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10 I WELCOME 

WELCOME 

Welcome to Medley-- the integrated Desktop Publishing program 
for the Apple IIGS! Medley combines all three areas of Desktop 
Publishing (word processing, artwork, and page layout) into one 
program. Now Desktop Publishing is truly a one-stop process, 
requiring no switching to different programs. Medley incorporates 
several unique features which allow you to create more 
sophisticated documents than ever before. Among them are the 
ability to wrap words around any shape or object (not just 
rectangles), an 80,000 word spell checker, an on-screen 
thesaurus, and a 500 picture "clip-art" disk. The possibilities of 
Medley are virtually limitless. 

In order to take full advantage of the features available to you in 
Medley, please take the time to read through this manual. It will 
guide you through the process of creating a document, and serve 
as a resource for any questions you may have. 

Medley. 
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WHAT YOU'LL NEED 

An Apple JIGS with a fully populated one megabyte RAM 
expansion card (1.25 megabytes total in the computer) and a 
monochrome monitor. 

One 3.5" disk drive. 

A blank, formatted 3.5" disk for storing your document files. 

A second 3.5" disk drive or hard disk, color RGB monitor, and 
printer are recommended, but optional. 

IMPORTANT NOTE: 

If your computer has the minimum amount of RAM required ( 1.25 
megabytes), be sure to set your RAM Disk Size to "zero" for both 
the minimum and maximum memory options from the Control 
Panel. See your Apple IIGS Owner's Manual for instructions if 
you do not know how to do this. If you have to reset the RAM 
Disk, be sure to turn your computer off, and then back on again. 
If you do not do this, the computer mcry not recognize that the 
RAM Disk size has been changed. 

Medley is segmented so that separate parts will load into the 
computer as they they are needed. The first segment to load 
contains most of the word processor. Once a segment is loaded, it 
stays in memory so that you do not have to wait for it to load 
again. The exception is if the available RAM becomes filled, and 
another segment is trying to load. Medley will then flush the other 
segments from memory while the new segment loads. No 
information from your document will be lost while this happens. 
Due to this feature, more RAM in your computer means less 
possible disk accessing. If you have enough RAM (at least 2 
Megabytes), you can create a RAM disk upon which the entire 
program can be loaded. 
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SOME IMPORTANT TERMS 

Listed below are some general terms pertaining to Medley and the 
Apple IIGS user interface. These terms are used frequently 
throughout this manual and it would be to your advantage if you 
are familiar with their definitions. 

APPLE IIGS FINDER-- The screen that appears first when Medley is 
loaded. The Finder will show a graphic representation of all disk 
drives available on your IIGS system (floppies, hard disks, and 
RAM disks). To see a list of files available on a given drive, 
double-click on the drive icon. Files can be opened, closed, 
copied, organized, and deleted from the Finder. 

AREAS --All areas referred to in this manual are "art areas." An art area 
is a closed shape (rectangle, round rectangle, oval, or polygon) 
into which art or text can be placed. Areas are designated by 
borders which can be visible or invisible. Areas can be placed 
anywhere within a document, and text will always wrap around 
them. 

AUXILIARY DICTIONARY-- A listing of words added by the user in 
addition to the 80,000 word Medley spell check dictionary. The 
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spell checker cross-checks all words in a document against a list of 
known words. If an auxiliary dictionary is opened, then the 
words in that dictionary will not be flagged by the spell checker, 
no matter which document is being checked. 

BUTTON -- A small oval with a command inside its borders, usually 
appearing in a dialog box. Clicking on a button will activate the 
command. Buttons with double borders are the default buttons, 
and pressing the Return key will also activate them. 

CLICK-- Pushing down and letting up on the mouse button. 

CLICK AND DRAG-- Hold down the mouse button while you move the 
mouse. 

CLIPBOARD -- This is used to delete, move, or copy any text or 
artwork. Text or art is moved or copied from the document to the 
"Clipboard" and held there until it is taken off and placed 
elsewhere. 

CLOSE BOX --The small square box on the left side of the Title Bar. 
Click inside the Close Box if you are done working on your 
document and wish to quit. This works just like the Close 
command in the File menu. 

COMMAND KEY -- The key just to the left of the Space Bar, 
designated with a~ symbol and an open apple. Often times, keys 
used in conjunction with this key constitute short-cuts to many of 
the menu commands. If you have a lie that has been upgraded to a 
JIGS, the Command key is designated by only the open apple. 

CONTROL PANEL -- Allows you to change the configuration (clock 
time, monitor colors, printer slots, RAM memory, etc.) of your 
Apple JIGS computer. The Control Panel can be accessed at any 
time by pressing the Command I Control I ESC keys. To 
make sure that the computer recognizes a Control Panel change, 
the computer should be turned off, and then back on again after the 
Control Panel is accessed. 
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CURSOR-- The flashing vertical line when you are in the Text mode. 
The cursor signifies the point at which any new text will appear 
when entered. 

DEFAULT-- When a new Medley file is opened the program assumes, or 
defaults to, certain basic characteristics (e.g. the font is Shaston 
size 8, the margins are set at 1.5" from top and bottom, the lines 
are single spaced, etc.). These characteristics can be changed to 
alter the appearance of your document. 

DESKTOP-- Any document window that is open is considered to be on 
the "Desktop." Although up to ten documents can be on the 
Desktop at one time, only one document is active and is able to be 
worked on. 

DIALOG BOX -- Special windows that pop up for many of the pull-down 
menu commands, providing further options. In any dialog box, a 
button (command) that is outlined by double lines instead of a 
single line can be activated by pressing the Return key as well as 
by clicking on it. 

DIRECTORY --The listing of files and folders on a disk. Folders are 
often known as "subdirectories" since they can contain their own 
listings of files and folders. 

DOCUMENT DICTIONARY-- A listing of words added by the user in 
addition to the 80,000 word Medley spell check dictionary. The 
spell checker cross-checks all words in a document against a list of 
known words. Words added to a document dictionary will modify 
the list of known words only for the individual document under 
which it was created. Words added to one document dictionary 
will be flagged if a different document is spell checked. 

DOUBLE-CLICK-- Clicking the mouse twice, rapidly. 

DRAGGING -- Moving the mouse while the mouse button is held down. 

FILE -- Any document is considered a file. Saved documents are stored 
on a disk under file names that you give them. 
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FOLDER -- Many files (individual documents) can be organized and 
placed into folders. This keeps the list of files from becoming too 
cluttered. Folders can also be placed within folders. 

FONT -- A complete set of letters, numbers, and symbols -- all with the 
same design characteristics. 

GLOBAL -- Any change that affects the entire document is referred to as a 
global change. For example, if an art area is placed in the same 
spot on every page, it is called "global art." 

GRAYED OUT -- Menu commands that are showing in ,g@y- not black. 
This signifies that the command cannot be activated at that time. 

IDGHLIGHT -- When text or a menu command is selected it will become 
highlighted -- the text will be white, reversed out of a black 
background. 

ICON -- A small picture displayed on the screen, representing things such 
as flies, folders, and programs. For example, the Medley icon is: 

~ 
MEDLEY 

MENU -- A list of options available to you. The menus in Medley are 
"pull-downs," meaning that clicking on the menu header (title) will 
cause the options available under that header to appear. 

MENU BAR -- The line of text at the top of the screen where all the "pull­
down" menu headers are listed. Clicking the mouse on any of 
these headers (including the Apple insignia) will cause a list of 
options to drop down. 

OPTION KEY -- Located to the left of the Command key and labeled 
"option." If you have a lie that has been upgraded to a IIGS, the 
Option key is just to the right of the Space Bar and has a solid 
apple on it. 

PAGE PART --An art area that has been turned into a text area with the 
Convert Areas command. Page Parts can be resized and moved 
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like art areas, but they are actually miniature pages. As such, the 
text within them can be formatted and manipulated just as with a 
full-sized page. 

PIXEL -- Short for "picture element." Pixels are very small dots that 
measure 80 per inch horizontally, and 32 per inch vertically. 

POINTER -- The object that moves on the screen when you move the 
mouse. The pointer can assume several shapes. In the Text mode 
it is represented by an "!-Beam" or an arrow, depending whether 
or not you have moved the pointer into a text area. In the Paint 
Tool, the pointer is represented by a paint bucket, pencil, eraser, 
or one of several other objects. 

PULL TABS -- Small black squares located on the sides of art areas when 
they are selected. Clicking and dragging a pull tab allows you to 
resize the art area. 

RESIZE BOX -- Located in the lower right corner of the document 
window. Clicking and dragging this box allows you to change the 
size of the document window. 

SCROLL BARS -- Positioning the mouse pointer on any of the arrows in 
the scroll bars (far right and bottom of the document window) and 
holding down the button will cause the document to move 
("scroll") up, down, left, or right. If you click inside the gray 
shaded area, the document will scroll the length of one window 
per click. If you position the pointer in the white box within the 
scroll bar and click and drag, the distance you scroll the document 
will be proportional to the distance you drag the white box. 

TEXT MODE-- Whenever you are able to enter and format text, you are 
in the word processor, or Text mode. 

TITLE BAR-- Located at the top of the document window, below the 
Menu Bar. The title you give to your document is displayed here. 
(All new documents are displayed as "Untitled.") 

WINDOW -- Any document that appears on the Desktop is in the form of 
a window. This means that it can be closed, resized, repositioned, 
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or remain on the Desktop with many other windows. If multiple 
windows are on the Desktop, click on any window to make it the 
active one. 
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GETTING STARTED 

NOTE: If your computer has the minimum amount of RAM required 
( 1.25 megabytes), be sure to set your RAM Disk size to "zero" for 
both the minimum and maximum memory options from the 
Control Panel. See your Apple IIGS Owner's Manual for 
instructions if you do not know how to do this. If you have to 
reset the RAM Disk, be sure to turn your computer off, and then 
back on again. If you do not do this, the computer may not 
recognize that the RAM Disk size has been changed. 

BACKING UP THE MASTER DISKS 

Medley comes with four disks: the Medley Startup disk, the 
Medley Program disk, the Dictionary disk, and the Clip Art disk. 
All are unprotected so that you can make working copies. Once 
you have made the copies, put the originals away in a safe place in 
case your working copies are damaged. Copies of these disks 
may be made for your own personal use only. Please read the 
License Agreement for complete details. 

The Medley disks may be copied in the same manner as any other 
Apple IIGS disk: by using the System Utilities which are located 
on the Apple IIGS System Disk, or by dragging icons from one 
disk to another on the Finder desktop. See the Apple IIGS System 
Disk manual for complete details. 

LOADING 11EDLEY WITH ONE DISK DRIVE 

1. Insert the Medley Startup disk into the disk drive, label side up. 
Turn on the monitor and computer. 
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2. After a while, the 1/GS Finder will appear on the screen. 

3. Eject the Startup disk and insert the Medley Program disk. You 
will see an icon for the Program disk. Double-click the Medley 
Program disk icon. A dialog box will now appear showing- the 
Medley file icon. Double-click the Medley file icon. The Medley 
title screen will appear. 

4. Shortly thereafter, a message will appear telling you to insert the 
Startup Disk. Eject the Program disk, insert the Startup disk, and 
press the Return key. 

5. After the program loads for a while, the blank Medley word 
processing screen will appear. 
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Eject the Startup disk and insert the Program disk. You can now 
enter text as in any other word processor, or pull down the File 
menu and select "Open Document" to open any pre-existing files. 
The Program disk should be kept in the drive as much as possible. 
There are files on the disk that the computer needs to access from 
time to time. If the computer looks for and does not find the 
Program disk, you will be prompted to reinsert it. Since all fonts 
(type styles) are stored on the Startup disk, any font changes will 
require you to reinsert the Startup disk. This includes documents 
that are opened with different fonts already in them. If the Startup 
disk is not in your disk drive, and you have selected a font change 
or opened a file, a dialog box will appear instructing you to insert 
the Startup disk. Eject the Program disk and insert the Startup 
disk. Once the fonts have loaded, you can reinsert the Program 
disk. 

To save your document once you are finished, please see "Saving 
a Document." 
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LOADING MEDLEY WITH TWO DISK DRIVES 

1. Insert the Medley Startup disk in drive #1, and the Medley 
Program disk in drive #2 -- label side up. Turn on the monitor and 
computer. 

2. After a while, the IIGS Finder will appear on the screen. 

3. You will see an icon for the Medley Program disk. Double-click 
the Program disk icon. A dialog box will now appear showing the 
Medley file icon. Double-click the Medley file Icon. The Medley 
title screen will appear. 

4. After the program loads for a while, the blank Medley word 
processing screen will appear. 



22 I GETTING STARTED 

You can enter text here as in any other word processor, or pull 
down the File menu and select "Open Document" to open any pre­
existing files. The Program disk should be kept in one of the 
drives as much as possible. There are files on the disk that the 
computer needs to access from time to time. If the computer looks 
for and does not find the Program disk, you will be prompted to 
reinsert it. Since all fonts (type styles) are stored on the Startup 
disk, any font changes will require that the Startup disk is in one 
of the drives. This includes documents that are opened with 
different fonts already in them. If the Startup disk is not in a drive 
after you have selected a font change or opened a file, a dialog box 
will appear instructing you to insert the Startup disk. Eject one of 
the disks and insert the Startup disk. 

To save your document once you are finished, please see "Saving 
a Document." 

USING MEDLEY WITH A HARD DISK 

NOTE: The Medley Startup disk contains the Apple IIGS System Disk, 
version 3.2. THE MEDLEY PROGRAM DISK MUST BE 
LOADED FROM SYSTEM DISK 3.2 OR IT WILL NOT WORK 
PROPERLY. If you have an earlier version of the System Disk 
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(e.g., version 3.1) running on your hard disk, you must first 
delete the following System Disk files: PRODOS, SYSTEM 
folder, APPLETALK folder, and ICONS folder. Then copy the 
same 4 files from the Medley Startup disk onto your hard disk. If 
you have System Disk version 3.2 already installed on your hard 
disk, you only need to modify the Fonts folder (located in the 
SYSTEM folder). Copy the fonts in the Fonts folder from the 
Medley Startup disk into the SYSTEM folder on your hard disk. 
(Medley has special fonts which are in the Fonts folder on the 
Medley Startup disk.) 

1. Turn on the hard disk drive and your Apple IIGS. The 1/GS 
Finder will appear on the screen. 

2. Insert the Medley Program disk into your 3.5" disk drive, and the 
Medley disk icon will appear. 

3. Position the pointer on the hard disk icon and double-click. A 
window will appear with various icons in it. 

4. Select New Folder from the File menu. A new folder called 
"Untitled" will appear in the window. Select Rename from the 
File menu to give the folder an appropriate title (e.g., 
Medley.HD). 
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5. Position the pointer over the Medley disk icon and double-click. 
The Medley file icon will appear in a window. Now, position the 
pointer over the Medley file icon, click, and drag it on top of the 
new folder you have just created. When the folder becomes 
highlighted, release the mouse button and Medley will be copied 
into the folder. 

6. Eject the Medley disk and insert the Dictionary disk. Double-click 
the Dictionary disk icon and several files will appear in a window. 
Click the Select All command from the Special menu and they 
will all become highlighted. Position the pointer over one of the 
file icons, and click and drag. All the files will move with the 
mouse. When the pointer is over the new Medley folder, it will 
become highlighted. Release the mouse button and the files will 
be copied into the folder. 

7. Eject the Dictionary disk and insert the Clip Art disk. Copy all 
files from the Clip Art disk to your hard disk just as you did with 
the Dictionary disk. 

8. To start Medley, position the pointer on the the folder into which 
Medley was copied. Double-click, and a window will appear with 
Medley, Dictionary, and Clip Art file icons in it. 

9. Position the pointer on the Medley icon and double-click. The 
Medley title screen will appear as the program starts to load. 

10. After the program loads for a while, the blank Medley word 
processing screen will appear. You can enter text here as in any 
other word processor, or pull down the File menu and select 
"Open Document" to open any pre-existing flies. 
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To save your document once you are finished, please see "Saving 
a Document." 
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A QUICK TOUR 

Medley has several unique capabilities, and these are briefly 
described in this section. If you are familiar with Macintosh-style 
word processors and artwork programs, you may wish to start 
using Medley at once. 

One important thing to keep in mind is that Medley is fully 
interruptible. In other words, you do not have to wait for a 
command to be finished before you can go on and do something 
else. For example, if you have added an art rectangle to a full page 
of text, the text will start to wrap around the rectangle. However, 
you can start to type before the text has finished its reformatting. 
The text wrapping will eventually finish, as it works to catch up 
during your pauses. 

Medley is designed to be used as a word processor first. Although 
you can design your page layout before text is entered, Medley 
will process text more quickly if you enter most of the text before 
any art areas have been created. 

Once Medley is loaded, the "Untitled" word processing screen 
appears. Text can be entered, formatted, and deleted as in any 
other word processor. 
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To add an art area to your document, select one of the options 
(rectangle, round rectangle, oval, or polygon) from the Areas 
menu. Once the pointer is moved back below the Title Bar, it will 
become a small "+". Position the pointer at the spot where you 
wish the art area to be inserted, click, and drag. The area will 
grow and shrink with the mouse movement. Once the art area is 
the desired size, let up on the mouse button and an area with 
orange borders (gray borders on a monochrome monitor) and 
black squares on the sides called "pull tabs" will be placed on the 
page . Any text will automatically wrap around it. 
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To stretch an area, position the pointer over the pull tab which is 
on the side you wish to stretch, click and drag. Areas can only be 
stretched in one direction at a time. With a polygon, draw with the 
"+"to create a multiple-sided area. Polygons are made up of many 
line segments, each separated by a pull tab, which can be stretched 
to resize the area. 
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Areas can be repositioned anywhere on the page by positioning the 
pointer inside an area, clicking and dragging. The entire area will 
move with the mouse. 
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When you create an art area, it will have orange borders (gray on a 
monochrome monitor). These borders indicate that you are in the 
Move I Change mode. To return to the Text mode, move the 
pointer outside the art area and click the mouse. The area borders 
will turn black. You can then enter text, or you can enter the Paint 
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Tool (see below). To return to the Move I Change mode, click the 
Move I Change command from the Areas menu, and then position 
the pointer in any art area and click the mouse. You can also enter 
the Move I Change mode by just clicking ONCE in any unselected 
(black borders) area. The area borders will again tum orange 
(gray on a monochrome monitor). 

You can enter the Paint Tool from the Move I Change mode by 
selecting the Enter Paint Tool command from the Areas menu. 
Selecting this command will cause the artwork tools to appear. 
You can also enter the Paint Tool at any time when you are not in 
the Move I Change mode by positioning the pointer inside an art 
area and double-clicking. Use the artwork tools as with any other 
"paint" program. To return to the Text mode, select the Return to 
Word Processor command from the File menu, or double-click 
outside the art area. 

Columns and other special page lay-out designs can be created 
with art areas (e.g., long narrow areas can be used to divide 
columns of text). See the "Page Layout" section for a full 
explanation of all the options available. 
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THE APPLE MENU 

Items under the Apple menu are considered "Desk Accessories," 
and provide the user with helpful information. 

ABOUT MEDLEY 

HELP 

The About Medley ... command shows you how much memory is 
presently being used, and tells you which version of Medley you 
are using. Click anywhere on the screen to return to the 
document. 

Choosing the Help command opens a window that gives you 
general information about the many options available in Medley. 
For more detail, the information in the Help window is cross­
referenced to chapters in this manual. 

To use the Help command, select it from the Apple menu. A 
dialog box will appear stating: "Choose a pull-down for which you 
need help." Position the pointer on a menu, click, and drag to 
select a menu command. Let up on the mouse button, and the 
dialog box will fill with the Help text for the selected menu 
command. 
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OPENING AND CLOSING DOCUMENTS 

OPENING A NEW DOCUMENT 

The New Document command creates an empty document window 
("Untitled" appears in the title bar). This is also the first screen 
which appears after the program is loaded. Medley allows you to 
have up to ten different document windows on the Desktop at one 
time. If ten windows have already been opened, New Document 
will be grayed out on the File menu. 

OPEN1NG AN EXISTING DOCUMENT 

The Open Document command allows you to open a file 
previously saved to disk. If you already have ten files on the 
Desktop, Open Document will be grayed out on the File menu. 
Once you have selected Open Document, a dialog box will appear 
that looks something like this: 
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To open a document, scroll through the list of files and click on the 
one you want to open. The file name will become highlighted. 
Click the "Open button" to enter the document. If you do not see 
a file that you know has been saved to disk, it may have been 
placed in an unopened folder. Folders are differentiated from 
Files by their icons. 

To open a folder, position the pointer over the folder name and 
click the mouse. The folder name will become highlighted. 
Position the pointer on the "Open button" and click. The disk 
icon next to the disk name will change to an open folder icon and a 
list of file names contained within that folder will appear. Once 
you see the file you want, position the pointer on its name and 
click the mouse. The file name will become highlighted. Position 
the pointer on the "Open button" and click the mouse to open the 
file. To access another folder you must first close the open folder 
(unless the folder you want resides within the open folder). 
Selecting the "Close button" closes an open folder. The "Close 
button" is grayed out if no folder is opened. 
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To open files from another disk, insert the new disk and select the 
"Disk button." The disk name next to the disk icon will change 
and a list of all files and folders on that disk will be displayed. 
Select the file or folder you want to open and click the "Open 
button." 

Selecting the "Cancel button" cancels the Open Document 
command. 

OPENING APPLEWORKS FILES 

All AppleWorks word processing files can be imported and 
opened directly with the Open Document command, just as any 
Medley file can. Medley is able to read an Apple Works file, along 
with most of its formatting, so that you do not have to create an 
ASCII file. Special Apple Works formatting that will transfer intact 
to Medley consists of: 

Tabs (3 or more spaces are also converted to Tab 
characters) 

Bold text 
Underlined text 
Superscript text 
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Subscript text 
Justified text 
Centered text 
Paragraph indents 
Single space (sets bottom leading to 1) 
Double space (sets bottom leading to 10) 
Triple space (sets bottom leading to 20) 
Page break 
Sticky spaces 

IMPORTING FILES FROM OTHER WORD PROCESSORS 

Documents written on other Apple II word processors can be 
opened and copied into Medley as long as they have been saved to 
disk as Text (ASCII) Files. All formatting will be lost, but the 
entire body of text will transfer into Medley. The one exception is 
AppleWorks. All AppleWorks word processing files can be 
opened with the Open Document command, just as any Medley file 
can. 

To open a Text File from word processors other than 
Apple Works, select the Open Document command from the File 
menu. Insert the disk with the saved ASCII Text File into a disk 
drive and press the "Disk button." A list of available files will 
appear under the disk name. Position the pointer over the file to be 
selected, and click. The file name will become highlighted. Click 
the "Open button," and a new file will be opened. 

To copy the text from another word processor into an existing 
Medley file, first transfer the Text File into a new Medley file as 
detailed above. Then, use Cut or Copy to transfer the text onto the 
Clipboard. Finally, use Paste to transfer the text into the existing 
Medley file. 

SETTING MARGINS 

Medley gives you default margins of 1" on the top and bottom, 
and .75" on the left and right. Should you desire to change the 
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pre-set margins, choose the Set Margins command. Selecting Set 
Margins gives you a dialog box from which you can change the 
default margins. 
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Position the pointer in the box of the margin you would like to 
alter. Click and then enter the number (in inches) of your choice. 
Any decimal will also work (e.g., 2.5"). Click OK to accept the 
margin changes, or Cancel to return to your document and cancel 
any changes. 

If you are changing margins for a document in which there are 
existing art areas, you may get a dialog box which says, "Art on 
page(#) too large for margin values." Although text can reformat 
itself inside smaller margins, art areas cannot. If an existing art 
area is too large to fit within the parameters set by the new 
margins, either resize the area so that it is smaller, or keep your 
margins wide enough to contain the art area. 

NOTE: Make sure that your printer will be able to print afullline 
of text if you set your margins wider than the default margins. For 
example, you will always need at least .5" on all margins for the 
Apple LaserWriter. 

The Gutter Margin affects the left and right margins. When the 
gutter margin is set at 0" (the default setting), the left and right 
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margins will measure distance from the left and right edges of the 
paper. Giving a value to the gutter margin will move the left 
margin in on odd-numbered pages, and move the right margin in 
on even-numbered pages. For example, if the left and right 
margins are set at 1 11 and you set the gutter margin at 1 II, the left 
margin on odd-numbered pages will become 211 and the right 
margin on even-numbered pages will become 2 11

• The opposite 
margins will remain at 1 II. Of course, your document width will 
be narrowed by one inch on all pages. This gives you the ability 
to bind your document in a notebook without obscuring any text 
or art. 

PAGE SETUP 

The Page SetUp ... command lets you choose the page parameters 
for your entire document. The options available to you will differ 
with your choice of printer selected in Choose Printer. 

Page SetUp with Image Writers: 

1. Click Page SetUp ... 

2. A dialog box like the one below will appear. 
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3. Click any of the four options under Paper to choose your 
paper size: 

* US Letter for paper gl/2 inches wide by 11 
inches tall. (This is the default selection.) 

* US Legal for paper gl/2 inches wide by 14 inches 
tall. 

* A4 Letter for European standard paper - gl/4 
inches wide by 112!3 inches tall. 

* International Fanfold for International standard 
paper - gl/4 inches wide by 12 inches tall. 

4. Click "Condensed" under Vertical Sizing to print your 
document at half its normal vertical height, but at the 
normal width. 

5. Under Printer Effects, click "No Gaps Between Pages" 
to print the document without any page breaks. Click 
"50% Reduction" to print the document at half its normal 
size (height and width). 

6. Click the Orientation for your printed page. 

~=-1 
Tall Wide 

Tall (default selection) prints with the top line of your 
document starting at the top of the page. 

Wide prints with the top line of your document printing 
along the right side of the page. 

7. Click OK to accept the Page SetUp, or Cancel to return to 
your document without changing the Page SetUp 
parameters. 
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Page SetUp with LaserWriters: 

1. Click Page SetUp ... 

2. A dialog box like the one below will appear. 
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3. Click any of the four options under Paper to choose your 

paper size: 

* 

* 

* 

* 

US Letter for paper gi/2 inches wide by 11 
inches tall. (This is the default selection.) 
US Legal for paper gl/2 inches wide by 14 inches 
tall. 
BS Letter for paper 15 inches wide by 11 inches 
tall. 
A4 Letter for European standard paper - gl /4 
inches wide by 112!3 inches tall. 

4. Click the Orientation for your printed page. 

= Tall Wide 
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Tall (default selection) prints with the top line of your 
document starting at the top of the page. 

Wide prints with the top line of your document printing 
along the right side of the page. 

5. Vertical Sizing: 

NORMAL -- Prints text and art at the same proportion as is 
shown on the computer monitor. 

INTERMEDIATE-- Prints text and art at two thirds their 
normal height, but at the normal width. 

CONDENSED -- Prints text and art at one half their normal 
height, but at the normal width. 

6. Printer Effects: 

SMOOTHING -- Instructs the LaserWriter to add dots 
between the rough edges of artwork and non - LaserWriter 
fonts to produce a smoother effect. 

FONT SUBSTITUTION-- If the fonts you have chosen 
for your document are not resident within your 
LaserWriter, this command will substitute fonts that are 
resident within the LaserWriter. Non-LaserWriter fonts 
will print as they appear on the screen -- somewhat blocky 
looking. Fonts resident within the LaserWriter will have a 
higher resolution and much cleaner appearance. If you 
know which fonts are resident within your LaserWriter, 
then you can create your document with the assurance that 
the final text out-put will match the text on the screen. 
Some examples of font substitution are: 

Shaston becomes Helvetica 
Geneva becomes Helvetica 
Venice becomes Courier 
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7. You can Reduce or Enlarge your document by typing 
in a number from 25 to 400 in the "% Box" next to 
Reduce or Enlarge. 50% will reduce the document by 
half. 200% will enlarge the document to twice its normal 
size. 

8. Click OK to accept the Page SetUp, or Cancel to return to 
your document without changing the Page SetUp 
parameters. 

CLOSING A DOCUMENT 

The Close command closes the active document window. If you 
have made changes to the document, a dialog box appears and 
asks if you want to save the changes. 
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To save the changes, click the "Yes button." Click the "No 
button" if you do not want the changes saved. Clicking the 
"Cancel button" cancels the Close Document command and 
returns you to the active document window. 

You can also close a document by clicking in the "Close box" on 
the document title bar. 



OPENING AND CLOSING DOCUMENTS I 43 

SAVING A DOCUMENT 

There are two different commands to save a document: 

1. The Save As [Document Name] command saves the active 
document under the name which is presently showing in the title 
bar. Select the Save As [Document Name] command, and your 
document will be saved to disk. After it has been saved, you are 
returned to the document. This command will also replace an 
existing document of the same name with the active document. If 
changes have been made and you wish to retain the original 
version as well as the changed version, use Save As ... to save the 
document under a different name. 
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2. The Save As ... command enables you to save the active document 
under a new name, as well as to choose the disk or folder where 
you would like to save the document. Since all new documents 
are given the name "Untitled," you would use this command to 
give it a title of your choice. To use this command: 

A. Select Save As... A dialog box will appear with the 
outlined name of the active document showing in the lower 
left corner (below "Enter file name to save:"). 
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B. When text is entered, a new title will replace the existing 
(outlined) title. 

C. Click the "Save button," and your document will be saved 
to disk under the new name. 

To save your document to a different disk select the "Disk 
button." The name of the disk to which the document will be 
saved is located in the upper left corner of the Save As ... dialog 
box next to a disk icon. 

A. To save a document if you have only one disk drive, eject 
the Medley disk and insert a formatted 3.5" disk into the 
drive. Click the "Disk button," and the name of the new 
disk will appear next to the disk icon. The memory 
available on that disk will be displayed below the name. 
Click the "Save button" to save your document to the new 
disk. 
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B. To save a document if you have two disk drives, insert a 
formatted 3.5" disk into the second drive and click the 
"Disk button." The name of the new disk will appear next 
to the disk icon. The memory available on that disk will be 
displayed below the name. Click the "Save button" to 
save your document to the new disk. 

C. To save a document to a hard disk, make sure that the 
name of the hard disk is showing inside the dialog box 
next to the disk icon. (Click the "Disk button" if it isn't.) 
Click the "Save button" to save the document. 

When many documents are saved to a disk, the disk directory may 
start to look cluttered and unorganized. You can better organize 
your files by placing similar documents into folders. 

To create a new folder in which to place your document: 

A. Enter the name you wish to give the NEW FOLDER below 
"Enter file name to save" and click the "New Folder 
button." 
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B. The new folder name will appear outlined in the listing. 
Click the "0 pen button." This opens the folder 
(represented by the disk icon changing to an open folder 
icon). Since no files have yet been saved to the folder, the 
listing is empty. 

C . Enter the name you wish to give your DOCUMENT below 
"Enter file name to save." Click the "Save button" to save 
the document to the newly-created folder. 

D. You are returned to the active document. 

To save your document to an existing folder: 

A. Position the pointer on one of the folder titles in the listing 
and click the mouse (all non-folder titles are grayed out in 
the dialog box). The folder title becomes highlighted. 
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B. Click the "Open button." This opens the folder 
(represented by the disk icon changing to an open folder 
icon). A listing of files within the folder will be displayed. 

C. Enter the name you wish to give your DOCUMENT below 
"Enter file name to save." Click the "Save button" to save 
the document to the folder. 

D. You are returned to the active document. 

Clicking the "Close button" allows you to close a folder if you do 
not want to save a file there. The "Close button" is grayed out if 
no folder is opened. 

Clicking the "Cancel button" will cancel the Save As ... command 
and return you to your document. 

EXPORTING TEXT 

Text in any document (with or without art) can be saved as a text 
(ASCII) file so that it can be exported to another word processor. 
All art and formatting will be lost when this is done. 
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To save a document as an ASCII file, select the Save As ... 
command from the File menu. A dialog box will appear. Enter 
the name you wish to give the file below "Enter file name to save." 
Click in the box next to "Save Text Only" and an "X" will appear. 
Click the "Save button" to save the file. If you save the ASCII 
flle under the same name as an existing Medley file, the ASCII file 
will replace the Medley file, causing the loss of all art and 
formatting. Files can be saved to different disks and folders in the 
normal manner. 
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Clicking the "Cancel button" will cancel the Save As ... command 
and return you to your document. 

DELETING A DOCUMENT 

The Delete ... command lets you delete a file from the disk. Only 
files can be deleted with this command - not folders. This 
command will permanently erase the entire selected 
document. 

When you select Delete ... , a dialog box appears with a list of files. 
Select the file you wish to delete by positioning the pointer on its 
name and clicking. Make sure that the name to be deleted is a file 
and not a folder (look at the icons). The file name will become 
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highlighted. Position the pointer on the "Delete button" and 
click. The file will now be deleted. 
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To open a folder, double-click on a folder name. The disk icon 
will change to an open folder icon and a list of all files within the 
folder will appear. Select the file you wish to delete by positioning 
the pointer on its name and clicking. The file name will become 
highlighted. Position the pointer on the "Delete button" and 
click. The file will now be deleted. 

Click the "Disk button" to view files from different disks. The 
name of the new disk will appear next to the disk icon along with a 
listing of all its files and folders. Select the file you wish to delete 
by positioning the pointer on its name and clicking. The file name 
will become highlighted. Position the pointer on the "Delete 
button" and click. The file will now be deleted. 

Clicking the "Cancel button" cancels the Delete ... command. 

QUTITING MEDLEY 

To quit Medley, click the Quit command. If you have made no 
changes since you last saved the document, you will be returned 
to the Finder. If you have started a new document, or made 
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changes to one already existing, a dialog box will appear asking if 
you would like to save the changes. 
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Click the "Yes button" to save your changes and quit Medley. 
You are then returned to the Finder. 

Click the "No button" to quit Medley, but leave your document as 
it was when you last saved the document. You are then returned 
to the Finder. 

Click the "Cancel button" to cancel the Quit command and return 
to your document. 
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TYPING AND EDITING 

TYPING 

In many ways, entering text in Medley is similar to typing on a 
typewriter, except that the characters are printed to a monitor 
screen instead of directly onto paper. Characters that are entered 
from the keyboard are placed on the screen and stored in the 
computer's memory until you Save the document. Characters can 
be inserted into any place in the document by moving the cursor 
with the arrow keys, or by placing the mouse pointer at the point 
of insertion and clicking. Characters will be entered at the point of 
the blinking cursor. Holding the Option key down while typing 
will cause special characters to be printed instead of the characters 
on the keyboard. 

Medley automatically wraps text from one line to the next. When 
you have reached the end of a line, and a word will not fit, Medley 
will move it to the next line. Text will also wrap around any art 
areas you have created within your document. If a word will not 
fit on a line because of an art area border, the text will either move 
down a line or to the other side of the area, depending on how you 
set the Text Wrap Direction from the Format menu. 

The one exception to this is if you have created a text 
area that is very narrow. For example, if you are entering 
text into a very narrow column, or if you have placed a big art area 
that runs close to the left page margin, or if you have placed an art 
area so that it is close to both borders of a column, then Medley 
will split any word that is larger than the space available. The best 
remedy here is either to move the art area, or resize it so that it is 
bigger or smaller. This will create a space for the text that is wide 
enough to fit entire words, or else will leave no space in which 
parts of words can fit. 
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When your text reaches the bottom of the screen, the document 
will automatically shift up several lines to allow you to keep 
typing. 

Pressing the Return key inserts a "paragraph break" at the cursor 
point and moves the cursor to the next line. In most cases,the 
Return key should only be pressed at the end of a paragraph. 
"Paragraph break" symbols are invisible unless you choose Show 
Paragraph Breaks from the Special Effects menu. 

"Sticky spaces" can be created by pressing the Option I Space 
keys. "Sticky spaces" are empty spaces which keep the two 
words it separates from being split apart, even if the words wrap 
from one line to the next. 

DOCUMENT LENGTH 

All documents in Medley are limited to 32 pages in length. This is 
the case no matter how much art is included, or the size of paper 
that is used. If a document exceeds 32 pages, the text will still be 
captured in memory, but you will not be able to see it. Any text or 
art that is Cut or deleted will cause some of the invisible part of the 
document to move up onto the 32nd page. If you are importing a 
large text file, the entire file will be imported, but you will only be 
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able to see the first 32 pages. To be able to work with the entire 
imported file, separate Medley files must be made. Cut the first 32 
pages and Paste them into a new document. New text will move 
into the vacated space. Continue to do this until the whole 
imported file exists as separate Medley files. 

MOVEMENT WITHIN A DOCUMENT 

You can move the cursor within a document with either the mouse 
or the arrow keys. To move the cursor with the mouse, position 
the pointer at the spot you wish to place the cursor (by moving the 
mouse) and click. The flashing cursor will appear at that point 
and text can be entered or deleted. To move the cursor with the 
arrow keys, simply press any arrow key while the cursor is 
flashing, and the cursor will move in that direction. 

our score and seven years ago our fathers brought forth on this 
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con not hollow-- this ground. The brave 11en,living and dead, who 

d here, hove consecrated it, far above our poor power to add or 
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You can "scroll" through a document by using the vertical and 
horizontal scroll bars. These bars are located on the right side and 
bottom of the document window. The scroll bars are graphic 
representations of the length and width of your document. For 
example, the top of the vertical scroll bar is the beginning of your 
document, and the bottom of the scroll bar is the end. The size of 
the white box within the scroll bar is proportional to the area 
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showing on the screen in relation to the entire document (the larger 
a document is, the smaller the box gets). 

To scroll vertically, position the pointer on the up or down arrow 
of the vertical scroll bar. Hold down the mouse button and you 
will scroll the document several lines at a time (depending on type 

size). Position the pointer in the gray area of the scroll bar and 
click, and the document will scroll the length of one window (one 
screen) at a time. If you position the pointer in the white box 
within the scroll bar and click and drag, the distance you scroll the 
document will be proportional to the distance you drag the white 
box. 

The horizontal scroll bar works much the same as the vertical 
scroll bar. If the margins in your document are not set wide 
enough to extend past the right border on the screen, there will be 
no horizontal scroll bar showing. 

Using the Go To Page ... command on the Shortcuts menu will 
enable you to move to the top of any specific page. 

SELECTING TEXT BLOCKS 

To make any changes to a block of text, you must first select it 
with either the mouse or the arrow keys. 

To select text with the mouse, position the pointer to the left of the 
first character of the text you wish to select. Click and drag the 
mouse up, down, left, or right to highlight the block of text. 
Release the mouse button and select the appropriate command 
from the Edit, Search, Font, or Format menus. Pressing the 
Shift key and clicking the mouse at the same time will select all 
text from the blinking cursor (or from, and including, a selected 
block of text) to the point at which the mouse is clicked. 
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But, in o larger sense, we con not dedicate-- we can not consecrate-­
can not hallow-- this ground. lhe brave 11en,living and dead. who 

struggled hm, have consecrated it, far above our poor power to add or 
detract. lhe world will little note, nor long re11e11ber what we say here, 

To select text with the arrow keys, position the cursor before or 
after the block of text to be selected. Press the Shift key at the 
same time as any of the arrow keys and the text will be selected in 
the direction of the arrow. 

Entire words, sentences, and paragraphs can be selected just by 
clicking the mouse. To select a word, position the pointer on the 
word and double-click. To select a sentence, position the pointer 
on a word in the sentence and click three times. To select a 
paragraph, position the pointer on a word in the paragraph and 
click four times. 

You can select sentences, paragraphs, or the entire document by 
using the commands on the Shortcuts menu. 

CHOOSING FONTS, STYLES, AND SIZES 

Different fonts, styles, and sizes of text can be chosen either 
before or after you start to type. The text will appear on the screen 
just as it will appear when printed on paper. 

The one exception is underlined text. Some fonts will not 
underscore text on the screen, although the underscores will show 
when printed. To see if any text is underlined, select the text and 
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check the Font menu. The Underline command will have a 
check-mark next to it if the text is underlined. 
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Characters that are inserted into a body of text will be in the same 
font and style as those surrounding them. When you change the 
font, style, or size, existing text will not alter unless selected; any 
new text entered will be in the new font, style, or size. 

To change the font, style, or size of existing text, select the text 
you wish to change with the mouse or arrow keys. The selected 
text will change to whichever font, style, or size are chosen. 

To choose a style, select the Font menu. Position the pointer over 
Font, click, and drag the mouse down to choose the desired style 
for your text. The style selected will be displayed with a check­
mark next to it. Styles can also be chosen in any combination 
(e.g., bold - italic - underline). Below is a list of the styles 
available: 

Plain 
Bold 
Underline 
Italic 
Oudine 

(default style) 
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Superscript - (slightly raised text) is based on the leading, 
or space between lines, set with the Change 
Leading command on the Format menu. A 
larger value assigned to the "top of line 
leading" will allow for higher superscripted 
text. 

Subscript- (slightly lowered text) is based on the 
leading, or space between lines, set with the 
Change Leading command on the Format 
menu. A larger value assigned to the 
"Bottom of line leading" will allow for lower 
subscripted text. 

To choose a font or size, you must use the Choose a Font 
command from the Font menu. A dialog box will appear listing 
the different fonts, styles, and sizes. 
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Scroll through the fonts, position the pointer over the desired font 
and click. The selected font will become highlighted. Each 
selected font will have at least one number representing the size of 
the text listed under the "Size" window. You can choose one of 
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the pre-set sizes by clicking on it, or create a size of your own by 
entering a number in the "Other Size" box. No font sizes should 
be set larger than 60. 

IMPORTANT NOTE: 

If you will be printing with an ImageWriter, the pre-set sizes will 
print better than custom sizes when the "Better Text" option is 
selected. Also, when printing with the "Better Text" option 
selected, no font should be set larger than 30. F ants larger than 30 
will print with the "Better Color" option selected, but not with the 
"Better Text" option. (See "Printing a Document" for complete 
details.) 

You can also select styles from the Choose a Font dialog box by 
clicking in the appropriate box. Selected styles will have an "X" in 
their box. Click 0 K to accept the font changes and return to the 
word processor. Click Cancel to cancel all changes and move 
back to the word processor. 

DELETING TEXT 

You can delete text character by character, or by entire blocks at a 
time. 

To delete text one character at a time, click the mouse (or use the 
arrow keys) to position the pointer to the right of the character(s) 
to be deleted. Pressing the Delete key will then delete characters 
one at a time to the left of the cursor. 

To delete whole blocks of text, select the block of text to be deleted 
and click the Clear command from the Edit menu, or press the 
Delete key. The block of text will be deleted; however it will not 
be put on the clipboard. You can also select Cut from the Edit 
menu and the selected text will disappear from the screen, but it 
will not immediately be deleted from the program. It is placed on 
the Clipboard and remains there until the Cut or Copy commands 
are used. It is then replaced (and effectively deleted) by another 
block of text, or an art area. 
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Selecting text and then pressing any key will delete the selected 
text and insert the chosen key in its place. 

MOVING TEXT 

Text can be moved by using the Cut command. 

To move text, use the mouse or the arrow keys to select the block 
of text you wish to move. Select Cut from the Edit menu. The 
text is removed from the screen and placed on the Clipboard. 
Place the pointer where you wish to move the text and click (or use 
the arrow keys). Select Paste from the Edit menu. The selected 
text is copied from the Clipboard into the document starting at the 
cursor. 
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The cut text remains on the Clipboard until something else replaces 
it (using Cut or Copy), so you can move the same block of text 
several times without having to re-select it. Text that is Cut to the 
Clipboard can also be placed in any other document. Simply open 
the other document and Paste the Clipboard contents into it. 

COPYING TEXT 

Text can be copied by using the Copy command. 

To copy text, use the mouse or the arrow keys to select the text 
you wish to copy. Click Copy in the Edit menu. Although the 
screen does not change, a copy of the selected text will be placed 
on the Clipboard. Place the pointer where you wish to position the 
copied text, and then click (or use the arrow keys). Select Paste 
from the Edit menu. The selected text is copied from the 
Clipboard into the document starting at the cursor. 
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The copied text remains on the Clipboard until something else 
replaces it (using Cut or Copy), so you can make multiple copies 
without having tore-select the text every time. Text that is Copied 
to the Clipboard can also be placed in any other document. Simply 
open the other document and Paste the Clipboard contents into it. 

VIEWING CLIPBOARD CONfENTS 

To see what, if any, selections of text or art are on the Clipboard, 
click Show Contents of Clipboard in the Edit menu. A window 
will appear showing what is on the Clipboard at that time. Click in 
the Clipboard window Close Box to return to the Text mode. 
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FINDING TEXT 

Selecting the Find command from the Search menu allows you to 
look for any occurrences of parts of words, whole words, or 
groups of words (including punctuation). 
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Selecting the Find command causes a dialog box to appear which 
can be moved to any point on the screen by clicking and dragging 
on the Title Bar. Enter the text you wish to search for in the edit 
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box next to "Find What." Click the "Find Next button" and 
Medley will start to search your document starting at the point of 
the cursor. Each time a match is found it will be highlighted 
within the text. You can then click the "Find Next button" to 
search for the next occurrence, or click the Close Box to re-enter 
the word processor. 

The Find command normally searches for ill cases of the text 
entered in the Find edit box, regardless of what may be 
surrounding it. For example, when searching for the text "the," 
the word "rather" would be flagged because it contains those three 
letters. If you wish to limit your search to only those words which 
match the text in the edit box exactly, select the "Whole Word" 
option (click in the box). Medley recognizes a whole word as a 
collection of letters separated by spaces, punctuation, numbers, or 
any characters (e.g., $,#,*). 
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The Find command will normally search for text regardless of its 
constitution of uppercase and lowercase letters. If you wish to 
search for text that is dependent on uppercase I lowercase, select 
the "Match Upper I Lowercase" option (click in its box). 

To exit the Find command, click in its Close Box, or click 
anywhere outside the Find dialog box. Any text that was 
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highlighted as a result of the Find command will remain selected as 
you return to the word processor. 

REPLACING TEXT 

Selecting the Replace command from the Search menu allows 
you to search for and replace any occurrences of parts of words, 
whole words, or groups of words (including punctuation). 
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Selecting the Replace command causes a dialog box to appear 
which can be moved to any point on the screen by clicking and 
dragging on the Title Bar. Enter the text you wish to be replaced 
in the edit box next to "Find What." Next, position the pointer in 
the box next to "Change To," click, and then enter the text you 
wish to replace it with. Click the "Find Next button" to find the 
first occurrence. The "Find What" text will become highlighted 
within the document. To replace the text just for that occurrence, 
click the "Change button." To replace the text and then go on the 
next occurrence, click the "Change, Then Find button." To 
make no change and go on to the next occurrence, click the "Find 
Next button." 
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If you would like to replace text in every case throughout the entire 
document, click the "Change All button" and the Replace 
command will automatically change every occurrence. 

The Replace command normally searches for all cases of the text 
entered in the Replace edit box, regardless of what may be 
surrounding it. For example, when searching for the text "the," 
the word "rather" would be flagged because it contains those three 
letters. If you wish to limit your search to only those words which 
match the text in the edit box exactly, select the "Whole Word" 
option (click in the box). Medley recognizes a whole word as a 
collection of letters separated by spaces, punctuation, numbers, or 
any characters (e.g., $,#, *). 
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The Rt-place command will normally search for text regardless of 
its constitution of uppercase and lowercase letters. If you wish to 
search for text that is dependent on uppercase I lowercase, select 
the "Match Upper I Lowercase" option (click in its box). 

To exit the Replace command, click in its Close Box, or click 
anywhere outside the Replace dialog box. 



TYPING AND EDITING I 67 

UNDOING AND REDOING 

The Undo command lets you cancel a change made to your 
document. Undo keeps track of the last 10 changes made to the 
document. A change consists of any of the following: 

Add art area, group areas, ungroup areas, bring to front, 
send to back, move areas, change area, convert areas, set 
margins, font changes, typing, add page break, delete text, 
delete areas, import art, change page layout, change page 
setup, change to uppercase, change to lowercase, ruler 
changes, spell check changes, thesaurus changes, replace 
text, leading changes, duplicate areas, document dictionary 
changes, cut, paste, hyphenation, and justification 
changes. 

To use Undo, select it from the Edit menu. The last change made 
to the document will be listed to the right of Undo when the Edit 
menu is pulled down. If Undo is used, then the previous change 
made will be listed to the right of Undo. If no changes have been 
made, Undo will be grayed out. 

Redo undoes Undo, so that the changes cancelled by Undo are 
once again placed in the document. Redo will keep track of 10 
Undo's. 
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To use Redo, select it from the Edit menu. The last Undo made 
to the document will be listed to the right of Redo when the Edit 
menu is pulled down. If Undo has not been used after any change 
to the document, Redo will be grayed out. If you have used Redo, 
and then make a change to the document, Redo will become 
grayed out until Undo is once again used. 

KERNING 

sting whether that notion, or 
con I ong rndurt. lie ore 11et on 

to dedicate o portion of 
who hm gave their I ives 
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Kerning is the process by which certain characters, when placed 
together, take up less space than other characters. This allows you 
to place more text within a certain width. Medley automatically 
kerns text as it is entered. For example, a combination of "JT" 
will take up less space than "WH." Text-based word processors 
such as Apple Works do not do this-- every character takes up the 
same amount of space. Due to the kerning feature, it is hard to 
line-up text vertically over several lines. The placement of the 
cursor is dependent upon the type of characters used in each line, 
not how many are used. We suggest that Tab Alignments be used 
if you are going to line-up or indent several lines of text. 
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FORMATTING A DOCUMENT 

MARGINS 

Medley gives you default margins of 1" on the top and bottom, 
and .75" on the left and right. Should you desire to change the 
pre-set margins, choose the Set Margins command. Selecting Set 
Margins from the File menu gives you a dialog box from which 
you can change the default margins. 
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Position the pointer in the box of the margin you would like to 
alter. Click and then enter the number (in inches) of your choice. 
Any decimal will also work (e.g., 2.5"). Click OK to accept the 
margin changes, or Cancel to return to your document and cancel 
any changes. 

NOTE: Make sure that your printer will be able to print a full line 
of text if you set your margins wider than the default margins. For 
example, the Apple JmageWriter must always have at least .5" for 
the right margin. 
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GUTIERS 

Gutters give you the ability to bind your document in a notebook 
without obscuring any text or art. This is because there is always 
a wider inside margin. 

Gutter margins are determined with the Set Margins command on 
the File menu. A dialog box will appear. 
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The gutter margin will affect the left and right margins. When the 
gutter margin is set at 0" (the default setting), the left and right 
margins will measure distance from the left and right edges of the 
paper. Giving a value to the gutter margin will move the left 
margin in on odd-numbered pages, and move the right margin in 
on even-numbered pages. For example, if the left and right 
margins are set at 1" and you set the gutter margin at 1", the left 
margin on odd-numbered pages will become 2" and the right 
margin on even-numbered pages will become 2". The opposite 
margins will remain at 1". Of course, your document width will 
be narrowed by one inch on all pages. 
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RULERS 

Selecting the Show Rulers command from the Special Effects 
menu will cause horizontal and vertical rulers to appear. 

Four score and men years ago our fathers brought forth on this 
continent, o new notion, conceived in libertu. and dedicated to the 
proposition thot o II men ore created equo I. 

HoN we ore engaged in o great civil war, testing whether that notion, 
or any notion so conceived and so dedicated, con long endure. We ore aet on 
o great battlefield of that war. We hove c001e to dedicate o portion of that 
field, as o final resting place for those who hm gave their lives that 
that notion light live. It is altogether fitting and proper that we should 
do this. 

But, in o larger sense, we con not dedicate-- we con not consecrate 

. :: 

The rulers are marked in inches and will scroll with the document. 
Both paragraph indents and tab alignments can be set with the 
rulers showing. Floating hash-marks within the rulers will move 
with the pointer to give you the pointer's exact location. If an art 
area is selected, two hash-marks will appear in each ruler. These 
will give you the location of the left, right, top and bottom edges 
of the area. The rulers are correlated to the margin settings, not the 
actual page width and length. With the horizontal ruler, any ruler 
measurements that exceed the margin setting (created with the Set 
Margins command on the File menu) will be grayed out. Once 
the rulers are showing, the menu command will change to Hide 
Rulers. Select this command to make the rulers disappear. 

The horizontal ruler contains paragraph indent markers for the first 
line, left margin, and right margin. Indent markers allow you to 
indent lines and paragraphs for special effects. The first line 
indent marker is the upper left (red) triangle; the left indent marker 
is the lower left (blue) triangle; the right indent marker is the right 
(blue) triangle. These three triangular markers can be moved by 
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positioning the pointer over them, and clicking and dragging. Any 
text that is entered afterwards will conform to the markers. If the 
markers are moved after text has been entered, only the text within 
the paragraph in which the cursor is blinking will conform to the 
new marker settings. Multiple paragraphs which are selected will 
also conform to new marker settings. If art areas are added to the 
document, the indent markers may not work the same as they 
would in a document that consists of text only. For instance, if an 
art area is added to the middle of a page to create two columns of 
text, the first line indent marker will apply only to the paragraphs 
in the left column. Paragraphs starting in the right column would 
all be flush left (no frrst line indent). Left and right indent markers 
will apply to the text on the left and right margins of the page -- not 
to the left and right borders of the columns. In this case, tabs must 
be used to create consistent first line indents. 

Different tab stop alignments can also be set from the rulers. Tab 
stops can be set to align flush left, flush right, centered, or to a 
decimal point. Each different tab alignment is represented by a 
different marker. They are: 

~ Flush Left 
~ Flush Right 
,J, Center 
-i- Decimal 

To place a tab marker on the ruler, position the pointer just below 
the desired inch mark (in the same part of the ruler as the indent 
markers). Click the mouse and a tab marker will appear. Tab 
markers initially default to flush left. From that point on, unless 
more tab markers are added, the cursor will move to align itself 
below that tab marker when the Tab key is pressed. To move the 
tab marker, position the pointer over the marker, and click and 
drag. The marker will move with the mouse. Once the marker is 
moved, all text within the paragraph in which the cursor is 
blinking will reformat itself to reflect the change. If multiple 
paragraphs are selected, they will all reformat to reflect the tab 
marker changes. There is no limit to the amount of tab markers 
which can be placed on the ruler. 
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To change the tab stop alignment, position the pointer over the tab 
marker you wish to alter and click while holding the Shift key 
down. Each click will cause a different type of tab marker to 
appear. If text has already been entered, the paragraph in which 
the cursor is blinking will reformat to reflect the change. 

To delete a tab marker, click on it once with the mouse, and it will 
disappear. 

Tab markers can also be set and changed with the Set Tabs 
command from the Format menu. 

COPYING RULERS 

Paragraphs with unique formatting can have their ruler settings 
(indents and tab markers) copied. Once copied they can be Pasted 
into other parts of your document to create the same format. 

To copy a ruler, first select Show Paragraph Breaks from the 
Special Effects menu. Then, select the paragraph break symbol 
at the end of the paragraph which has the ruler formatting you 
wish to copy. Click Copy on the Edit menu. The ruler settings 
will be copied to the Clipboard. Next, select the paragraph break 
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symbol of the paragraph which is to have the ruler copied into it. 
Then, click Paste on the Edit menu. That paragraph will now 
reflect the copied ruler settings. 

LINE SPACING 

The space between lines, called "leading," can be narrowed or 
widened with the Change Leading command on the Format 
menu. This command will only change leading for entire 
paragraphs -- not selected lines within a paragraph. A paragraph is 
created every time the Return key is pressed. 

To change the line spacing select Change Leading and a dialog box 
will appear showing the line spacing settings. The line spacing, or 
leading, is measured in "points." One "point" measures 1/36 of an 
inch on the screen. Enter a number in the box next to "Top of Line 
Leading" to measure the spacing from the topmost character in a 
line of text. Enter a number in the box next to "Bottom of Line 
Leading" to measure the spacing from the lowest character in a line 
of text. 
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If the leading change is made before any text is entered, your entire 
document will reflect the change. Once text has been entered, any 
paragraph in which the cursor is blinking will reflect a leading 
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change. Multiple paragraphs that have been selected will also 
reflect a leading change. 

Click OK to accept the changes and return to the word processor. 
Click Cancel to return to the word processor without making any 
changes. 

PARAGRAPH GAPS 

The spacing, or gaps, between paragraphs can be narrowed or 
widened with the Change Leading command on the Format 
menu. A paragraph is created every time the Return key is 
pressed. 

To change the paragraph spacing select Change Leading and a 
dialog box will appear showing the paragraph spacing settings. 
The paragraph spacing is measured in "points." One "point" 
measures 1/36 of an inch on the screen. Enter a number in the box 
next to "Top of Paragraph Leading" to measure the spacing from 
the first line of text in a paragraph. Enter a number in the box next 
to "Bottom of Paragraph Leading" to measure the spacing from the 
last line of text in a paragraph. 
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If the leading change is made before any text is entered, your entire 
document will reflect the change. Once text has been entered, any 
paragraph in which the cursor is blinking will reflect a leading 
change. Any text that has been selected will also reflect a leading 
change. 

Keep in mind that any paragraph leading is dependent upon how 
the line leading is set. For example, if the "Bottom of Line 
Leading" is set at 2 points, and the "Top of Paragraph Leading" is 
set at 2 points, then the actual space between paragraphs will be 4 
points. 

Click OK to accept the changes and return to the word processor. 
Click Cancel to return to the word processor without making any 
changes. 

TEXT WRAP DIRECTION 

Text can wrap either vertically or horizontally. Medley defaults to 
vertical word wrapping (that is, whenever the text runs into an art 
area border it will drop down a line). 

With vertical word wrapping, the text continues to move down 
until it reaches the bottom of the page. At that point, it will wrap 
into any space available on that page before it moves onto the next 
page. For example, if art areas have been set up to divide the text 
into columns, the text will wrap down the left column every time it 
runs into the art area border. When it reaches the bottom of the 
page, the text will move up to the top of the page and start to wrap 
down the next column. However, if an art area is placed in the 
middle of a page, the text will wrap down so that there is a blank 
space to the right of the art area until the text reaches the bottom of 
the page. At that point, the text will move into the space to the 
right of the art area. To keep the text from wrapping behind an art 
area make sure that the area extends to the right margin. 
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Four score and seven yrars ago our fathers brought 
on this continent, a new nation, conceived in liberty, and 
dedicated to the proposition that all1en ore created equal 
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Horizontal word wrap lets you wrap text across art areas. This 
can be used when you would like the text to surround and read 
across the art. 
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To change the word wrap direction to horizontal, select the Change 
Page Layout command from the Format menu. Click inside the 
box next to "Page number" and enter the number of the page on 
which the word wrap direction will be changed. (The page on 
which the cursor is blinking is the default page number.) Click the 
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"Wrap across button" and then click the "OK button" to exit the 
dialog box. To change the text wrap back to vertical, click the 
"Wrap down button." 

0 don't change wrap 
@wrap down 
Owrap across 

0 don't changr global page parts 
@show global page ports 
0 hide global poge parts 

0 don't change global art 
@show global art 
0 hide global art 

To change the word wrap direction inside a Page Part, the Page 
Part must first be selected. (Click Move I Change Areas on the 
Areas menu, and then click inside the Page Part.) Then, choose 
the Change Page Layout command. The "Page number" option 
will be inactive (grayed out) since you are within a Page Part. 
Click the word wrap direction of your choice and then click "OK" 
to return to the text. If the Page Part is a global Page Part, the 
Change Page Layout dialog box will display "All pages" instead 
of the "Page number" option. This is because a word wrap 
direction change made in any one global Page Part will affect every 
global Page Part. 

HYPHENATION 

Selecting the Hyphenation command from the Format menu gives 
you the option to place hyphens in large words along the right­
hand margin. This command is mostly applicable to documents 
that are fully justified, or justified right. Hyphens added with the 
Hyphenation command are "soft." This means that should the 
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hyphenated word move to anther line due to further text entry, you 
will not see the hyphen mark. 

Medley's hyphenation is based on its 80,000 word dictionary. If 
the Dictionary disk is not in one of your disk drives, you will be 
prompted to insert it. The program moves through the document 
and checks words at the end of each line against the dictionary to 
see whether or not they can, or should be hyphenated. If a word 
can possibly be hyphenated, you will be given a choice on how to 
structure the hyphenation. 

To hyphenate a document, select the Hyphenation command. A 
dialog box will ask: "Where is Med.Dictionary?" The computer is 
looking for the Hyphenation word list. Eject the Medley disk, 
insert the Dictionary disk, and click the "Disk button." The file 
name "Med.Dictionary" should now appear highlighted in the disk 
listing. Click the "0 pen button" to open the file and start the 
Hyphenation process. 

fl file Edit Search Areas Font Format Special Effects Shortcuts 

... =-~~«-· 

When the program finds a word that can potentially be 
hyphenated, a dialog box will appear. At this point you can either 
hyphenate your entire document automatically, or look at each 
hyphenated word individually. 
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Click the "Auto Hyphenate button" to automatically hyphenate 
the whole document. All words will be hyphenated according to 
the dictionary Preferred format. 

Click the "Manual Hyphenate button" to look at each word 
before it is hyphenated in the document. A dialog box will appear 
with the hyphen correctly placed within the word. This will be the 
Preferred hyphenation based on the main dictionary word list. If 
the word to be hyphenated is not in the dictionary, or has been 
added to one of the supplementary dictionaries, it will be 
hyphenated based on an algorithm. 

If you would like to change the hyphenation break-points, first 
click the "Manual button." Then, position the pointer between 
the two letters to be hyphenated and click. The blinking cursor 
will appear. Enter a hyphen character from the keyboard. 

Click Hyphenate and the word will become hyphenated at one of 
the break-points according to the format that was selected 
(Preferred or Manual). The program will then move forward to 
find another potential candidate for hyphenation. When it does, 
the dialog box will appear again. Click Hyphenate All if you 



TABS 

FORMA TIING A DOCUMENT I 81 

would like to hyphenate the rest of the document automatically. 
Click the "Cancel button" to cancel the hyphenation process. 

If you would like to hyphenate specific portions of your text, first 
select the word or words, and then select the Hyphenate 
command. Only the selected text will come under consideration 
for hyphenation. 

If you would like to place a "soft" hyphen in a word manually, 
first position the cursor between the two letters to be hyphenated. 
Press the Option I Hyphen keys and the word will be 
hyphenated, but only if the word is at the end of a line on the right 
margin. Should the hyphenated word move to anther line due to 
further text entry, you will not see the hyphen mark. If a "soft" 
hyphen is placed in a word that is not at the end of a line, you will 
not see a hyphen mark until it is the last word on a line. A "hard" 
hyphen (just pressing the Hyphen key) is different than a "soft" 
hyphen because it will always be showing, no matter how the text 
is moved. 

Tab stops can be created and changed with the Set Tabs command 
from the Format menu. 

8 File [dit Search Areas font foraat Special Effects Shortcuts 
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To create a tab stop, select the Set Tabs command and a dialog box 
will appear. Since the ruler is an integral part in setting the tab 
stops, it will appear with the Set Tabs dialog box, whether or not it 
has been selected. Tab stops can be set to align flush left, flush 
right, centered, or to a decimal point. Each different tab alignment 
is represented by a different marker, all of which are listed under 
"Tab Types." All tab types will be grayed out if no tab marker is 
selected. 

To place a tab marker on the ruler, position the pointer just below 
the desired inch mark (in the same part of the ruler as the indent 
markers). Click the mouse and a tab marker will appear. Tab 
markers initially default to flush left, and this will now be reflected 
under "Tab Types." 
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From that point on, unless more tab markers are added, the cursor 
will move to align itself below that tab marker when the Tab key 
is pressed. To move the tab marker, position the pointer over the 
marker, and click and drag. The marker will move with the 
mouse. Once the marker is moved, all text within the paragraph in 
which the cursor is blinking will reformat itself to reflect the 
change. If multiple paragraphs are selected, they will all reformat 
to reflect the tab marker changes. 
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To change the tab stop alignment, click the button next to the type 
desired. It will become selected, and the tab marker on the ruler 
will also reflect the change. You can also hold down the Shift 
key while clicking on a tab marker, and the tab type will change 
with each click of the mouse. If text has already been entered, the 
paragraph in which the cursor is blinking will reformat to reflect 
the change. 

To delete a tab marker, click on it once with the mouse, and it will 
disappear. Text affected by the tab marker will change to reflect 
the deletion. 

If more than one tab marker is on the ruler, you can select a marker 
to edit by holding down the Option key while clicking on it. The 
Set Tabs dialog box will reflect the newly selected marker. There 
is no limit to the number of tab markers that can be placed on the 
ruler. 

If only the ruler is showing, and you wish to bring up the Set Tabs 
dialog box, hold down the Option key while clicking on a tab 
marker. The Set Tabs dialog box will appear reflecting the 
selected tab marker. 

To exit the Set Tabs dialog box, click in its close box. The dialog 
box will disappear, but the rulers will remain. To hide the rulers at 
the same time as the dialog box, select the Hide Rulers command 
from the Special Effects menu (while the Set Tabs dialog box is 
still showing). Both the rulers and the dialog box will disappear. 

TAB LEADERS 

When the Tab key is pressed, the cursor will move to align itself 
under a tab marker. Normally, a blank space is left from the point 
of origin to the tab marker. However, "Tab Leaders" can be 
created so that when the Tab key is pressed either a series of dots, 
dashes, or a solid line will appear between the point of insertion 
and the tab marker. 
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To create a tab leader, choose the Set Tabs command from the 
Format menu. A dialog box will appear showing "Tab Types" 
and "Leaders." Either create a new tab stop marker by clicking 
just below the numbers on the ruler, or select an existing marker 
by clicking on it while holding down the Option key. Notice that 
of the four leader types available, the blank leader is selected. 
Select one of the other visible leader types and click in the close 
box of the dialog box. All tabs using the selected tab marker will 
now have a visible leader insened. 
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Tab leaders default to printing along the bottom of the line of text. 
To have the leader print higher, select the leader by clicking and 
dragging between its point of origin and the tab marker. It will 
become highlighted. Select Choose Font from the Font menu, 
and then enter a number smaller than the font size of the text in the 
"Other Size" box. Click OK and the leader will be raised off the 
bottom line. For example, if your font size is Shaston 8, enter "4" 
in the "Other Size" box and the leader will now be located half way 
between the bottom and the top of the line of text. 

Choptrr 1 
Events leading to the Civil War ... ··· ..................... 3 
The Marth-· · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · 11 
The South · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · ·. · ... · 1~ 
The Political Structure of the South············ ......... 25 

Choptrr 2 
The Generals········ .. ·· · ······· · ······················ 31 
The Soldiers··········································· 35 
Slavery and the Korth-·· ································ ~3 
The Hojor Bottles·· ············· · ······················ 55 

TEXT WSTIFICA TION 

Text can be formatted to be Justified Left, Justified Right, 
Centered, or Fully Justified with the commands on the Format 
menu. Medley defaults to left justification. 

To format text, select the text and then click on the justification of 
your choice. The selected text will reformat to your selection type. 
If no text has been selected, all text within the paragraph in which 
the cursor is blinking will reflect the formatting change. If no text 
has been entered or if you are starting a new paragraph, first select 
the justification, and then any text that is entered afterwards will be 
formatted accordingly. 
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PAGE BREAKS 

Page breaks are designated by a solid black line which runs across 
the screen. Any time an existing document is changed, Medley 
automatically repaginates the entire document. Since Medley is 
interruptible, you do not have to wait for the pagination to finish in 
order to continue working on your document. 

You can also manually place a page break anywhere in your 
document by selecting the Add a Page Break Here command from 
the Format menu. Adding a page break with this command will 
cause all TEXT below that point to be printed on the next page. 
Graphics can still be placed below a page break. Page breaks can 
also be inserted into any Page Part. This will cause the text to 
flow into the next Page Part or the next full-sized page. 

To add a page break, position the cursor where you want to break 
the text, and click the Add a Page Break Here command. Page 
breaks are designated by a double "paragraph break" symbol when 
the Show Paragraph Breaks command from the Special Effects 
menu is chosen. 
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To delete a manual page break, choose the Show Paragraph 
Breaks command. Select the double paragraph break symbols and 
delete them. 

PAGE NUMBERS, HEADERS, AND FOOTERS 

To place page numbers in a document, select the Change Page 
Numbers command from the Format menu. Page numbers can 
consist of several different styles, and can be placed in different 
locations. Page numbers will not be displayed on the document 
screen, but can be seen with the Show Page command on the 
Special Effects menu. 

Select the Change Page Numbers command and a dialog box will 
appear. Choose the style of number by selecting it in the "Style" 
box. Choose the page number location location by clicking on one 
of the page configurations under the "Location button." To see 
more page number locations, click the "Location button" and 
four more page configuratiuons will appear. Number locations not 
selected will be grayed out. 
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Change Page Humbers ... 
Style 

@(none) 
012 
Oxii 
OXII 
Otwelve 
OTwelve 
0TWELVE 

Affect Pages [[] 
through ill] 

( Choose font V H~ber Page 1 as [] 

[:,s·rncornl 

You can select different fonts, sizes and styles for page numbers 
by clicking the "Choose Font button." The Choose Font dialog 
box will appear, and fonts can then be chosen in the normal 
manner. 

Larger page number font sizes may affect your final printed 
document. Page numbers are placed within the parameters set by 
the horizontal margins, but are not correlated to the vertical 
margins. Page numbers are always placed based on the top or 
bottom of the page, llQ1 the top or bottom margins. Therefore, if 
you have a large page number, it may run into the text, depending 
how close to the edge of the page your vertical margins are set. 
The farther from the edge of the page your vertical margins are set, 
the less likely you are to have a problem with large page numbers. 
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, ................................. , 
~ D-

Page numbers default to printing 18 points away from the top or 
the bottom of the page. 18 points equates to 1/2", and is the 
required minimum distance from the edge of the page for some 
printers. (For example, if text or art is closer than 1/2" to the edge 
of the page, the LaserWriter will clip the portion that overlaps the 
1/2" margin.) To change the distance from the edge of the page, 
enter a number in the box next to "Points from edge of paper." 

Change Poge HuJDbers... Points troll edge of paper lit[~] 
Style [] 

0 (none) (]D) ~ Affect Pages 1 
012 through [[] 

( Choose font ) H b p 1 [[] lr ( location ~ IE er oge os I 

.._______. 1 OJ [j] [ I] OJ 
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Page numbers on the first page of a document can start with any 
number. If the first page of your document will be numbered" I," 
leave the box next to "Number Page 1 as" set to the default choice 
(1). If the first page of your document is a continuation of another 
file, enter a new number in the box next to "Number Page 1 as." 
For example, all documents in Medley are limited to 32 pages. If 
your document will be longer than 32 pages, it must consist of at 
least two separate files. Therefore, the first page of the second file 
would start with number 33. 

Change Page Humbers ... Points from Pdgp of pow ~ 
St~Je 

0 (none) 
@12 
Oxii 
OXII 
Otwelve 
0Twelve 
0 THE LYE 

Rffpct Pogps [] 

through [ill 
( Choose Font ) H b P 1 mr-1 

~ Pr ogp OS~ lc ( looohoo ) 1 
[]J fl~J OJ CD 

Once page numbers are selected, they do not have to show on all 
pages. Enter the numbers of pages in which you want them to 
appear in the boxes next to "Affect Pages." For example, if the 
first page of your document will be a title page, you may not want 
a page number on it. Leave the number "1" in the box next to 
"Number Page 1 as." Change the boxes next to "Affect Pages" so 
that they read "2 through 32." Page numbers will now start to 
appear on page two, starting with the number two. 

Text can appear on the same line as a page number, so that headers 
or footers can be created. Whether the line of text becomes a 
header or a footer depends on which location is chosen for the 
page numbers. To create a header or footer, enter text in the boxes 
below "Text Surrounding Page Numbers." The gray diamond 
represents the location of the page number within the line of text. 
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Text can be entered in front of, or behind the diamond. The 
diamond can be deleted (place the cursor to the right of it and press 
the Delete key) if you want no numbers in your headers or 
footers. If the diamond is deleted, it can be placed back in the edit 
box by pressing the Option I# keys. Text can be structured 
differently to reflect even or odd numbered pages. Text 
surrounding numbers will be subject to the choices made in the 
"Affect Pages" boxes. 

Change Poge Humbers ... Points from edge of paper [[] 

Affect Pages [] 
through [ill 

Style 
0 (none) 
@12 
Oxii 
OXII 

( Choose Font ) M b P 1 [IT] 

ffiiTIDJ'DJi 
~~~es I Linco In ond the Civi I War ¢ 

Text Surrounding Page Humbers (¢--type "Option / I") 

~~;~s 1¢ Lincoln and the Civil Wor ~ 

Click OK to accept all page number modifications and return to 
your document. Click Cancel to return to the document without 
making any changes. 

LOCAL EXCEPTIONS TO GLOBAL ART AND PAGE PARTS 

If you have set up your document to contain either global art areas 
or global Page Parts there may be specific pages on which you do 
not want them to appear. (See "Placing Areas On All Pages" if 
you do not know how to create a global area.) Global areas can be 
determined by the fact that their borders will be blue instead of 
orange when they are selected. 

To hide global art or Page Parts, fust make sure that there are no 
areas selected. Choose Change Page Layout from the Format 
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menu and a dialog box will appear. "Hiding" is different from 
"deleting" because you can always retrieve the hidden Page Part or 
art area and its contents. 

" File Edit Search Areas Font For1ot Special Effects Shortcuts 

0 don't change wrap 
@wrap down 
0 wrap across 

0 don't change global page ports 
@show global page ports 
0 hide global page ports 

0 don't change global art 
0 sh011 global art 
~hide global art 

But, in a larger sense, we con not dedicate-- we can not consecrate-- we con 
not holl011 --this ground. The brave men, living and dead, who struggled hm, 

Page 1 

Click in the box next to "Page number" and enter the page 
number where the area is to be hidden. (The page on which the 
cursor is flashing is the default page number.) Click the "Hide 
global page parts button" if the area is a Page Part. Click the 
"Hide global art button" if the area is an art area. Click OK to 
return to the text. Any text contained in the Page Part will not be 
deleted, but it will appear on the page or in the next Page Part. 
Hiding global areas affects an entire page. (You cannot select and 
hide one particular global area on a page.) If any areas are selected 
in your document, the "global hide buttons" will be grayed out. 

To make an art area or Page Part reappear, click the "Show 
global page parts button" or the "Show global art button." 
Text or art in these areas will reappear with them. 

CHANGING TEXT TO UPPERCASE AND LOWERCASE 

Entire blocks of text can be changed to uppercase (all capitals) or 
to lowercase (no capitals). 
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To change a block of text to uppercase, select the text to be 
changed with the mouse or the arrow keys. Select the Change To 
Uppercase command from the Format menu. The entire block of 
selected text will now be in uppercase. Selecting the Change To 
Lowercase command will convert an entire selected block of text to 
lowercase. 

6tob or 6' 
Rdd o Page Break Here 6, 
Change Page Lo~out... 

But, in o larger sense. we con not dedi --we 
not hollow-- this ground. The brave men, living 
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SPECIAL EDITING COMMANDS 

SPELL CHECKING A DOCUMENT 

Medley includes an integrated 80,000 word spell checker. The 
spell checker will recognize and suggest alternatives for misspelled 
words as well as words misspelled phonetically (e.g., the word 
"dikshunary" would have "dictionary" suggested as an 
alternative) . You can check the spelling of an entire document, or 
just the text that you select. 

To check the spelling of an entire document, you must first load 
the Dictionary disk. Select the Spell Check command from the 
Search menu. A dialog box will ask: "Where is 
Med.Dictionary?" The computer is looking for the Spell Checker 
word list. Eject the Medley disk, insert the Dictionary disk, and 
click the "Disk button." The file name "Med.Dictionary" should 
now appear highlighted in the disk listing. Click the "0 pen 
button" to open the file and start the Spell Check. 

fi File Edit Search Areas font for1ot Special £ffects Shortcuts 

( Disk ) 
so 

Open ~ 
Clm 

( Cancel ) 

But, in a larger sense, 11e con no cote-- we con not consecrate-- we con 
not hollow-- this ground. The brave men, living ond dead, who struggled here, 

Page 1 
1'.·.· .. - 0:."'·' • 

Once the Spell Check is started a dialog box will appear that says: 
"checking spelling of entire text." At the same time you will see a 
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graph showing the percentage of text remaining before the Spell 
Check is completed. While this dialog box is on the screen, you 
can abort the spell check at any time by pressing the COMMAND -
Period (.) keys. If a word is found that Medley does not 
recognize, another dialog box will appear with instructions on how 
to handle it. 

0\ 100\ 
~ ·· .. · ·· .. -

1 o conce I Spe 11 Check hoI d down the 6 ke~ 
and type o period(.). 

OS 0 

those who hm gave their lives that that notion 
might live. It is altogether fitting ond proper that 
we should do this. 

But, in o larger sense, we con not dedicate-- we con not consecrate-- we con 
not hollow-- this ground. The brave men, living and dead, who struggled here, 

Any word that the Medley dictionary does not recognize will 
appear in the "edit box" (below "Replace it with"). If the word is 
misspelled and you know the correct spelling, you can modify it in 
the "edit box." Once the correct spelling is entered, click Here to 
replace the misspelled word in that instance only, or click 
Everywhere to replace it in every case within the document. 

If the word is spelled correctly but is not in the Medley dictionary 
(e.g., last names), you can tell the program to "Ignore" it Here, or 
throughout the entire document (Everywhere). If you will be 
using the word frequently, you can add it to the Document 
Dictionary by clicking the "Add button." 



96 I SPECIAL EDITING COMMANDS 

The ~lord "Abraham" is not in the word lists. 

~ Stop Spell Checking. 

(Suggest) Suggest Alternate Spellings. 

IIJP Add it to the Doc~ent Dictionary. 

( Rdd ) Add it to the AuxiliarH DictionarH. 

~ ("E,-ve-rti-:-Wh-ere--..,) Ignore. 

~ [ [l!NIJI1hm » =Re=pl=ac=e 1,.-·t_wi_th _____ _, 
I~ 1. 

Once the word is added the spell check will continue. Any 
commonly used words can be added in this fashion so that they 
will not be flagged in the future. The Document Dictionary is 
specific to the active document, so that any words added to the 
Document Dictionary in one document will be flagged if another 
document is spell checked. To add words that will be recognized 
by all documents, you must edit the Auxiliary Dictionary from the 
Dictionaries command. 

If you are not sure of the spelling, click Suggest to have the 
program suggest several possibilities. At this point, another dialog 
box will appear with the suggestions. To replace a misspelled 
word with one of Medley's suggestions, scroll through the list of 
possible alternatives. Position the pointer on the correct word and 
click. Click the "Here button" to replace the word in that instance 
only. Click the "Everywhere button" to replace it in every case 
within the document. If you do not see the correct alternative, 
click Cancel to return to the previous dialog box. If no words 
appear, then Medley has found no close matches to the unknown 
word. 
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It File Edit Search Areas font For1ot Special Effects Shortcuts 
lincoln 

fours ... forth on this contenent, a new notion, conceived in Libert ... new n 
men or The word "contenent" is not in the ~lord lists. .. r •• , .l ~Inn ~noll rhor~ino 

Suggest Alternate Spellings ... 

·~·111111!~11' ~ contingent ~ 
Replace it with cantonment 

continuant 
contented \;§· (0 
cantainaent ~~~~ ((EVWJ11hmj contenting 4i 
continentlij {} ~ 

To check the spelling of selected text, first select the word or 
words. Then select the Spell Check command from the Search 
menu. Load the Dictionary Disk in the same manner as you would 
for spell checking the entire document. The spell checker will 
search only the selected text. 

ADDING WORDS TO THE DICTIONARIES 

The Dictionaries command on the Search menu lets you see, 
delete, or add any words to the various dictionaries. The 
Document Dictionary contains words pertaining only to the active 
document. An Auxiliary Dictionary contains words that will be 
recognized by the spell checker for all documents. The 80,000 
word Medley Dictionary can not be edited. 
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K File Edit Search Areos font foraot Special Effects Shortcuts 
Lincoln 

( Edit Document Dictionary~ 

( £dtt nuXtltaru Olctionor~ ) 

Ho Au xi! iory Dictionary se Jected 
( Create Au xi I ior y Dictionary ) 

( Select Auxiliary Dictionary ) 

( Stop using Auxil iaru O ictionor~ ) 

.... '; ... 

Select the Dictionaries command and a dialog box will appear. 
Click Edit Document Dictionary to see the list for the active 
document. All words that have been added to 1lliU Document 
Dictionary will be listed alphabetically. If there are too many 
words to fit inside the box, you will be able to scroll through 
them. 

Edit Do cUilent Dictionary ... 
Abroho11 

rn::::-'1 Gettysburg 
~~ 

so 

But, in o larger sens ·-we con 
not hollow-- this ground. I he brave men, liVIng and dead, who struggled here, 
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To delete a word from the Document Dictionary, position 
the pointer over the word and click. The word will become 
highlighted. Click the "Delete button" to delete the word. 

To add a word to the Document Dictionary, enter the word 
in the box next to Add. Click the "Add button" and the 
word will be added to the dictionary. Words can also be 
added to the Document Dictionary from the Spell Check 
command. 

Click Done to exit and return to the word processor. 

To add words that will be recognized by the spell checker for all 
documents, you must have created and selected an Auxiliary 
Dictionary. The "Edit Auxiliary Dictionary button" will be 
grayed out if no Auxiliary Dictionary is selected. Only one 
Auxiliary Dictionary can be open at a time. 

To create an Auxiliary Dictionary, select the Dictionaries command 
and a dialog box will appear. Click Create Auxiliary 
Dictionary, and a dialog box will appear with the name of the 
disk and the memory available on it. 

fi File Edit Search Areas Font For1ot Special Effects Shortcuts 
Lincoln 

S /Hd2/Dictionary/ 
Free: 1546k out of 10240k. ( Disk ) 

D £n9.H~p 0 ( Hew F o I der ) 
D £n912Clx 
D finder Doto 
D H~d Oic t ioooru 
D U solf~x. Sun 
D W~bstN.lex 

Dictionary H011e: 

I Au xi I iaryl 
But, in o I orger we con 
not hollow-- this ground. I he brave men, liVIng and dead, who struggled here, 

Page 1 

Enter the name you wish to give the Auxiliary Dictionary in the 
box below "Dictionary Name." To place your Auxiliary 
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Dictionary on a different disk, insert the disk and click the "Disk 
button." The name of the new disk will appear next to the small 
disk icon. Folders can be created, opened, and closed in the 
normal manner so that you can better organize your Dictionaries. 
(See "Saving a Document" for complete details.) Click Create 
and a file will be created for your Auxiliary Dictionary. You are 
then returned to the word processor, and the newly created 
dictionary will be active. However, it will have no words in it. 

To add or delete words from an active Auxiliary Dictionary, select 
the Dictionaries command and a dialog box will appear. The name 
of the active Auxiliary Dictionary will be displayed above Create 
Auxiliary Dictionary. 

Iii File Edit Search Areas Font For1at Special Effects Shortcuts 
lincoln 

(Edit Document Dictionary) 

(Edit Auxiliary Dictionary ) 

Current dictionary is Civil.War ~ 
( Create Auxiliary Dictionary ) 

( Select AuxiliarH Dictionary ) 

(Stop using Auxiliary Dictionary ) 

Click the "Edit Auxiliary Dictionary button." A dialog box 
will appear, alphabetically listing all words that have been added to 
that Auxiliary Dictionary. If there are too many words to fit inside 
the box, you will be able to scroll through them. 
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Antietalll 
Appa11attax 
Confederate 
Fredericksburg 
Gettysburg 
Jackson 
Poto11oc 
Sumner 

(Add J) I Sher11on 

so 

To delete a word from the Auxiliary Dictionary, position 
the pointer over the word and click. The word will become 
highlighted. Click the "Delete button" to delete the word. 

To add a word to the Auxiliary Dictionary, enter the word 
in the box next to Add. Click the "Add button" and the 
word will be added to the dictionary. 

Click Done to exit and return to the word processor. 

To select an Auxiliary Dictionary, choose the Dictionaries 
command and a dialog box will appear. Click Select Auxiliary 
Dictionary, and a dialog box will appear listing the Auxiliary 
Dictionaries available. Select the name of the dictionary you wish 
to have open, and click the "Open button." You will be returned 
to the word processor with the selected dictionary active. If the 
Auxiliary Dictionary you wish to open is on another disk, insert 
the disk and click the "Disk button." Dictionaries located on the 
new disk will appear in the dialog box. Auxiliary Dictionaries 
located in folders can be accessed with the 0 pen and Close 
buttons. Click Cancel to return to the word processor without 
selecting any Auxiliary Dictionary. 
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But, in o larger sens ·-we con 
not hollow-- this ground. I he brave men, 11v1ng and dead, who struggled hm, 

Page 1 

If you wish to use another Auxiliary Dictionary, simply select the 
other dictionary. To stop using the active Auxiliary Dictionary, 
click Stop Using Auxiliary Dictionary and no Auxiliary 
Dictionary will be selected. 

THE ELECfRON1C THESAURUS 

The Medley Thesaurus will suggest synonyms for specified words 
within your document. The Thesaurus provides appropriate 
synonyms for many different word usages. Note the differences 
in the synonyms that the Thesaurus provides for the word "sound" 
in the following sentences: 

That idea seems quite lli!!ld. (stable, firm, secure) 

What was that~? (noise) 

Sound the alarm. (declare, announce, broadcast) 

The Thesaurus will also provide a different choice of synonyms 
according to the number of the word. 
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He heard a loud sound. (noise) 

He heard loud sounds. (noises) 

Finally, the Thesaurus will provide different synonyms according 
to the tense of the word. 

She will sound the alarm. (declare, announce) 

She sounded the alarm. (declared, announced) 

The Thesaurus will not work unless the Dictionary disk is loaded. 
First, select a word by double-clicking on it. Then, select the 
Thesaurus command from the Search menu. A dialog box will 
ask: "Where is Med.Dictionary?" The computer is looking for the 
Thesaurus word list. Eject the Medley disk, insert the Dictionary 
disk, and click the "Disk button." The file name 
"Med.Dictionary" should now appear highlighted in the disk 
listing. Click the "Open button" to open the file and start the 
Thesaurus. 

IIi File Edit Search Areos Font For1ot Special Effects Shortcuts 

so 

Once the Thesaurus has been started a list of synonyms for the 
selected word will appear. Some words may have more than one 
definition. This will be indicated in the upper left corner of the 
dialog box. "1 of 1" means that the definition is the first and only 
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definition of the selected word. "1 of 8" means that the definition 
is the first of eight definitions of the selected word. Each 
definition may have many possible synonyms. If more synonyms 
exist than can fit in the box, use the scroll bar to view them all. To 
see the next definition, click the "Next button." To see the 
previous definition, click the "Last button." 

n File [dit Search Areas Font F or1ot Special Effects Shortcuts 
Lincoln 

Four score and seven ~ears ago our fathers brought forth on this continent, o 
new notion, conceived in Libertu, and dedicated to the proposition thot all 
men ore created !E!IlD. 
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To replace the selected word (in the document) with a synonym, 
click on any synonym. The word will become highlighted. Click 
OK and you will be returned to the word processor. The selected 
word will be replaced with the chosen synonym. 

To leave the Thesaurus without making any changes, click the 
"Cancel button." 

SHOW PARAGRAPH BREAKS 

The Show Paragraph Breaks command will display all paragraph 
break symbols ( t ) on the screen. Paragraph break symbols are 
inserted every time you press the Return key and are invisible 
unless this command is selected. 
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Once the paragraph break symbols are showing, the command will 
change to Hide Paragraph Breaks. Selecting this command will 
cause the "paragraph break" symbols to become invisible once 
again. 

SHOW SPACES AND TABS 

The Show Spaces and Tabs command will display all spaces in the 
text as a slightly raised period. 

Rfrican·R 
TH£.CROCOOILE TH 
-+ OnP·Of·thP·oldtst·rP I otivPs·of·thP 
dinosour·sti ll·o I ivt-todoy·is·thP· 
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Tabs will be displayed as an arrow pointing to the right. Spaces 
are inserted into your text every time the Space Bar is pressed. 
Tabs are inserted every time the Tab key is pressed. 

Once the Space and Tab symbols are showing, the command will 
change to Hide Spaces and Tabs. Selecting this command will 
cause the Space and Tab symbols to become invisible once again. 

SHOW AN ENTIRE PAGE 

To see the page displayed on the screen as a full page, select the 
Show This Page command from the Special Effects menu. 
This command produces a dialog box showing the entire page 
(both text and art) as a 75% reduction. No changes can be made 
within the Show This Page dialog box. 

fi File Edit Search Rreos Font For1ot Special Effects Shortcuts 

If your document consists of two or more pages, the pages will be 
displayed in pairs with the page number below the corresponding 
pages. If your document consists of more than two pages, you 
can move through the pages by using the scroll bar. 

Clicking the "Cancel button" returns you to your document. 
Positioning the pointer inside one of the pages and clicking will 
return you to your document at that spot on that page. 
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SHORTCUTS 

FIND A PAGE NUMBER OR GO TO ANY PAGE 

You can quickly locate the number of the page that is displayed on 
the screen by selecting the Go To Page command from the 
Shortcuts menu, or pressing COMMAND - G. A dialog box will 
appear showing the page number in small rectangle. The page 
number is also located in the left corner of the horizontal scroll bar. 

fi File Edit Search Rreos Font Foraot Specia l Effects Shortcuts 
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not hollw-- this ground. lhe brave men, I iving ond dead, who struggled here, 

Poge 1 

To move to any page, enter the page number you wish to go to in 
the small rectangle and click 0 K. You will be returned to the 
specified page in your document. 

Click Cancel to cancel the command and return to the word 
processor. 

SELECTING A SENTENCE 

Select This Sentence will select the sentence in which the cursor is 
blinking. Also, clicking three times on any word in a sentence will 
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select the sentence. The style, font, and size of the selected 
sentence can then be changed, or it can be moved, copied, or 
deleted. 

SELECfiNG A PARAGRAPH 

Choosing the Select This Paragraph command will select the 
paragraph in which the cursor is blinking. Paragraphs are denoted 
by the "paragraph break" symbol, which can be seen by clicking 
Show Paragraph Breaks on the Special Effects menu. Also, 
clicking four times on any word in the paragraph will select the 
entire paragraph. The style, font, and size of the selected 
paragraph can then be changed, or it can be moved, copied, or 
deleted. 

SELECTING THE ENTIRE DOCUMENT 

Choosing Select All Paragraphs will select all text within the active 
document. The style, font, and size of the entire document can 
then be changed, or it can be moved, copied, or deleted. 

MOVING BElWEEN DOCUMENTS ON THE DESKTOP 

Any document that is opened is considered to be on the "Desktop." 
You can have up to ten documents on the Desktop at one time. 
Any document on the Desktop will have its title displayed at the 
bottom of the Search menu. To move between opened 
documents, position the pointer on the document title you wish to 
bring to the front, and click. That document will become active. 
The active document will always have its title grayed out under the 
Search menu. 
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dedicated to the proposition that all 
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But, in o larger sense, we con not dedicate-- we con not consecrate-- ~1e con 
not hollow -- this ground. The brave men, living and dead, who struggled here, 

TEXT MENU I KEYSTROKE COMMANDS 

Many of the menu commands can also be activated from the 
keyboard. These commands will have an "open apple" and a 
letter, number, or symbol next to them on the menu. The "open 
apple" is an abbreviation for the Command key. The Command 
key pressed with the letter, number, or symbol will activate the 
corresponding menu command. Below is a list of all keystroke 
commands available in the Text mode: 

Help .. .. ................ . ..... . . .. ....... Command I? 
New Document ........................ Command IN 
Open Document ...................... . Command I 0 
Close [Document Name] ............. Command I W 
Save As [Document Name] ......... . Command IS 
Print ................................... . . Command I P 
Quit .......... . ...... .. ........ . . .. .... . . Command I Q 
Undo . ............... . ........ ........... Command I Z 
Redo . .. . . ....... . .. . .. .. . ........ . ..... . Command I A 
Cut .... . ................................ . Command I X 
Copy .................................... Command I C 
Paste .. .... . . .. ......... .. ...... .. ..... .. Command IV 
Duplicate ............ . .......... . ...... . Command I D 
Find ............... . .......... . ......... . Command I L 
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Replace .......................... .. . .... Command I K 
Add Art Rectangle .................... . Command I I 
Add Art Round Rectangle ... . ... . ... . Command I 2 
Add Art Oval.. ........................ . Command I 3 
Add Art Polygon ......... . . . ... . .... .. Command I 4 
Convert Areas ... . .......... .......... . Command I = 
Bold Text.. ............................ . Command I B 
Underline Text.. ...................... . Command I U 
Italic Text .............................. . Command I I 
Choose Font ........ .................. . Command IF 
Set Tabs ............................. ... Command I Tab or' 
Add a Page Break Here .... ........... Command I RETURN 
Left Justified ..... . .......... .......... . Command I< 
Right Justified .................. . ..... . Command I> 
Centered ........ . ..................... .. Command IE 
Fully Justified ....................... .. Command I J 
Show Rulers .......................... . Command I R 
Show Spaces and Tabs ........ . ... . .. Command IT 
Show Paragraph Breaks ..... ........ Command I Y 
Go To Page .......................... .. Command I G 
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ADDING ART AREAS TO A DOCUMENT 

Inserting art areas into text allows you to customize your 
document. With Medley, you are able to create any shape of art 
area, and the text will wrap around it automatically. Art areas can, 
of course, contain art, but they can also have nothing at all in 
them. In this way, they can be used to form borders and columns 
and improve the final appearance of your document. Although 
you can design your page layout before text is entered, Medley 
will process text more quickly if you enter most of the text before 
any art areas have been created. 

One important thing to keep in mind is that Medley is fully 
interruptible. In other words, you do not have to wait for a 
command to be finished before you can go on and do something 
else. For example, if you have added an art rectangle to a full page 
of text, the text will start to wrap around the rectangle. However, 
you can start to type before the text has finished its reformatting. 
The text wrapping will eventually finish, as it works to catch up 
during your pauses. 

ADDING RECTANGLES, OVALS, AND POLYGONS 

To add an area to your document, select one of the options 
(rectangle, round rectangle, oval, or polygon) from the Areas 
menu. Once the pointer is moved back below the Title Bar, it will 
become a small "+". Position the pointer at the spot where you 
wish the art area to be inserted, click, and drag. The area will 
grow and shrink with the mouse movement. Once the art area is 
the desired size, let up on the mouse button and an area with 
orange borders (gray borders on a monochrome monitor) and 
black squares on the sides called "pull tabs" will be placed on the 
page. Any text will automatically wrap around it. 
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NOTE: lfyou are adding an art area to a document that already has 
several art areas, there may be a delay before the "+"pointer 
appears. The more art areas there are, the longer the delay may be. 
Check to see that Areas in the Menu Bar is still highlighted. This 
means that the Add [art area] command is still active. 

A polygon will be represented by a "+" for freehand drawing. 
Position the "+" wherever you want to start your polygon, then 
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click and drag the mouse. Dragging the mouse creates a multiple­
sided art area made up of small line segments. Letting up on the 
mouse button will automatically complete a closed polygon. 
Polygon borders will be black until the polygon is completed. The 
borders will then turn orange (gray on a monochrome monitor) 
with pull tabs separating the line segments. Polygons with longer 
line segments can be created by holding down the Shift key as the 
polygon is drawn. Press the Shift key while you click the mouse 
(letting up on the button). Each click becomes an anchor point. 
Once you let up the mouse button, the line segment moves with the 
mouse until it is clicked again. Letting up on the Shift key closes 
the polygon. 
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living ond dead, who struggled hm, hove cons 

SELECfiNG ART AREAS 

Selecting an art area allows you to make simple modifications to 
the area while in the Text mode. To select an art area, click the 
Move I Change Areas command from the Areas menu. A check­
mark will appear next to the command. Position the pointer over 
the art area you wish to change and click. The borders will turn 
orange (gray on a monochrome monitor), signifying that the area 
is in the Move I Change mode and ready to be modified. Once you 
are in the Move I Change mode, any area in which you click will 
be selected. You can also enter the Move I Change mode by just 
clicking ONCE in any unselected (black bordered) area. 
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You can de-select an area by clicking in another art a~a. clicking 
in the text, or clicking the Move I Change Areas command (the 
check-mark will disappear). 

Any text that has been selected before you enter Move I Change 
can still have its fonts and styles changed from the Font menu. 
This allows you to see how different styles and sizes of text will 
be affected by the changing art areas without having to go back 
into the Text mode. 

CHANGING AREA SIZES 

Any area that is to be resized must first be selected (that is, it will 
have orange borders, gray on a monochrome monitor). This 
signifies that the area is in the Move I Change mode. 

Any area that has just been added to the document is automatically 
in the Move I Change mode. To place an existing area in the Move 
I Change mode, select Move I Change Areas from the Areas 
menu, and then click inside the area you wish to modify. You can 
also enter the Move I Change mode by just clicking ONCE in any 
unselected (black bordered) area. Once you are in the Move I 
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Change mode, you can move from area to area without re-selecting 
Move I Change Areas. The Move I Change mode is de-selected by 
clicking anywhere outside an art area. 

To stretch an area's borders, position the pointer inside the area 
and click to select it. The borders will turn orange (gray on a 
monochrome monitor). Position the pointer on the pull tab on the 
side you wish to stretch, click, and drag. Areas can only be 
stretched one direction at a time. Polygons are made up of many 
line segments, each separated by a pull tab, which can be stretched 
to re-size the area. 
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If you make an area smaller than the art that is inside, the art 
outside the area borders will be "cropped" (not deleted) as long as 
the area remains selected. If the area is once again resized to be 
larger, then the "cropped" art will show again. If the area is de­
selected, then the art outside the area borders will become 
"clipped" (deleted). If the area is resized, the "clipped" art will 
never show. 

You can resize an area one pixel at a time by clicking on top of a 
pull tab, letting up on the mouse, and then pressing the Option 
key at the same time you press an Arrow key. Pressing the Shift 
- Option - Arrow keys simultaneously will stretch the area ten 
pixels at a time. This feature will also allow you stretch an area 
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beyond the borders of the screen (e.g., the entire length of a page) 
without having to scroll the document. 

Selecting a round rectangle and pressing the Control and Option 
keys with an Arrow key enables you to control the "roundness" 
of the rectangle. Pressing the Control - Option - Shift -
Arrow keys accelerates changes. 
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not hollo1~ --this ground. The brave men. living ond dead, who struggled here, 

CUSTOM DESIGNING POLYGONS 

Once a polygon is created it can be redesigned so that it can 
assume virtually any shape. Polygons can have their borders 
resized in the same manner as any other art area, and they can have 
line segments either added or subtracted. For example, a rectangle 
can be redesigned to assume the shape of a capital "L". 
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To add a line segment, select a polygon. Position the pointer just 
inside a border line. Click and drag while pressing the Option 
key. The line segment will become hinged at the pointer, creating 
two line segments out of one. Both new line segments will stretch 
as the mouse is moved. Once the mouse button is let up, the line 
segments will turn orange (gray on a monochrome monitor) and a 
pull tab will appear where the mouse pointer was positioned. 
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To subtract a polygon line segment, drag any pull tab on top of an 
ADJACENT PULL TAB, and the two line segments will become 
one. However, a polygon must always have at least three sides. 

MOVING AREAS 

Any area that is to be moved must first be selected. (It will have 
orange borders, gray on a monochrome monitor.) This signifies 
that the area is in the Move I Change mode. 

Any area that has just been added to the document is automatically 
in the Move I Change mode. To place an existing area in the Move 
I Change mode, select Move I Change Areas from the Areas 
menu, and then click inside the area you wish to modify. You can 
also enter the Move I Change mode by just clicking ONCE in any 
unselected (black bordered) area. Once you are in the Move I 
Change mode, you can move from area to area without re-selecting 
Move I Change Areas. The Move I Change mode is de-selected by 
clicking anywhere outside an art area. 

To move an area to another location on the same page, position the 
pointer inside the area and click to select it. The borders will turn 
orange (gray on a monochrome monitor). Click once again inside 
the area and drag the mouse. The area will move with the mouse. 
Areas can be moved with art inside them. 
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Pressing the Option key and an Arrow key at the same time 
moves a selected area one pixel at a time in the direction of the 
arrow. Pressing the Shift - Option - Arrow keys moves the 
area ten pixels at a time. 

To move an area to a different page, use the Cue and Paste 
commands on the Edit menu, or Convert Areas from the Areas 
menu. See "Moving Areas To a Different Page." 

By pressing the Shift key while clicking inside any unselected 
(black border) areas, you can select more than one area while in 
the Move I Change Areas mode. This allows you to move the 
selected areas as a group. To detach any area from the group, you 
must fust be in the Move I Change mode. Position the pointer in 
the area you want to detatch, and press the Shift key while 
clicking. 
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EXACT SIZING AND POSITIONING OF AREAS 

Areas can be sized and moved to precise coordinates using either 
the rulers, or the Show Move I Change Info command if you need 
to see the entire page while making changes. 

To use the rulers, choose the Show Rulers command from the 
Special Effects menu. Horizontal and vertical rulers will 
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appear. Aoating hash-marks within the rulers will move with the 
pointer. To resize an area, select it, click and drag on a pull tab, 
and the hash-marks will display the exact coordinates of the 
moving pull tab. To move an area, select it, and click in its center. 
Drag the mouse and two sets of hash-marks will appear on each 
ruler. They represent the right and left borders of the area, and the 
top and bottom borders of the area. 

If the areas are selected as a group, the ruler hash-marks will 
display information pertinent to the areas as a group. The hash­
marks in the horizontal ruler represent the extreme left and right 
area borders. The hash-marks on the vertical ruler represent the 
extreme top and bottom area borders. 
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D 
To change areas while the entire page is showing, select Show 
Move I Change Info from the Areas menu. This command will 
will allow you to size and position any area in increments of a 
sixteenth of an inch. To see this information in its entirety, the 
document window must be resized to the left with the "Resize 
Box." This will leave space for the Move I Change Info box to 
appear. 
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Select the area you wish to change. The area's coordinates will 
appear along with a small graphic representation of the entire page 
in the Move I Change Info box. No text is shown on the smaller 
version of the page, only art areas. The selected art area is 
designated by its orange borders (gray on a monochrome 
monitor). The gray, dashed lines close to the perimeter of the page 
represent the margins. Art areas must be moved and resized on the 
full-size page, not the smaller version in the Move I Change Info 
box. 

The area coordinates are measured in inches. Top represents the 
number of inches from the top margin to the top of the area. Left 
represents the number of inches from the left margin to the left side 
of the area. Width and Height represent the dimensions of the 
area. As an area is moved or resized on the full-sized page, the 
coordinates will change in the Move I Change Info box. The small 
representation of the area in the Move I Change Info box will not 
move until the mouse button is let up. 
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For a polygon, you can get the coordinates of any particular pull 
tab by positioning the pointer on the pull tab, clicking, and holding 
down the mouse button. Point Horiz. represents the distance 
from the left mar~in to the pull tab. Point Vert. represents the 
distance from the top margin to the pull tab. If the pull tab is 
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moved (by dragging the mouse), the coordinates will change with 
the movement. 

If you have selected areas that are grouped together, the Move I 
Change Info box displays information pertinent to the areas as a 
group. Top represents the number of inches from the top margin 
to the top of the uppermost area. Left represents the number of 
inches from the left margin to the left side of the area that is 
farthest left. Width and Height represent the dimensions of the 
areas as a grQ,YQ (Width= left area to right area, and Height= top 
area to bottom area). As the areas are moved, the coordinates will 
change. 
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After Show Move I Change Info has been selected, the Areas 
menu displays Hide Move I Change Info , so that it can be de­
selected. 

CONVERTING AREAS TO DIFFERENT TYPES 

To convert any art area to another type (e.g., from a rectangle to an 
oval), select the Convert Areas command from the Areas menu. 
An art area must first be selected (be in the Move I Change mode) 
or Convert Areas will be grayed out. A dialog box will appear, 
listing several options. 
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The upper right corner lists the four art area types (rectangle, oval, 
round rectangle, and polygon). The type of the selected art area 
will have its button turned "on." To change your art area to 
another type, click any of the other three buttons. Any art in the 
area will remain, although it may be cropped inside the new area. 

Click 0 K to accept the changes, or click Cancel to cancel any 
changes and return to the document. 

MOVING AREAS TO A DIFFERENT PAGE 

To move an area or group of areas to another page, you must use 
the Cut and Paste commands on the Edit menu, or the Convert 
Areas dialog box. 

The Cut and Paste commands work just as they do with text. 
First, select an area or group of areas. The borders will turn 
orange (gray on a monochrome monitor). Select Cut and the 
selected area(s) along with any contents will be removed from the 
document and placed on the Clipboard. Make sure that the page 
on which you wish to move the area is showing on the screen, and 
then select Paste. The selected art area is copied into the document 
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at the top of the highest page showing. For example, if both pages 
number 2 and 3 are showing, the selected area will be Pasted to the 
top of page 2. Once the area has been Pasted to the correct page, 
move it to its final location on the page by clicking in its center and 
dragging. 

The cut art area remains on the Clipboard until something else 
replaces it (using Cut or Copy), so you can move the same area 
several times without having tore-select it. Art that is Cut to the 
Clipboard can also be placed in any other document. Simply open 
the other document and Paste the Clipboard contents into it. 

To use the Convert Areas dialog box, you must first select an area 
or group of areas. Then select Convert Areas from the Areas 
menu. Click the "Move to page button" and enter a page 
number in the box. The area with its art will be moved from its 
present page to the new page. Any areas that have been selected as 
a group can also be moved in this way. 
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Click 0 K to accept the changes, or click Cancel to cancel any 
changes and return to the document. 

PLACING AREAS ON ALL PAGES 

Medley gives you the ability to create "global an," or an areas that 
appear in the same place on ill.l pages of your document. To install 
global art (useful for uniform page lay-outs) you must first select 
an area or group of areas. Select Convert Areas from the Areas 
menu. A dialog box with several options will appear. Click the 
"Display on all pages button." The selected area or group of 
areas will appear in the same location on every page. When a 
global art area is selected, its borders will be colored blue instead 
of the usual orange. Art can be added either before or after the 
global an has been created, and it will appear inside the art area on 
every page. 
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For example, if you want three columns of text for every page in 
your document, flrst create the column dividers by adding an Art 
Rectangle from the Areas menu. Stretch a rectangle so that it is 
narrow and spans the length of the page. Select Duplicate from the 
Edit menu. This will create a second column divider consisting of 
the exact same dimensions as the first one. Position the art areas 
where the column margins will be. Select both areas as a group by 
pressing the Shift key and clicking in the unselected rectangle. 
Select Convert Areas , and then click the "Display on all pages 
button." 

Click 0 K to accept the changes, or click Cancel to cancel any 
changes and return to the document. 

LASERWRITER PRINT QUALITY FOR INDIVIDUAL AREAS 

The quality of LaserWriter print can be changed for individual 
areas, depending on the type of art contained in the area. To 
change the LaserWriter print quality, first select an area or group 
of areas. Then, select the Convert Areas command from the 
Areas menu and a dialog box will appear. 
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If the art area contains mostly black and white art (e.g., black text 
created in the Paint Tool), then select the "To LaserWriter 
high-quality button." This option will cause the black and white 
art to be printed very cleanly and precisely, but if the art area 
contains any colors, the LaserWriter may print them as patterns. 

If the art area contains colors, then select the "To LaserWriter 
gray scale button." The colors will be printed in varying shades 
of gray to give more of a "newspaper photo" appearance. 

If two or more areas have been selected as a group, the "Don't 
change LaserWriter quality button" will be selected. This is 
because the same group can contain areas with different 
LaserWriter print specifications. This button prevents all grouped 
areas from ac(;identally having their LaserWriter print 
specifications changed. 

TURNING OFF AREA BORDERS 

All area borders are initially turned "on," which means that they 
show. To turn the borders of an area or group of areas off, fust 
select the area(s). Then, select Convert Areas from the Areas 
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menu. Click the "Turn off borders button" at the bottom of the 
Convert Areas dialog box. The borders will disappear once the 
area is no longer selected. To turn the borders on, click the "Turn 
on borders button." Borders can be turned on and off globally 
by clicking the "Display on all pages button." Any selected 
areas will appear on every page with their borders on or off. 
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Borders that are showing on the screen will also show when the 
document is printed. Borders that have been turned off will not 
show when the document is printed. 

If two or more areas have been selected as a group, the "Don't 
change borders" button will be selected. This is because the 
same group can contain areas with their borders turned on, while 
at the same time containing areas with their borders turned off. 
This button prevents all grouped area borders from accidentally 
being turned off or on. 

Click 0 K to accept the changes, or click Cancel to cancel any 
changes and return to the document. 
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SHOW ALL 1-llDDEN AREA BORDERS 

If you would like to see all area borders that have been turned off, 
you can force ALL area borders to show by selecting the Force 
Showing Borders command from the Areas Menu. Area borders 
must first have been turned off from the Convert Areas dialog box 
for this command to have any effect. Borders that have been 
turned on with this command will show when the document is 
printed to paper. 

Once the Force Showing Borders command has been selected, the 
Areas menu will display Don't Force Showing Borders. To turn 
all hidden area borders back off, select this command. 

GROUPING AREAS TOGETHER 

Areas can be attached to one another (grouped together) so that 
they can be moved or deleted as a group. Select one area by 
clicking in it so that you are in the Move I Change mode. Press the 
Shift key while clicking inside any unselected (black bordered) 
areas. This will attach the area that was unselected to the selected 
area. There are an unlimited number of areas which can be 
grouped together on one page. 



132 I ADDING ART AREAS TO A DOCUMENT 

Areas that have been grouped together will have orange borders 
(gray on a monochrome monitor) with no pull tabs when in the 
Move I Change mode. Grouped areas can only be moved or 
deleted. They cannot be resized. Areas that have been grouped 
together are not discernible when in the Text mode. 

If you have grouped some areas together and leave the Move I 
Change mode, they will not reappear as a group the next time you 
enter Move I Change. To keep selected areas together as a group 
while moving in and out of Move I Change, select the Group 
command in the Areas menu. Select Ungroup to cancel the 
Group command. These commands will only be active (not 
grayed out) if two or more areas have been selected as a group. 

To delete several areas as a group, select the areas as a group and 
press the Delete key, or click Cut in the Edit menu. 

To detach any area from the group, you must first be in the Move I 
Change mode. Position the pointer in the area, and press the Shift 
key while clicking. The area will no longer be a part of the group, 
but it will not be deleted. 

CHANGING ART AREAS TO TEXT AREAS 

Any art area can be changed to an area that holds text. These text 
areas become miniature pages, or "Page Parts." You can use the 
Page Parts to do things such as wrap text different ways on the 
same page, or make the text conform to a unique shape. If you 
convert an art area that contains art into a Page Part, the art will be 
deleted. 

To change an art area to a Page Part, select the area or group of 
areas, and then select Convert Areas from the Areas menu. A 
dialog box will appear with several options. 
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Click the "To text contents button" in the lower left comer. All 
selected areas will become miniature pages. As such, they can be 
formatted just like a full-sized page. Once the Page Part is created, 
you can use the Convert Areas dialog box to alter the Page Part in 
much the same way as you can alter an art area. You can change 
the Page Part area type (rectangle, round rectangle, oval, or 
polygon), display the Page Part as a global Page Part (Display 
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on all pages), and turn the borders of the Page Part on and off. 
You cannot move a Page Part from one page to another with the 
text in it. The Page Part itself will move, but not the text. Just as 
with global art, global Page Part borders will appear as blue, not 
orange, when selected. 

If two or more areas have been selected as a group, the "Don't 
change contents" button will be selected. This is because the 
same group can contain art areas, while at the same time containing 
areas that have been converted to Page Parts. This button prevents 
all grouped areas from accidentally being converted to art areas or 
Page Parts. 

If you create a global Page Part, the Page Part will be positioned in 
the same place on every page. The text will flow in and out of the 
Page Part in the same sequence as it does on the page that is used 
as the model for the global Page Part. In other words, the text 
showing within the first Page Part will not appear within the other 
global Page Parts. 

Once the Page Part has been designated, click OK to return to the 
text. You must then click outside the Page Part to de-select the 
area (the borders will revert to black, or will disappear if they are 
turned off). Text can then be entered. Once you start typing, the 
text will start to print in the fust Page Part. Text flows from Page 
Part to Page Part in the order that they are created. The text will 
flow onto the page only after the last Page Part. Text will flow out 
of a Page Part if a Page Break (from the Format menu) is 
inserted, or the bottom of a Page Part is reached. Art areas can 
also be placed inside the Page Parts, and the text will wrap around 
the art. 
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Once a Page Part has been de-selected (the borders have reverted 
to black) it can only be selected again with the Move/ Change 
Areas command on the Areas menu. Click Move I Change Areas 
and then position the pointer inside the Page Part area and click. 
As with any art area, once the Page Part has been selected, it can 
be resized or moved on that page. 

If a Page Part is deleted or converted back into an art area, the text 
will not disappear, but move onto the page or the next Page Part. 
To delete a Page Part, select the Page Part or group of Page Parts 
and press the Delete key. To convert a Page Part back into an art 
area, select the Page Part and then select the Convert Areas 
command from the Areas menu. Click the "To art contents 
button," and the Page Part area will once again become an art area. 

WORKING WITH OVERLAPPING AREAS 

Bring To Front, and Send To Back allow you to shuffle areas that 
overlap and are "stacked" on top of each other. The area in "front" 
will show in its entirety, but the area in "back" will be partially or 
possibly completely hidden by it. Areas are "stacked" in the order 
in which they were placed on the screen. (The last area created will 
take priority.) These commands allow you to change their order 
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and their final appearance. With these commands, you can create 
such special effects as artwork that overlaps columns. 

To use Bring To Front and Send To Back, first select an art area. 
Click either of the commands on the Areas menu to "stack" the 
areas in the order you desire. 
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COPYING AREAS 

An entire art area or group of areas can be copied (including the 
art) with the Copy and Paste commands, or the Duplicate 
command on the Edit menu. The Duplicate command will be 
grayed out if no area is selected. 

To copy an area, select the area and the borders will turn orange 
(gray on a monochrome monitor). Select Copy and a copy of the 
selected area will be placed on the Clipboard. The original will 
remain in the document. Make sure that the page on which you 
wish to copy the area is showing on the screen, and then select 
Paste. The selected art area is copied into the document at the top 
of the highest page showing. For example, if both pages number 
2 and 3 are showing, the selected area will be Pasted to the top of 
page 2. Once the area has been Pasted to the correct page, move it 
to its final location on the page by clicking in its center and 
dragging. Any areas which have been copied on the same page 
will be placed directly on top of each other. 
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The selected area remains on the Clipboard until something else 
replaces it (using Cut or Copy), so you can copy the same area 
into your document several times without having to re-select it. 
Art that is Copied to the Clipboard can also be placed in any other 
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document. Simply open the other document and Paste the 
Clipboard contents into it. 

To copy with the Duplicate command, first select an area. Then, 
select the Duplicate command and a duplicate area will be placed 
down and to the right of the original area. The duplicate area will 
now be selected. If you will be making more than one duplicate, 
you can change the default spacing between the duplicates. Move 
the first duplicate away from the original and each subsequent 
duplicate will be placed in the document at the same distance. Any 
time a selected copy is moved, the placement of the following 
duplicates will reflect the change. Once you have finished 
duplicating, you can reposition any of the areas by selecting one, 
positioning the pointer in it, and clicking and dragging. The 
Duplicate command will not alter the contents of the Clipboard. 

dedico 
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To duplicate a group of areas, first select the areas as as group 
(Shift-click while in the Move I Change mode), and then select 
the Duplicate command. 

DESIGNING COLUMNS 

Unlike many other desktop publishing programs, Medley does not 
require that you create and define a text area in order to generate 
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columns. Columns can be created in any number and in any size 
by adding long, narrow art rectangles where you don't want the 
text to go. The art rectangles will become column margins as well 
as dictate the space between the columns of text. Thus, they serve 
as column dividers, and are commonly called "gutters." The page 
can be divided into columns either before or after text has been 
entered. 

To divide a page of text into two columns, add an art rectangle and 
stretch it so that it is the length of the page. Since the width of the 
rectangle will be the space dividing the columns, stretch the 
rectangle horizontally to create the desired "gutter" width. If you 
will be creating more than two columns, and want them to be 
divided by an even amount of space, select the Duplicate command 
from the Edit menu. This will allow you to make several copies 
without having to resize the art areas. 
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Once an art area ("gutter") has been sized, position the pointer in 
the middle of the art area, and click and drag to position it 
anywhere on the page. Unless specified otherwise (i.e., with the 
Change Page Layout command on the Format menu) the text will 
always wrap vertically. This means that when art areas ("gutters") 
are placed on a page the text will drop down a line when it runs 
into an art area border. When the text reaches the bottom of the 
page it will wrap up and start to print at the top of the next column. 
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DELETING AREAS 

To delete an art area, you must be in the Text mode. Select the 
area to be deleted by clicking in it. The borders will tum orange 
(gray with a monochrome monitor). Selecting the Clear command 
or pressing the Delete key will remove the area and its art from 
the document completely. Selecting Cut from the Edit menu will 
remove the area from the document, but it will be placed on the 
Clipboard. 

To delete several areas at one time, first select the areas as a group 
by pressing the Shift key while clicking inside the areas. The 
borders of the grouped areas will turn orange (gray on a 
monochrome monitor), but they will not have pull tabs on the 
corners. Then, select the Clear command, press the Delete key, 
or click Cut in the Edit menu. 

WRAPPING TEXT AROUND OVALS AND POLYGONS 

Inserting ovals and polygons into text can create some special 
problems because they do not have square borders for text to wrap 
around. The Medley word processor looks for any space on the 
page into which text can be inserted. Since ovals and polygons 
can leave small gaps for text to fit into, parts of words may appear 
where you do not want them to. 
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To block out gaps around an oval where you do not want text to 
appear, place a rectangle big enough to cover the gaps on top of 
the oval. Use Send To Back from the Areas menu to place the 
rectangle behind the oval. Finally, go to Convert Areas in the 
Areas menu and click the Turn Off Borders button. The 
rectangle behind the oval will not show, but it will block any text 
from moving into the gaps left by the roundness of the oval. 
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To block out gaps left by the irregular shape of a polygon you can 
either put a rectangle behind the polygon as with an oval, or you 
can stretch some of the polygon borders so that they extend into 
the gap where text is not desired. 

IMPORTING ART 

Selecting Import Art from the Special Effects menu will allow 
you to bring art from other sources into Medley. This includes 
pictures from the clip art disk that is included with Medley. To 
import art from another source (e.g., another "paint" program, 
digitized, or scanned art), the art must have been saved in as a 
"CO" file (Apple Preferred Format), or a "Cl" file (single screen 
file). 

Select Import Art and a dialog box will appear. 
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Select Import Art and a dialog box will appear. 
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If the art file is on another disk (e.g., the Medley clip art disk), 
insert the art disk and click the "Disk button." The name next to 
the small disk icon will change to reflect the name of the art disk, 
and all of its art files will be listed. Scroll through the list of file 
names and click on the one to be imported. The file name will 
become highlighted. Click the "Open button" to import the art. 
An art area will automatically be opened at the beginning of the 
document and the art will be placed within it. If you have selected 
an art area to import to (the area is in the Move I Change mode), 
the art will be placed within the selected area. 

If the art area is smaller than the imported art, the art outside the 
area borders will be "cropped" (not deleted) as long as the area 
remains selected. If the area is resized to be larger, then the 
"cropped" art will show. If the area is de-selected, then the art 
outside the area borders will become "clipped" (deleted). The 
"clipped" art will never show if the area borders are expanded. 

If you are importing art from other "paint" programs, their palettes 
may not be compatible with Medley's. To compensate for this, the 
Import Art dialog box allows you to convert other "paint" palettes 
to Medley's. Underneath "Adjust Color" are three buttons. If the 
art file is compatible with Medley (e.g., Medley clip art files), 
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leave the "Standard button" selected. If your art files do not look 
good after being imported into Medley, try either Option 1 or 
Option 2. 

If you are importing digitized or scanned art, the colors that 
Medley assigns to the art may not look very good. Medley can, 
however, break the colors down and display them as shades of 
gray. To do this, select Switch To Gray Scale from the Special 
Effects menu. All color within the document will be changed to 
shades of gray. Once this command is chosen, the menu 
command changes to Switch To Color. Select this to once again 
display the document in color. 

If you do not see an art file that you know has been saved to disk, 
it may have been saved as a file format unrecognizable to Medley, 
or it may have been placed in an unopened folder. Folders are 
differentiated from Files in the Import Art listing by their icons. 
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To open a folder, position the pointer over the folder name and 
click the mouse. The folder name will become highlighted. 
Position the pointer on the "Open button" and click the mouse to 
open the folder. A list of file names contained in that folder will 
appear. Once you see the file you want, position the pointer on its 
name and click the mouse. The file name will become highlighted. 
Posi tion the pointer on the "Open button" and click the mouse to 
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import the art. To close an open folder, select the "Close 
button." The "Close button" is grayed out if no folder is opened. 

Selecting the "Cancel button" cancels the Import Art command. 

USING THE CLIP ART DISK 

To import art from the Medley Clip Art disk, insert the Clip Art 
disk in a drive and select the Import Art command from the 
Special Effects menu. A dialog box will appear with the name 
of the disk next to the small disk icon. It should read "/Clip.Art/." 
If this is not the name of the disk, click the "Disk button" to select 
another disk. Below the disk name, the folder "Art" will be 
highlighted. Click the "Open button" to open the "Art" folder. A 
list of art files will appear. Scroll through them to select a file. 

8 File Edit Search Areas Font For1ot Special Effects Shortcuts 
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To see printed reproductions of all Medley's clip art, refer to the 
"Clip Art Gallery" section in the back of this manual. Select an art 
file by clicking on it. It will become highlighted. Click the "Open 
button" to open the file. If an art area was selected prior to using 
the Import Art command, the clip art will appear in the selected 
area. If no area was selected, the clip art will appear within an art 
area automatically created to be large enough to show all art within 
the file. 
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Once the clip art file is in the document, you will see several 
pictures. There are two ways to isolate one picture from the rest: 

1. Resize the art area with its pull tabs until all unwanted 
pictures are excluded. If you would like a different type of 
art area to surround the picture (e.g., an oval instead of a 
rectangle) select the Convert Areas command from the 
Areas menu. 

~2__~ 
~ 
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2. Enter the Paint Tool and select a picture by drawing a 
border around it with either the Selection Box or the Lasso. 
Cut or Copy the selected picture to the Clipboard. Go back 
into the Text mode, and make sure that the art area into 
which the clip art file was Imported is selected. Delete the 
art area by pressing the Delete key. Now, choose Paste 
from the Edit menu and the selected picture will be placed 
into the document. If the picture was selected with the 
Lasso, it will now reside within a polygon art area. If the 
picture was selected with the Selection Box, it will be 
within a rectangular art area. See "Cutting Art Objects" for 
more information. 

EXPORTING ART 

Selected art areas can be exported from Medley into other IIGS 
paint programs to take advantage of special features that they may 
have. The art can then be Imported back into Medley and placed in 
your document. 

To export art, first make sure that an art area is selected. (You 
must be in the Text mode.) Select the Export Art command from 
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the Special Effects menu. A dialog box will appear with 
several options. 
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The name of the disk to which the art will be saved is located next 
to the small disk icon in the upper left corner. If you want to save 
you art to another disk, insert the disk and click the "Disk 
button." The name of the new disk should appear next to the disk 
icon. 

In the box under "Enter file name to save," enter the file name 
under which you will be saving your art. Click the "Save button" 
and the art will be saved as a "paint file." "Paint files" can be 
imported into most IIGS paint programs. If your paint program 
cannot read a "paint file" it may be able to read a "picture file," 
which is an uncompacted version of the "paint file." To save the 
art as a "picture file," click in the box next to "Picture Format." 

If the art is larger than the art area borders, the amount of art that is 
saved will depend on whether or not the art area was ever de­
selected. If the art area has not been de-selected (after drawing a 
picture with the Paint Tool or using the Import Art command), 
then the saved art file will include all art, even if the art is 
"cropped" by the art area borders. If the art area has been de­
selected, then the art will be "clipped," and only the art within the 
area borders will be saved as the art file. 
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If you will be saving many art files, the disk directory may start to 
look cluttered and unorganized. You can better organize your files 
by placing them into folders. 

To create a new folder in which to place your art files: 

A. Enter the name you wish to give the NEW FOLDER below 
"Enter file name to save" and click the "New Folder 
button." 

as the king of the 
of its fierce 
s bother the lion, 
os for owoy troll 
!e. ThP fet~ole 

hunter. She 
as 113 of her life 

B . The new folder name will appear outlined in the listing. 
Click the "Open button." This opens the folder 
(represented by the disk icon changing to an open folder 
icon). Since no files have yet been saved to the folder, the 
listing is empty. 

C. Enter the name you wish to give your ART FILE below 
"Enter file name to save." Click the "Save button" to save 
the art file to the newly-created folder. 

D. You are returned to the active document. 

To save your art file to an existing folder: 
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A . Position the pointer on one of the folder titles in the listing 
and click the mouse (all non-folder titles are grayed out in 
the dialog box). The folder title becomes highlighted. 

B. Click the "Open button." This opens the folder 
(represented by the disk icon changing to an open folder 
icon). A listing of files within the folder will be displayed. 

C. Enter the name you wish to give your ART FILE below 
"Enter file name to save." Click the "Save button" to save 
the art file to the folder. 

D. You are returned to the active document. 

Clicking the "Close button" allows you to close a folder if you do 
not want to save a file there. The "Close button" is grayed out if 
no file is opened. 

Clicking the "Cancel button" will cancel the Export Art command 
and return you to your document. 

FROM TEXT MENUS TO PAINT MENUS 

Once you have created your art areas, you can put some "art" into 
them. 

You can enter the Paint Tool from the Move I Change mode by 
selecting the Enter Paint Tool command from the Areas menu. 
Selecting this command will cause the artwork tools to appear. 
The tools will work only within the borders of the selected area. 
The Enter Paint Tool command will be grayed out if no area is in 
the Move I Change mode. 
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You can also enter the Paint Tool at any time when you are not in 
the Move I Change mode by positioning the pointer inside an area 
and double-clicking. The artwork tools will appear, and will work 
only within the borders of that particular area. All functions of the 
art tools are explained in the next section. To return to the word 
processor, select the Return to Word Processor command from the 
File menu, or double-click outside the art area. 
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DRAWING WITH MEDLEY 

SELECTING TOOLS AND COLORS 

To enter the Paint Tool, select the Enter Paint Tool command from 
the Areas menu while you are in the Move I Change mode. If 
you are not in the Move I Change mode, you can double-click in 
any art area. 

Once you are in the Paint Tool, you can draw only within the area 
that was selected in the Text mode. Tools and colors to draw with 
can be selected from the Tool Box (vertical window), and the 
Color Box (horizontal window). 
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To select a tool, position the mouse pointer on top of the tool you 
would like to use and click. Once you move the pointer back into 
the selected art area, the tool will become effective. All tools are 
explained in the "Tools Summary" section. 

To select a color or pattern, you must first determine which part of 
the object you will be drawing. The left side of the Color Box 
contains a box with a small trapezoid which lets you choose the 
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"background", "border", and "fill" colors. On a monochrome 
monitor, all colors will appear as varying shades of gray. 

To choose a "background" color, position the pointer outside the 
trapezoid (but still within the box borders) and click. Then, move 
the pointer to the color or pattern of your choice and click. The 
background area (outside the trapezoid) in the small box will now 
display that color. The "background" color inside the selected art 
area will not change at once, but any time the Eraser is used, it will 
erase in the new "background" color. While the Eraser is selected, 
any color that is chosen will automatically be reflected in the 
BACKGROUND area of the trapezoid. 

we ore engaged in a great civil war, testing 
that nation, or on~ nation so conceived and 

ted, can I ong endure. We ore 11et on a great 
ttlefield of that war. We have co1e to dedicate a 
tion of that field, as a fino! resting place for 
e who here gave their lives that that na tion 

ight live. It is altogether fitting and proper that 
· e should do this. 

To choose a "border" color, position the pointer on the trapezoid 
and click. Then, move the pointer to the color or pattern of your 
choice and click. The border of the trapezoid will display the new 
color. The "border" color affects these tools; Text, Spray Paint, 
Paint Brush, Pencil, Straight Line, and also the borders on any 
rectangles, ovals, and polygons. The borders of the art areas 
themselves will not change. While any of these tools are selected, 
any color that is chosen will automatically be reflected on the 
BORDER area of the trapezoid. 
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we are engaged in a great civil war, testing 
that notion, or onH notion so conceived and 

icoted, can long endure. We ore11et on o great 
tlefield of that wor. We hove co1e to dedicate a 
ion of that field, as a final resting place for 

who here gave their lives that that nation 
live. It is altogether fitting and proper that 

should do this. 

To choose the "fill" color, position the pointer inside the trapezoid 
and click. Then, move the pointer to the color or pattern of your 
choice and click. The area inside the trapezoid will display the 
new color. The "fill" color affects the Paint Bucket and any 
"filled" rectangles, ovals, and polygons. While the Paint Bucket is 
selected, any color that is chosen will automatically be reflected in 
the FILL area of the trapezoid. 

we m engaged in a great civil war, testing 
that nation, or anH nation so conceived and 

ted, can long endure. We are 11et on a great 
efield of that war. We have co1e to dedicate a 

of that field, as a fina l resting place for 
who here gave their lives that that nation 
live. It is altogether fitting and proper that 

should do this. 
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LINE WIDTHS 

The widths of lines and borders are determined by the "Border 
Palette." This is located at the bottom of the Tool Box. The 
"Border Palette" does not affect the Paint Brush or the borders of 
the art areas. 

To change a line width, position the pointer over the square that 
represents the desired line width and click. A small box will 
appear around the selected square. Any new lines and borders will 
be in the selected width. Old lines and borders will not change. 

FREEHAND DRAWING 

we ore engaged in o great civil wor, testing 
hether thot notion, or ony notion so conceived and 
dicoted, con long endure. We ore 11et on o great 
ttlefield of thot war. ~e hove co1e to dedicate o 
tion of thot field, os o fino! resting place for 

who here gave their lives thot thot notion 
live. It is altogether fitting ond proper that 

should do this. 

The Pencil and the Paint Brush are used to draw freehand lines 
with the mouse. 

To use the Pencil, first choose a "border" color and the desired line 
width from the "Border Palette." Select the Pencil, and the pointer 
will become a small pencil. Position the pointer inside the area, 
click, and drag. A line will be drawn with the tip of the pencil. 
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four score and seven years ogo our fathers brought forth on this continent, a 
new nation, conceived in Libert~, and dedicated to the proposition that oil 
men ore created equo I. 

we ore engaged in o great civil war, testing 
hether that nation, or an~ nation so conceived ond 
dicoted, can long endure. We are 11et on o great 
tlefield of that war. We have co1e to dedicate a 

n of that field, as a final resting place for 
who here gave their lives that that nation 

t live. It is ol together fitting and proper thot 
should do this. 

To use the Paint Brush, choose a "border" color from the Color 
Box. Then, select your brush shape with the Select a Brush 
command on the Special Effects menu. (See BRUSH 
SHAPES.) Once the brush shape is selected, the pointer becomes 
that shape. Position the pointer inside the area. Click and drag, 
and a line will be painted. 

STRAIGHT LINES 

Use the Straight Line tool to draw lines that are perfectly straight. 

Select the Straight Line tool, a "border" color, and a line width. 
The pointer will be represented by a "+". Position the pointer 
where you would like the line to begin, then click and drag. The 
line is anchored at the beginning point and will stretch with the 
mouse movement. Let up on the mouse button when the line is in 
the desired location. 
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four score and seven ~ears ago our fathers brought forth on this continent, a 
new nation, conceived in Liberty, and dedicated to the proposition that all 

are created equal. 

we ore engaged in a great civil war, testing 
hether that nation, or anu notion so conceived and 
dicated, can long endure. We are IDet on o great 
ttlefield of that war. We hove co1e to dedicate a 
tion of thot field, as o final resting place for 

who hm gave their lives that that nation 
ight livt. It is altogether fitting and proper that 

should do this. 

DRAWING RECTANGLES, OVALS, AND POLYGONS 

Rectangles, ovals, and polygons can be hollow or filled. Border 
widths are determined by the "Border Palette." "Border" and "fill" 
colors are selected with the small trapezoid in the Color Box. 

To draw a rectangle, round rectangle, or oval, select the 
appropriate tool. The pointer will now be represented by a"+". 
Position the pointer inside the art area, and click and drag. The 
shape stretches with the mouse movement. Let up on the mouse 
button when the shape is the desired size. Borders will remain 
black and any "fill" colors will not show until the mouse button is 
released. You can control the "roundness" of a round rectangle by 
pressing any of the arrow keys while the mouse button is still 
pressed down. The next round rectangle placed in the art area will 
be set at the same "roundness" as the previous one. 
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score and seven years ago our fathers brought forth on this continent, o 
nation, conceived in Liberty, and dedicated to the proposition that all 
ore created equal. 

D we ore engaged in o great civil war, testing 
that notion, or on~ notion so conceived and 

con long endure. We ore 11et on o great 
lefield of that war. We hove co1e to dedicate a 

tion of that field, as a fino! resting place for 
who here gave their lives that that notion 

t live. It is altogether fit tins and proper that 
should do this. 

To draw hollow or filled freehand shapes, select the appropriate 
freehand shape tool. The pointer will be represented by a "+". 
Position the pointer inside the art area, and click and drag. The 
border line will be drawn with the mouse movement. Releasing 
the mouse button will connect the starting point and the end point 
with a straight line. Borders will remain black and any "fill" 
colors will not show until the mouse button is released. 

we ore ensosed in o great civil war, testing 
that notion, or on~ notion so conceived and 

icoted, con I one endure. We ore 11et on o great 
tlefield of that war. We hove co1e to dedicate o 

of that field, os o final resting place for 
who here gave their lives that that notion 
live. It is altogether fitting and proper that 

should do this. 
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To draw hollow or filled polygons select the appropriate polygon 
tool. The pointer will be represented by a "+". Position the 
pointer inside the art area, and click (do not drag). The border line 
will now move with the mouse. Each click thereafter becomes an 
anchor point from which the line moves with the mouse. Double­
clicking the mouse button will connect the last point with the 
starting point of the polygon. Double-clicking outside the art area 
will erase a polygon in the process of being created. Polygon 
borders can also be stretched and anchored outside the art area, 
although only the parts of the polygon within the art areas will 
show. Borders will remain black and any "fill" colors will not 
show until the mouse button is released. 

score and seven years ago our fathers brought forth on this continent, o 
notion, conceived in liberty, and dedicated to the proposition that all 
ore created equal. 

( 

DETAILED DRAWING 

we ore engaged in o great civil war, testing 
that notion, or any notion so conceived and s 

con long endure. We ore llet on o great 
efield of that war. We hove co1e to dedicate o 

of that field, as a fino I resting place for 
who here gave their lives that that nation 
live. It is altogether fitting and proper that 

should do this. 

The Magnifying Glass lets you do exact detail work by enlarging a 
small section of the art. 

Select the Magnifying Glass and the pointer will become a small 
box. Position the box over the area which you would like to 
enlarge and click. 
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we ore engaged in o great civil war, testing 
that nation, or on~ nation so conceived and 

cated, can long endure. We are 11et on o great 
lefield of that war. We have co1e to dedicate a 

of that field, as a final resting place for 
who here gave their lives that that nation 
live. It is altogether fitting ond proper that 

should do this. 

A dialog box will appear, showing the selected portion of art 
enlarged as a grid. Each square on the grid represents a dot on the 
screen. 

Select a color with the pointer and then move it into the grid (the 
only tool that will work here is the Pencil). The color that is 
selected as you enter the Magnifying Glass is the present "border" 
color. Clicking on any color within the grid while the O~on key 
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is pressed will cause the color selection to change appropriately. 
Click or drag the mouse to paint the individual squares the selected 
color. A small rectangle in the upper left comer shows the art at its 
actual size. Any changes made while the art is enlarged will also 
show up in this area. 

You can scroll the art while it is enlarged by moving the pointer 
just outside the border of the enlarged area. The pointer will 
become an arrow pointing in any one of eight directions (up, 
down, left, right, or diagonally). Click the mouse button and the 
entire enlarged section will scroll in that direction. Medley always 
scrolls art by two pixels at a time to avoid color shifting. 
However, it is possible to scroll by one pixel at a time while in the 
Magnifying Glass. To do this, hold down the Option key while 
clicking when the pointer is represented by the arrow of the 
desired scroll direction. The art will scroll one pixel at a time and 
its colors will change. Every other click will change the art back to 
its original color. 

Since the rectangle showing the art at its actual size shows more 
area than is enlarged, you can also scroll by positioning the pointer 
in that rectangle. The pointer will become a small box. Position 
the box over the portion of art to be enlarged and click. The 
enlarged section will be representative of the area chosen. 

=··= : illl ·@hi:·=' IIIli f¥.Wdllii1RIIlllWW. 
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TEXT 

Once you are finished, click the "OK button" to return to the full­
sized Paint Tool. Click the "Cancel button" to return to the Paint 
Tool and not record any changes. 

You can enter text of any color anywhere in an art area by using 
the Text tool. Select the Text tool and a "border" color . The 
pointer will become a"+". The horizontal line on the "+" will 
represent the base of the text line. Position the pointer where you 
would like the text to begin, and click. A flashing cursor will 
appear and the text you enter will start at that point. The mouse 
click point becomes the left margin, and any Returns will align 
flush left to that point. Text in the Paint Tool does not wrap 
around objects or move to another line when it runs into a border. 
When you print your document, text in the Paint Tool prints as art­
not as text. As a result, the printed "art text" is of lesser quality 
than text printed from the Text mode. 

Four score and seven ~ears ago our fathers brought forth on this continent, a 
nation, conceived in Libert~. and dedicated to the proposition that all 
are created equal. 

-r 
Ab raha Lincolri 

Text fonts, sizes, and styles can be chosen from the Font menu 
while you are in the Paint Tool in the same manner as when you 
are in the Text mode. However, since you cannot select text in the 
Paint Tool, font and style changes cannot be made to text after it 
has be entered. No font size larger than 60 should be chosen. 
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The leading, or space between lines can be adjusted by holding 
down the Shift key while pressing an up or down arrow key. 
The cursor will not move, but each press of an arrow key 
represents one pixel. Now, each time the Return key is pressed 
with the Shift key.l, the cursor will move to the left margin, but it 
will move the specified number of pixels down from the base line. 
If the Return key alone is pressed, the leading will return to its 
default setting. 

The alignment of the left margin can be changed at any time by 
holding down the Shift key while pressing a left or right arrow 
key. The cursor will not move, but each press of an arrow key 
represents one pixel. Now, when the Return key is pressed with 
the Shift key, the cursor will move to the left margin, but the left 
margin will begin at a new point. That point will be the specified 
number of pixels away from the original insertion point. Each 
subsequent time the Return I Shift keys are pressed, the cursor 
will move the specified number of pixels incrementally. If the 
Return key alone is pressed, the cursor alignment will stay flush 
left with the line above. Once you exit the Paint Tool, the leading 
in the Text tool reverts in all cases to its default setting. 

our score and seven years ogo our fathers brought forth on this continent, o 1~:-W.o• 
nation, conceived in liberts. and dedicated to the proposition that oil 
are created equal. 

Rbraho1lincoln 
Rbrohlllllincoln 
Abraham linea In 
Abraharalincoln 
Abroh011lincoln 

we ore engaged in a great civil war, testing 
that notion, or ans nation so conceived and 

con long endure. We ore 11et on a great 
efield of that war. We hove co1e to dedicate a 

of that field, os a final resting place for 
who here gave their lives that that notion 

t live. It is altogether fitting and proper that 
should do this. 

You can use the arrow keys to place the cursor any place within 
the art area. Text will always start to print from the flashing 
cursor. However, once the Return key is pressed, the cursor will 
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return to the left margin below the original insertion point. If the 
mouse is used to reposition the cursor, the mouse click point will 
become your left margin. 

Text can be deleted one character at a time by pressing the Delete 
key. As long as you do not move out of the Text tool, Medley 
treats all text entered as "text," so that it can be deleted even if 
Returns have been entered, or if the cursor has been repositioned 
with a mouse click. Once you leave the Text tool the text becomes 
"art," and any changes made to it must be made as if it were an art 
object. 

FILLING IN AN AREA 

Use the Paint Bucket to fill in any areas, or quickly change colors. 

To fill an area, first select a "fill" color from the Color Box. 
Select the Paint Bucket, and the pointer will be represented by a 
paint bucket. Position the tip of the pouring paint within any 
outlined area, and click. The area will fill with the chosen paint 
color. If there are gaps in the borders, or a "border" color is the 
same as the "fill" color, the filling paint will "leak" through. 

four score and seven years ago our fathers brought forth on this continent, o 
new notion, conceived in Libert~ , and dedicated to the proposition that all 
men ore created eQual. 

we ore engaged in o great civil war, testing 
that nation, or on~ notion so conceived and 

co ted. con long endure. We are 11H on o great 
lefield of that war. We hove co1e to dedicate o 

of that field, os a final resting place for 
who here gave their lives that that notion 
live. It is altogether fitting and proper that 

should do this. 

• 
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To change a color with the Paint Bucket, f1rst select a "fill" color 
from the Color Box. Position the tip of the pouring paint over 
the area to be changed and click. Any part of the art that was the 
old color and is touching that color area will be "filled" with the 
new color. For example, if you have several overlapping 
rectangles with black borders, and you wish to change the borders 
to green, click the Paint Bucket on any one of the borders. As 
long as they touch at some point (black touches black), the green 
paint will fill into all the black areas. 

ERASING ART 

Use the Eraser to "erase" any art. Once the Eraser is selected, the 
pointer is represented by a hollow box. To erase, position the 
pointer over the art to be erased, and click and drag. Any art that 
the pointer touches will be returned to the "background" color 
(selected from the Color Box). Art can also be deleted by 
selecting it with the Selection Box, and then pressing the Delete 
key. 

we ore engaged in a great civil war, testing 
that notion, or onH notion so conceived and 

icoted, con I ong endm. We m met on a great 
tlefield of that war. We hove co1e to dedicate o 
ion of that field, as o final resting place for 

who here gave their lives that that notion 
liR It is altogether fitting and proper that 

should do this. 

The entire art area can be erased at once by double-clicking the 
Eraser in the Tool Box, or selecting Erase Ail from the Special 
Effects menu. 
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MOVING ART 

Art can be repositioned anywhere within the active art area. To 
move some art, it must first be selected by using either the Lasso 
or the Selection Box. 

When the Lasso is selected, the pointer will look like a small lasso. 
Click and drag, using the tip of the lasso to draw a border around 
the art you wish to move. Let up on the mouse button, and the 
border will shrink to conform itself to the art object borders. The 
pointer will then be represented by a "+". Position the pointer 
inside the area to be moved, click, and drag. The lassoed area will 
move with the mouse. Since the Lasso border "slides" over the 
selected "background" color to conform to the outside border of 
the art object, no "background" color will be moved with it. 

WP ore engaged in o great civil war, testing 
ther that nation, or onu nation so conceived and 

can long endure. We are met on a great 
of that war. We hove coae to dedicate a 

of that field, as a final mting ploce for 
who here gave their lives that that notion 
live. It is altogether fitting and proper that 

should do this. lf--+--l 

With the Selection Box, the pointer is represented by a "+". 
Position the pointer near the area you wish to select, then click and 
dra~g the mouse. A box with moving borders will be formed. Let 
up on the mouse button, then place the pointer inside the box. 
Click and drag, and the objects inside the box will move with the 
mouse. Any "background" color within the box will move also. 
If you select the Shrink command from the Special Effects 
menu, the border of the Selection Box will act like the Lasso, and 
conform itself to the outside borders of the art object. 
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we ore engaged in o great civil war. testing 
that notion, or any notion so conceived and 

con long endure. We ore 11et on o great 
of that war. We hove co1e to dedicate o 

ion of that field, as o final resting place for 
who here gave their lives that that notion 

t live. It is altogether fitting and proper that 
should do this. 

You can also isolate and move part of an art object, even if it is 
surrounded by other art. To isolate part of an art object, first select 
the entire object with the Lasso. The Lasso borders will conform 
to the outside borders of the object. Next, decide which color 
should be excluded from the Lasso borders, and make it your 
"background" color. (Click in the background area of the Color 
Box trapezoid, and then select the color.) Although the 
"background" color changes to the selected color in the Color 
Box, it will not change in the art area. (The "background" color 
in the art area will not change unless the Eraser is used.) Select 
Shrink from the Special Effects menu. The Lasso borders will 
shrink and "slide" over the selected "background" color, 
conforming to borders consisting of any other color. This can be 
done over and over, until the Lasso borders conform to the piece 
of the art object that you want to move. Once you have isolated 
the art, use the pointer (click and drag) to move it. 
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RESIZING ART 

we ore engaged in a gmt civil war, te~ting 
that notion, or onH notion ~o conceived and 

icoted, con long endurt. We ore met on a great 
tlefield of that war. We hove co1e to dedicate o 
ion of that field, a~ a final re~ting place for 

who here gave their lives that that notion 
live. It is altogether fitting and proper that 

should do this. 

Any art can be resized so that it is larger or smaller if it is selected 
with the Selection Box. 

we ore engaged in a great civil war, te~ting 
that notion, or onH notion so conceived ond 

con I ong endure. We ore 11et on a great 
lefield of that war. We hove co1e to dedicate a 

of that field, as o final resting place for 
who here gave their lives that that notion 
livt It is altogether fitting and proper that 

shou I d do this. 

To resize art, click on the Selection Box and the pointer will 
become a "+". Position the pointer over the art that is to be 
resized, and click and drag. When the mouse button is let up, a 
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box with moving borders will surround the art. Now, place the 
pointer inside one of the borders of the Selection Box. Click and 
drag with the Command key held down and the art will shrink or 
expand with the corresponding border movement. If the pointer is 
placed inside a Selection Box corner, the art will shrink or expand 
diagonally. 

DUPLICATING ART 

Any art can be duplicated if it is selected with the Selection Box. 

To duplicate art, click on the Selection Box and the pointer will 
become a "+". Position the pointer over the art that is to be 
duplicated, and click and drag. When you let up the mouse 
button, a box with moving borders will surround the art. Now, 
place the pointer inside the Selection Box, and click and drag with 
the Option key held down. As the mouse is moved, the Selection 
Box with its art will move also. The original art will remain in the 
same location giving you an exact duplicate. 

our score and seven years ago our fathers brought forth on this continent, o 
notion, conceived in Libert~, and dedicated to the proposition that all 
ore created equal. 

~ 

'
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we ore engaged in o great civil war, testing 
that notion, or any notion so conceived and 

con I ong endure. lit ore 11et on o great 
lefield of thot wor. We hove co1e to dedicate a 
ion of thot field, as o fino I resting p)oce for 

who here gave their lives that thot notion 
t live. It is altogether fitting and proper that 

should do this. 
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INVERTING ART 

Any selected art can be inverted so that it is upside down (vertical 
flip), or backwards (horizontal flip). 

To invert art, first select the art with the Selection Box. Once the 
art is surrounded with the moving borders, select the Vertical Flip 
command from the Special Effects menu to turn the art upside 
down. Select the Horizontal Flip command to tum the art around 
backwards. 

1--=--....:.....:....:..:....:...:...:...:....:..~---l Change Colors .. . 
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BRUSH SHAPES 

Edit Patterns .. . 
Adjust Spro~point ... 
Hide Color Box 
Hide Too I Box 
Hide Both Bam 

great civil war, testing 
any nation so conceived and 

We ore 11et on o great 
We hove cou to dedicate o 
a final resting place for 
lives that that notion 

ether fitting and proper that 

The Paint Brush comes with a variety of different brushes which 
can be used to create many special effects. To select a new brush, 
click Select a Brush on the Special Effects menu, or double­
click the Paint Brush in the Tool Box. A dialog box will appear 
with the different brushes showing. A box outlines the current 
selection. Position the pointer over the desired brush and click. 
The new selection will be outlined by a box. Click the "Select 
button" to choose the shape. You will then be automatically 
returned to the Paint Tool. Select Cancel to return to the Paint 
Tool without making any changes. 
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To edit one of the existing brush shapes, select a shape and then 
click the "Edit button." A dialog box will appear with the shape 
enlarged in a grid. Position the pointer within the grid and click, 
or click and drag to draw. Since you are only editing the shape 
(not the color), each click will turn on or off a square in the grid. 
Click 0 K to return to the art area with the edited brush shape 
selected. Click Cancel to return to the art area with the unedited 
brush shape selected. 
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CHANGING COLORS 

Medley allows for substitution of one color for another throughout 
the entire selected art area, or lets you change all colors to shades 
of gray. These features may be useful when pictures from other 
sources are imported. Since Medley's color palette may be 
different from other color palettes, imported pictures may have 
their colors altered when they are brought into Medley . 

To substitute colors, select the Change Colors command on the 
Special Effects menu. A dialog box will appear with two rows 
of colors. Select the color you wish to change from the "Change 
All" row. That color will appear at the far left of the "Change All" 
row. Then select the color you wish to change it to from the "To" 
row. The selected color will appear at the far left of the "To" row. 
Click OK to return to the Paint Tool. The selected colors will be 
substituted. Click Cancel to return to the Paint Tool without 
making any changes. 

Digitized and scanned art often looks better as shades of gray than 
in color. This is particularly true of photographs. For this reason, 
the entire color palette can be changed into a gray palette, or "gray 
scale." Select the Change To Gray Scale command from the 
Special Effects menu and all art within the active document will 
be displayed in shades of gray. This same command can be 
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activated while you are in the Text mode from the Special 
Effects menu. 

EDITING THE PATTERNS 

Any of the patterns (non-solid colors) can be edited to make 
special patterns or colors of your choice. 

To edit a pattern, select a pattern and then select the Edit Patterns 
command from the Special Effects menu. A dialog box will 
appear showing a sample pattern (under "Edit Pattern"), along 
with an enlarged version in a grid which can be edited. 

II 
Select a color at the bottom of the dialog box and position the 
pointer in the grid. Click to paint the individual squares of the grid 
the selected color. The color painted in the edit grid will not match 
the selected color. Notice that each color has a set of two colors 
above it. The two colors represent the pattern you will see as you 
paint the grid, since the colors in Medley's palette are created by 
combining two colors. The sample pattern will change to reflect 
the "blended" colors as you edit the grid. 
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Click OK to go back to the Paint Tool. The selected pattern in the 
Color Box will reflect the changes. Click Cancel to return to 
the Paint Tool without making any changes. 

ADJUSTING THE SPRAY PAINT 

The Spray Paint can be adjusted for width, speed of fill, and 
splatter. 

To adjust the Spray Paint, select the Adjust Spray Paint command 
from the Special Effects menu. A dialog box will appear from 
which the adjustments can be made. 

0~ 
0 Ho Splatter 
@Some Splatter 
0 High Splatter 

... , .. .. . . 
::.:··.i.: .. i: 
·,· ':\ 

1/4" 1/2" 1" 1 V2" 2" 
l@::,;:~;,,,.i<·:.0.m\N0¥:~'41MtE¥~«41lll@\f:L:~ ffil 

Slow Fast 

The empty rectangle in the upper right hand corner of the dialog 
box is a test palette. Moving the pointer inside the rectangle and 
clicking will show you how the adjustments effect the Spray Paint. 
The following changes can be made: 

The width of the spray can be adjusted from less than 1/4" 
to almost 2" with the top scroll bar. Position the pointer on 
the white square within the scroll bar, and click and drag to 
place it under the desired width. 
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The rate of fill can be adjusted with the bottom scroll bar. 
Position the pointer on the white square within the scroll 
bar, and click and drag to select the fill rate. The Spray 
Paint will come out faster if the white square is farther to 
the right. 

The amount of splatter can be adjusted to "No," "Some," 
or "High." If the Spray Paint is held in one position, it 
will paint a perfect circle. The amount of Spray Paint 
"splatter" determines the amount that it will overflow and 
splatter outside the circle. 

MOVING AND HIDING THE COLOR AND TOOL BOXES 

If either the Color Box or the Tool Box are in your way while 
you are drawing, you can move them or hide them completely. 

The Tool Box will move from one side to the other when you 
click at the very top of it, just above the Lasso. The Color Box 
will move from top to bottom if you click in its far right side. 

You can hide either box, or both at the same time, by selecting the 
appropriate command from the Special Effects menu. 

" File Edit Font Special Effects 
Lin coIn 

four score and seven years ago our fathers brought forth on this continent, o ll.!.....L.:..:~ 
new notion, conceived in Liberta. and dedicated to the proposition that all 
men ore created eQuol. 

ow we ore engaged in o great civil war, testing 
hether that notion, or any notion so conceived and s 
edicoted, con I ong endure. We ore 11et on o great 
ottlefield of that war. We hove co1e to dedicate o 
ortion of that field, as a final resting place for 
hose who here gave their lives that thot notion 
ight live. It is altogether fitting and proper that IL---'-------'' 

e should do this. 

But, in o I urger sense, we con not dedicate --we con not consecrate-- we con 
not hol101~ -- this ground. The brave men, I ivins and dead, who struggl ed here 

Page 1 

8 • 

• • 
• • 



176 I DRAWING WITH MEDLEY 

UNDOING PAINT CHANGES 

Clicking Undo on the Edit menu will cancel the last changes made 
with the selected art tool, as well as most menu commands and 
keystroke commands. 

Clicking Redo on the Edit menu will replace the changes cancelled 
by Undo. Redo will be grayed out if Undo has not been used after 
a change has been made to the art. 

CUTTING ART OBJECTS 

Art objects can be Cut out of an art area and placed on the 
Clipboard. Once on the Clipboard they can be Pasted back into the 
art area they were Cut from, into another art area, or directly into 
the text. The art object must first be selected with either the Lasso 
or the Selection Box. 

To Cut using the Lasso, select the Lasso from the Tool Box. 
The pointer will become a small lasso. Use the tip of the lasso to 
draw a border around the art object. Let up on the mouse button, 
and the border will shrink to conform itself to the art object 
borders. Choose Cut from the Edit menu, and the object will 
disappear from the art area. The object will be placed on the 
Clipboard within a polygon art area. The shape of the polygon is 
determined by the shape that is initially drawn with the Lasso (the 
Lasso borders before they shrink to conform to the art object). 
Any "background" color will transfer to the Clipboard also. If you 
are going to Paste the art object into a body of text, and want the 
text to wrap closely around the shape of the object, make your 
Lasso border as close to the object as possible. 
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Polygons with longer line segments can be created by holding 
down the Shift key drawing with the Lasso. Press the Shift key 
while you click the mouse (letting up on the button). Each click 
becomes an anchor point. Once you let up the mouse button, the 
line segment moves with the mouse until it is clicked again. 
Letting up on the Shift key closes the polygon. 

To Cut using the Selection Box, choose the Selection Box from 
the Tool Box. The pointer will become a "+". Position the 
pointer over the art that is to be Cut, and click and drag. When the 
mouse button is l"t up, a box with moving borders will surround 
the art. Select Cul from the Edit menu, and all art within the 
Selection Box will disappear from the art area. The object will be 
placed on the Clipboard within an art area rectangle. The art area 
rectangle will have the same dimensions as the Selection Box that 
was drawn around the art object. Any "background" color will 
transfer to the Clipboard also. 
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COPYING ART OBJECTS 

Selected art objects from an art area can be Copied onto the 
Clipboard. Once on the Clipboard they can be Pasted back into the 
art area they were Copied from, into another art area, or directly 
into the text. The art object must first be selected with either the 
Lasso or the Selection Box. 

To Copy using the Lasso, select the Lasso from the Tool Box. 
The pointer will become a small lasso. Use the tip of the lasso to 
draw a border around the art object. Let up on the mouse button, 
and the border will shrink to conform itself to the 1rt object 
borders. Choose Copy from the Edit menu, and the obJect will be 
copied onto the Clipboard. The object will be placed on the 
Clipboard within a polygon art area. The shape of the polygon is 
determined by the shape that is initially drawn with the Lasso (the 
Lasso borders before they shrink to conform to the art object). 
Any "background" color will transfer to the Clipboard also. If you 
are going to Paste the art object into a body of text, and want the 
text to wrap closely around the shape of the object, make your 
Lasso border as close to the object as possible. 
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Polygons with longer line segments can be created by holding 
down the Shift key drawing with the Lasso. Press the Shift key 
while you click the mouse (letting up on the button). Each click 
becomes an anchor point. Once you let up the mouse button, the 
line segment moves with the mouse until it is clicked agai~. 
Letting up on the Shift key closes the polygon. 

To Copy using the Selection Box, choose the Selection Box from 
the Tool Box. The pointer will become a "+". Position the 
pointer over the art that is to be Copied, and click and drag. When 
the mouse button is let up, a box with moving bai'ders will 
surround the art. Select Copy from the Edit menu, and all art 
within the Selection Box will be copied onto the Clipboard. The 
object will be placed on the Clipboard within an art area rectangle. 
The art area rectangle will have the same dimensions as the 
Selection Box that was drawn around the art object. Any 
"background" color will transfer to the Clipboard also. 
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Art objects that have been placed on the Clipboard (with Cut or 
Copy) can be Pasted directly into the text, or back into any art 
area. 

Any art object which has been placed on the Clipboard will be 
surrounded by art area borders. The art area borders will have the 
same dimensions as either the initial outline drawing of the Lasso, 
or the size of the Selection Box (whichever was used to select the 
object). 

To Paste an art object directly into text, you must first be in the 
Text mode. Make sure that the whole page on which you want the 
object to appear is showing on the screen, and then select Paste 
from the Edit menu. If parts of 2 different pages are displayed on 
the screen, the art will be Pasted onto the topmost (lower 
numbered) page. The art object will be Pasted into the text, and 
the text will wrap around its area borders. The object is placed on 
the page displayed on the screen in the same location it occupied 
on the page it was Cut or Copied from. For example, if an art 
object is Cut l" from the bottom margin of a page, it will be Pasted 
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into the new page 1" from the bottom margin. Once the object is 
placed on a page, it can be moved in the normal manner. If an art 
area is selected when Paste is chosen, it will have no effect on the 
destination of the art object. 
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endure. We ore met on o great battlefield of thot war. 
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should do this. 

But, in o larger sense, we con not dedicate-- we con not consecrate-- we con 
not hollow-- this ground. The brave men, living and dead, who struggled here, 
hove consecrated it, for above our poor power to odd or detract. The world 

To Paste an art object into another art area, you must first select the 
art area while in the Text mode. Then, choose Enter Paint Tool 
from the Areas menu. The selected area will now be active. 
Select Paste from the Edit menu and the art object on the 
Clipboard will appear in the active art area. 

Art objects can also be Pasted into the same area over and over 
again, thus serving as a "duplicate" feature. Art objects Pasted 
into the same area will be placed directly on top of one another. 
To move a Pasted art object off from on top of the original, select 
it with either the Lasso or the Selection Box. An outline of 
moving borders will be formed. Click inside the moving borders, 
and drag. The art object on top will slide off with the mouse 
movement, leaving the original art object uncovered. 

MOVING BETWEEN DIFFERENT ART AREAS 

Once you are in the Paint Tool, you do not need to go back into the 
Text mode to select another art area to work in. If more than one 
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art area is showing on the screen, you can move between them by 
double-clicking in the area of your choice. 

WORKING WITH IMPORTED ART 

Art from other sources must be imported when you are in the Text 
mode. Once the art is imported into an art area, it can be worked 
on and modified in the same manner as any art that you create 
yourself. Medley does include several features which allow for 
differences that exist between Medley's Paint Tool and other 
"Paint" programs or digitized I scanned art. 

Color palettes may vary, so color art imported from another source 
may look different in Medley. This is because Medley's color 
palette is imposed on the imported art. Instead of adjusting the 
colors dot-by-dot, you can change one color to another throughout 
the entire art area in one step. Select the Change Colors command 
from the Special Effects menu. Pick the color to be changed in 
the "Change All" row. Pick the color you would like to change it 
to in the "To" row. Click OK and the color will change. 

ChongeAII -111-Hj.r:WJH!III'II:i!'li!HI 
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Digitized and scanned art often looks better in shades of gray 
rather than in color. This is particularly true of photographs. For 
this reason, the entire color palette can be changed into a gray 
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palette, or "gray scale." Select the Change To Gray Scale 
command from the Special Effects menu and all art within the 
active document will be displayed in shades of gray. This same 
command can be activated while you are in the Text mode from the 
Special Effects menu. 

When printing imported art to the LaserWriter, the quality of 
LaserWriter print can be changed for individual areas, depending 
on the type of art contained in the area. To change the Laser Writer 
print quality, first select an area or group of areas. Then, select the 
Convert Areas command from the Areas menu and a dialog box 
will appear. 
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If the art area contains mostly black and white art (e.g., black text 
created in the Paint Tool), then select the "To LaserWriter 
high-quality button." This option will cause the black and white 
art to be printed very cleanly and precisely, but if the art area 
contains any colors, the LaserWriter may print them as patterns. 

If the art area contains colors, then select the "To LaserWriter 
gray scale button." The colors will be printed in varying shades 
of gray to give more of a "newspaper photo" appearance. 

If two or more areas have been selected as a group, the "Don't 
change LaserWriter quality button" will be selected. This is 
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because the same group can contain areas with different 
LaserWriter print specifications. This button prevents all grouped 
areas from accidentally having their LaserWriter print 
specifications changed. 

PAINT MENU I KEYSTROKE COMMANDS 

Many of the Paint Tool menu commands can also be ac tivated 
from the keyboard. These commands will have an "open apple" 
and a letter, number, or symbol next to them on the menu. The 
"open apple" is an abbreviation for the Command key. The 
Command key pressed with the letter, number, or symbol will 
activate the corresponding menu command. Below is a list of all 
keystroke commands available in the Paint Tool: 

Help .......................... ...... . .... . . Command I ? 
Save As [Document Name] ............ Command I S 
Print. ............... . . .. ........ ... .. ... . .. Command I P 
Quit . ... ................................... Command I Q 
Undo ....... ............. . . . ............... Command I Z 
Redo ....... . ..... . ........................ Command I A 
Cut .............................. . ......... Command I X 
Copy ..... . ................................ Command I C 
Paste . . .................................... Command I V 
Bold Text.. ............................... Command I B 
Underlined Text ...... . .................. Command I U 
Italicized Text. ........................... Command I I 
Choose Font .. . .......................... Command I F 
Hide/Show Color Box ........... .. ..... Command I R 
Hide/Show Tool Box ................... Comrnand I T 
Hide/Show Both Boxes ................ Command I Y 
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TOOLS SUMMARY 

LASSO -- Used for moving art objects within an art area, or 
selecting objects to Cut or Copy to the Clipboard. The Lasso will 
conform exactly to the object that it surrounds, and will not include 
any "background" color. When the Lasso is selected the pointer 
becomes a small lasso. Click and drag to draw a line around the 
desired object with the tip of the lasso. Once the object is 
surrounded, let up on the mouse button and the Lasso border will 
shrink to conform itself to the outline of the object. The pointer 
will then become a"+". Position the pointer over the object, and 
click and drag to move it. Once an art object is selected with the 
Lasso, it can be Cut or Copied to the Clipboard. 

[] 

SELECTION BOX -- Used for moving art objects within an art 
area, resizing ~· inverting ~t, duplicating art, and selecting art to 
be Cut or CopLed to the Clipboard. The Selection Box will not 
conform to the object which it surrounds, and will include any 
"background" color when it is used to change the art. When the 
Selection Box is chosen, the pointer will become a"+". Click and 
drag diagonally over the desired object. Let up on the mouse 
button and a box with moving borders will be formed. Position 
the pointer inside the box, and click and drag to move it; 
Command - click - drag to resize it; and 0 ption - click - drag to 
duplicate it. Once an art object is selected with the Selection Box, 
it can be Cut or Copied to the Clipboard, or inverted with the 
Horizontal and Vertical Flip commands on the Special Effects 
menu. 

MAGNIFYING GLASS-- Used for enlarging selected parts of art 
objects to do detailed drawing. Select the Magnifying Glass and 
the pointer will become a small box. Position the box over the 
area which you would like to enlarge and click. A dialog box will 
appear, showing the selected portion of art enlarged as a grid. 
Each square on the grid represents a dot on the screen. Select a 
color with the pointer and then move it into the grid. (The only tool 
that will work here is the Pencil.) The color that is selected as you 
enter the Magnifying Glass is the present "border" color. Clicking 
on any color within the grid while the Option key is pressed will 
cause the color selection to change appropriately. Click or drag the 
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mouse to paint the individual squares the selected color. A small 
rectangle in the upper left corner shows the art at its actual size. 
Any changes made while the art is enlarged will also show up in 
this area. 

TEXT-- Used to place text of any color within an art area. Select 
the Text tool and a "border" color. Position the pointer where you 
would like the text to begin, and click. A flashing cursor will 
appear and the text you enter will start at that point. Text in the 
Paint Tool does not wrap around objects or move to another line 
when it runs into a border. Text fonts, sizes, and styles can be 
chosen from the Font menu while you are in the Paint Tool in the 
same manner as when you are in the Text mode. 

PAINT BUCKET-- Used to fill areas with one color. With the 
Paint Bucket selected the pointer will be represented by a paint 
bucket. Position the tip of the pouring paint within any outlined 
area, and click. The area will fill with the chosen "fill" color. If 
there are gaps in the borders, or a "border" color is the same as the 
"fill" color, the filling paint will "leak" through. 

[]] 

SPRAY PAINT-- Used to color an area with a dotted pattern. 
With the Spray Paint selected the pointer becomes a circular pattern 
of dots. Click and drag the pointer within the art area to create a 
"sprayed" effect. The Spray Paint color is chosen by selecting a 
"border" color. The rate and size of the Spray Paint fill can be 
adjusted with the Adjust Spray Paint command from the Speci~l 
Effects menu. 

PAINT BRUSH-- Used for freehand drawing of different shapes 
and patterns. To use the Paint Brush, choose a "border" color 
from the Color Box. Then, select your brush shape with the 
Select a Brush command on the Special Effects menu. (See 
"Brush Shapes.") Once the brush shape is selected, the pointer 
becomes that shape. Position the pointer inside the area. Click 
and drag, and a line will be painted. 

PENCIL-- Used for freehand drawing of different sized lines. To 
use the Pencil, first choose a "border" color and the desired line 
width from the "Border Palette." Select the Pencil, and the pointer 
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will become a small pencil. Position the pointer inside the area, 
click, and drag. A line will be drawn with the tip of the pencil. 

[;] 

STRAIGHT LINE-- Used to draw straight lines from one point to 
another. Select the Straight Line tool, a "border" color, and a line 
width. The pointer will be represented by a "+". Position the 
pointer where you would like the line to begin, then click and 
drag. The line is anchored at the beginning point and will stretch 
with the mouse movement. Let up on the mouse button when the 
line is in the desired location. 

ERASER -- Used to erase selected parts of the art area, or the 
entire art area at once. Once the Eraser is selected the pointer is 
represented by a hollow box. To erase, position the pointer over 
the art to be erased, and click and drag. Any art that the pointer 
touches will be returned to the "background" color (selected from 
the Color Box). The entire art area can be erased at once by 
double-clicking the Eraser in the Tool Box. 

HOLLOW RECTANGLE-- Used for drawing rectangular shapes 
with nothing inside. Choose a "border" color with the small 
trapezoid. Choose a border line width from "Border Palette." 
Select the Hollow Rectangle and the pointer will become a "+". 
Position the pointer in the art area, and click and drag diagonally. 
Let up on the mouse button when the rectangle is the size desired. 
Borders will remain black until the mouse button is released. 

[§] HOLLOW ROUND RECTANGLE -- Used for drawing 
rectangular shapes with round corners and nothing inside. Choose 
a "border" color with the small trapezoid. Choose the border line 
width from "Border Palette." Select the Hollow Round Rectangle 
and the pointer will become a"+". Position the pointer in the art 
area, and click and drag diagonally. Let up on the mouse button 
when the rectangle is the size desired. You can control the 
"roundness" of the corners by pressing any of the arrow keys 
while the mouse button is still pressed down. The next round 
rectangle placed in the art area will be set at the same "roundness" 
as the previous one. Borders will remain black until the mouse 
button is released. 
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HOLLOW OVAL -- Used for drawing ovals with nothing inside. 
Choose a "border" color with the small trapezoid. Choose the 
border line width from "Border Palette." Select the Hollow Oval 
and the pointer will become a "+". Position the pointer in the art 
area, and click and drag diagonally . Let up on the mouse button 
when the oval is the size desired. Borders will remain black until 
the mouse button is released. 

HOLLOW FREEHAND SHAPE -- Used for drawing freehand 
shapes with nothing inside. Choose a "border" color with the 
small trapezoid. Choose the border line width from "Border 
Palette." Select the Hollow Freehand Shape and the pointer will 
become a"+". Position the pointer in the art area, and click and 
drag. The border of the shape will be drawn with the mouse 
movement. You can join the starting point with the end point by 
hand, or let up on the mouse button and the two ends will be 
joined by a straight line. Borders will remain black until the 
mouse button is released. 

HOLLOW POLYGON -- Used for drawing polygons with 
nothing inside. Choose a "border" color with the small trapezoid. 
Choose the border line width from "Border Palette." Select the 
Hollow Polygon and the pointer will become a"+". Position the 
pointer in the art area, and click (but do not drag). The border line 
will now move with the mouse. Each click thereafter becomes an 
anchor point from which the line moves with the mouse. Double­
clicking the mouse button will connect the last point with the 
starting point of the polygon. Double-clicking outside the art area 
will erase a polygon in the process of being created. Polygon 
borders can also be stretched and anchored outside the art area, 
although only the parts of the polygon within the art areas will 
show. Borders will remain black until the mouse button is 
released. 

FILLED RECTANGLE-- Used for drawing rectangular shapes 
with a color or pattern on the inside. Choose a "border" color and 
a "fill" color with the small trapezoid. Choose the border line 
width from "Border Palette." Select the Filled Rectangle and the 
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pointer will become a"+". Position the pointer in the art area, and 
click and drag diagonally. Let up on the mouse button when the 
rectangle is the size desired. Borders will remain black and no 
"fill" color will show until the mouse button is released. 

FILLED ROUND RECf ANGLE-- Used for drawing rectangular 
shapes with round corners and a color or pattern on the inside. 
Choose a "border" color and a "fill" color with the small trapezoid. 
Choose the border line width from "Border Palette." Select the 
Filled Round Rectangle and the pointer will become a "+". 
Position the pointer in the art area, and click and drag diagonally. 
Let up on the mouse button when the rectangle is the size desired. 
You can control the "roundness" of the corners by pressing any of 
the arrow keys while the mouse button is still pressed down. The 
next round rectangle placed in the art area will be set at the same 
"roundness" as the previous one. Borders will remain black and 
no "fill" color will show until the mouse button is released. 

FILLED OVAL-- Used for drawing ovals with a color or pattern 
on the inside. Choose a "border" color and a "fill" color with the 
small trapezoid. Choose the border line width from "Border 
Palette." Select the Filled Oval and the pointer will become a "+". 
Position the pointer in the art area, and click and drag diagonally. 
Let up on the mouse button when the oval is the size desired. 
Borders will remain black and no "fill" color will show until the 
mouse button is released. 

FILLED FREEHAND SHAPE -- Used for drawing freehand 
shapes with a color or pattern on the inside. Choose a "border" 
color and a "fill" color with the small trapezoid. Choose the 
border line width from "Border Palette." Select the Filled 
Freehand Shape and the pointer will become a "+". Position the 
pointer in the art area, and click and drag. The border of the shape 
will be drawn with the mouse movement. You can join the starting 
point with the end point by hand, or let up on the mouse button 
and the two ends will be joined by a straight line. Borders will 
remain black and no "fill" color will show until the mouse button 
is released. 
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FILLED POLYGON --Used for drawing polygons with a color or 
pattern on the inside. Choose a "border" color and a "fill" color 
with the small trapezoid. Choose the border line width from 
"Border Palette." Select the Filled Polygon and the pointer will 
become a "+". Position the pointer in the art area, and click (do 
not drag). The border line will now move with the mouse. Each 
click thereafter becomes an anchor point from which the line 
moves with the mouse. Double-clicking the mouse button will 
connect the last point with the starting point of the polygon. 
Double-clicking outside the art area will erase a polygon in the 
process of being created. Polygon borders can also be stretched 
and anchored outside the art area, although only the parts of the 
polygon within the an areas will show. Borders will remain black 
and no "fill" color will show until the mouse button is released. 



JTIHIIE 
IF IT N IT § IHI IE JD) 
IPffi(Q)JD)1IJCC1T 

191 



192 I PRINTING 

PRINTING 

PREPARING THE IIGS FOR PRINTING 

You must set the printer "slot" from the Control Panel to direct 
your document to a printer linked directly to your IIGS, or a 
printer that will be located on the AppleTalk network. The slots 
are pre-set for a direct link to a printer. 

To set the "slots" from the Control Panel: 

1. With your computer on and your printer off, press the 
Command, Control, and Esc keys at the same time. 

2. A box will appear titled "Desk Accessories." Use the 
arrow keys to place the cursor over "Control Panel," and 
then press the Return key. 

3. A box will appear titled "Control Panel." Use the arrow 
keys to place the cursor over "Slots," and then press the 
Return key. A list of the seven slots and their designated 
uses will appear. To change a slot's designation, position 
the cursor over the slot number and then press the left or 
right arrow keys. 

4. To print directly, make sure that slot 1 is set to "Printer 
Port" if the printer is in the printer port, or that slot 2 is set 
to "Modem Port" if the printer is in the modem port. Slot 7 
must be set to "Your Card." 

5. To print over the Apple Talk network, make sure that slot 1 
is set to "Your Card" if you are using the printer port, or 
that slot 2 is set to "Your Card" if you are using the modem 
port. Slot 7 must be set to "Built-in Apple Talk." 

6. After all changes have been made, press the Return key. 

7. Select "Quit" to exit the Control Panel. 
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8. If any changes have been made you must turn the computer 
off and then back on again, or the changes will not take 
effect. 

CHOOSING A PRINTER 

The Choose Printer command allows you to select which type of 
printer to use when printing your document. Medley will print to 
ImageWriters, LaserWriters, and their compatibles. Medley is 
pre-set to print directly to an Image Writer. 

To choose a printer, position the pointer over the Choose Printer 
command and click. A dialog box like the one below will appear. 

It File £dit Search Areas Font For1ot Special £fleets Shortcuts 

Choose Printer v2.1 

Printer Port: 
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Position the pointer over one of the printers available under 
Printer Type and click. The printer selected will be outlined. 
Next, select the button that describes the connection between your 
printer and your computer. Image Writers can be accessed with the 
"Direct Connect button" or the "AppleTalk button" (if the 
AppleTalk Option is installed). LaserWriters will usually be 
accessed with the "AppleTalk button," unless your IIGS is 
connected to the LaserWriter through the RS232 serial port. Then 
you should use the "Direct Connect button." 
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Turn on the "Direct Connect button" if you will be printing 
directly to an ImageWriter. (The AppleTalk slot must have been 
de-selected from the Control Panel.) You must then choose which 
port you printer is hooked into by selecting one of the options 
under Printer Port: 

Select Printer if your printer is hooked up to the printer 
port. 

Select Modem if your printer is hooked up to the modem 
port. (Make sure that the "Modem" option on the Control 
Panel is set to accommodate a printer.) 

Turn on the "AppleTalk button" if your printer is on the 
AppleTalk network. (The AppleTalk slot must also have been set 
from the Control Panel.) All printers on the network that match 
the selection under Printer Type will be displayed under Select 
a Printer. Select the appropriate printer by clicking on its name. 

Click OK to accept your choices and return to your document. 
Click Cancel to return to your document without making any 
changes. 

PAGE SETUP 

The Page SetUp ... command on the File menu lets you choose 
the page parameters for your printed document. The options 
available to you will differ with your choice of printer selected in 
Choose Printer. 

Page SetUp with TmageWriters: 

1. Click Page SetUp ... 
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2. A dialog box like the one below will appear. 
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3. Click any of the four options under Paper to choose your 
paper size: 

* US Letter for paper gl/2 inches wide by 11 
inches tall. (This is the default selection.) 

* US Legal for paper gl/2 inches wide by 14 inches 
tall. 

* A4 Letter for European standard paper - gl/4 
inches wide by 112!3 inches tall. 

* International Fanfold for International standard 
paper- gi/4 inches wide by 12 inches tall. 

4. Click "Condensed" under Vertical Sizing to print your 
document at half its normal vertical height, but at the 
normal width. 

5. Under Printer Effects, click "No Gaps Between Pages" 
to print the document without any page breaks. Click 
"50% Reduction" to print the document at half its normal 
size (height and width). 
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6. Click the Orientation for your printed page. 

Tall Wide 

Tall (default selection) prints with the top line of your 
document starting at the top of the page. 

Wide prints with the top line of your document printing 
along the right side of the page. 

7. Click OK to accept the Page SetUp, or Cancel to return to 
your document without changing the Page SetUp 
parameters. 

Page SetUp with LaserWriters: 

1. Click Page SetUp ... 

2. A dialog box like the one below will appear. 
~ File Edit Search Areas Font Foraot Special Effects Shortcuts 
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3. Click any of the four options under Pa~r to choose your 
paper size: 
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US Letter for paper gi/2 inches wide by 11 
inches tall. (This is the default selection.) 
US Legal for paper gi/2 inches wide by 14 inches 
tall. 
B5 Letter for paper 15 inches wide by 11 inches 
tall. 
A4 Letter for European standard paper - 81/4 
inches wide by 112!3 inches tall. 

4. Click the Orientation for your printed page. 

Tall Wide 

Tall (default selection) prints with the top line of your 
document starting at the top of the page. 

Wide prints with the top line of your document printing 
along the right side of the page. 

5. Vertical Sizing: 

NORMAL -- Prints text and art at the same proportion as is 
shown on the computer monitor. 

INTERMEDIATE-- Prints text and art at two thirds their 
normal height, but at the normal width. 

CONDENSED --Prints text and art at one half their normal 
height, but at the normal width. 

6. Printer Effects: 

SMOOTHING -- Instructs the LaserWriter to add dots 
between the rough edges of artwork and non- LaserWriter 
fonts to produce a smoother effect. 
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FONT SUBSTITUTION -- If the fonts you have chosen 
for your document are not resident within the LaserWriter, 
this command substitutes fonts that are resident within the 
LaserWriter. Non - LaserWriter fonts will print as they 
appear on the screen -- very blocky looking. Fonts 
resident within the LaserWriter will have a higher 
resolution and much cleaner appearance. If you know 
which fonts are resident within your LaserWriter, then you 
can create your document with the assurance that the final 
text out-put will match the text on the screen. Some 
examples of font substitution are: 

Shaston becomes Helvetica 
Geneva becomes Helvetica 
Venice becomes Courier 

7. You can Reduce or Enlarge your document by typing 
in a number from 25 to 400 in the "% Box" next to 
Reduce or Enlarge. 50% will reduce the document by 
half. 200% will enlarge the document to twice its nom1al 
size. 

8. Click OK to accept the Page SetUp, or Cancel to return to 
your document without changing the Page SetUp 
parameters. 
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PRINTING A DOCUMENT 

NOTE: Before you begin to print, make sure that you have 
selected the appropriate printer (LaserWriter or lmageWriter). 

To Print With Image Writers: 

Select the Print command, and a dialog box with several options 
will appear looking like this: 

d File Edit Search Areas Font Fmat Special £ffects Shortcuts 

IHAGEWRIHR/PRIHHR v2.1 
Qualitu: 0 Better Text 

@Better Color 
0 Draft 

Poge ronge: 
@Rll 

OFrom:D To: D 
Copies:[[] 
Paper Feed:@ Automatic 0 Honual 

DColor (Cancel)(]) 
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There are three options available for Quality of printed text: 

1. Selecting Better Text will give you the highest quality of 
text output. However, it also takes the longest to print. 
Better Text will print text that has better resolution than 
the screen. Medley creates Better Text by generating a 
font that is twice the size of the font on the screen. It then 
condenses the large font to half its size as it prints, thereby 
creating higher resolution printed text that is the correct 
font size. Better Text works best when you use a font 
that can be selected from the menu at twice the size as that 
used in the document (e.g., The font "Shaston" is 
selectable in sizes 8 and 16. Create your document using 
size 8 for maximum printing resolution). If you select a 
font size that does not show a double in the font menu, it 
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will print in Better Text, but not with as good a 
resolution. 

IMPORTANT NOTE: 

When printing with the Better Text option selected, no 
font size should be set larger than 30. Medley has a font 
size limit of 60. Since Better Text blows fonts up to 
twice their selected sizes before condensing and printing 
them, sizes larger than 30 cannot be handled. (Text sized 
35 would become size 70 before being condensed and 
printed.) Using Better Color will allow you to print font 
sizes up to 60. 

2. Selecting Better Color will give you good quality text at 
a faster speed. Better Color will print text and graphics 
exactly as you see them on the screen. Due to the fact that 
some fonts do not display underlines on the screen, and 
since Better Color prints information exactly as it is 
displayed on the screen, some fonts will not have 
underlines printed in this mode. Printing in Better Text 
will display all underlines. See "Choosing Fonts, Styles, 
and Sizes" for more information. 

3. Selecting Draft will give you the quickest print speed, but 
it will print your document in segments. The graphics will 
print first, and then the text will print in only one font and 
size on a different part of the page. Use this mode to 
preview and proof your document. 

Page Range allows you to control how much of your document 
is printed at a time. If you want to print your entire document, 
click the "All button." If you want to print only certain pages, 
click the "From button." Then, position the pointer in each box, 
click, and type the page numbers to be printed. The document will 
be printed within the pages specified, including those pages. 

If you want more than one copy of each document, click in the 
Copies box and enter the number of copies desired. 
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From Paper Feed, click the "Automatic button" if you have 
paper that is either continuous or in a paper cassette. Click the 
"Hand Feed button" if you will be feeding the paper into the 
printer by hand (e.g. , personal stationary, corporate letterhead). 

Click in the Color box if you have an ImageWriter II or an 
ImageWriter LQ with a color ribbon, and wish to print your 
document in color. 

When all options are set to your specifications, click 0 K to print. 
Click Cancel to return to your document without printing. 

To Print With LaserWriters: 

Select the Print command, and a dialog box with several options 
will appear looking like this: 

It file Edit Seorch Areos F ant F or1at Special Effects Shortcuts 

lmrWriter v2.1 
Poges: @All 

OFrom:D To: D 
Copies:[[] 
Paper Source: 

@Paper TroH 
0 Manual Feed 

~CD 
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Pages allows you to control how much of your document is 
printed at a time. If you want to print your entire document, click 
the "All button." If you want to print only certain pages, click the 
"From button." Then, position the pointer in each box, click, and 
type the page numbers to be printed. The document will be printed 
within the pages specified, including those pages. 
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If you want more than one copy of each document, click in the 
Copies box and enter the number of copies desired. 

From Paper Source, click the "Paper Cassette button" if you 
will be using paper that is in a paper cassette. Click the "Manual 
Feed button" if you will be feeding the paper into the printer by 
hand (e.g., personal stationary, corporate letterhead). 

When all options are set to your specifications, click OK to print. 
Click Cancel to return to your document without printing. 

The quality of LaserWriter print can be changed for individual 
areas, depending on the type of art contained in the area. To 
change the LaserWriter print quality, first select an area or group 
of areas. Then, select the Convert Areas command from the 
Areas menu and a dialog box will appear. 

4 file [dit Search Areas font rorlat Special [fleets Shortcuts 

r- Convert Areas ... @to rectangle 

® ~ 0 to round rectangle 
Oto oval 
0 to polygon 

0 don't change contents ······················································ 
@to ort contents @ 11ove to page: rn:::::J 
0 to text contents 0 display on all pages 
................................................................... ······················································ 
0 don't change LoserWriter quality 0 don't change borders 
@to LaserWriter high-quality @turn an borders 
0 to LaserWriter gray scale ~ 0 turn off borders 
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If the art area contains mostly black and white art (e.g., black text 
created in the Paint Tool), then select the "To LaserWriter 
high-quality button." This option will cause the black and white 
art to be printed very cleanly and precisely, but if the art area 
contains any colors, the LaserWriter may print them as patterns. 
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If the art area contains colors, then select the "To LaserWriter 
gray scale button." The colors will be printed in varying shades 
of gray to give more of a "newspaper photo" appearance. 

If two or more areas have been selected as a group, the "Don't 
change LaserWriter quality button" will be selected. This is 
because the same group can contain areas with different 
LaserWriter print specifications. This button prevents all grouped 
areas from accidentally having their LaserWriter print 
specifications changed. 
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THE APPLE MENU 

ABOUT MEDLEY 

HELP 

Tells you how much memory is presently being used, and also 
tells you which version of Medley you are using. Click anywhere 
on the screen to return to the document. 

Gives you general information about the many options available in 
Medley. For more detail, the information in the Help window 
refers to chapters in the user's manual. 

THE FILE MENU 

NEW DOCUMENT 

Opens a new document with a blank screen. This is the "empty 
slate" upon which any type of document can be created. See 
"Opening a New Document." 

OPEN DOCUMENT 

Opens any previously created (and saved) document. This 
command also lets you open documents from different folders and 
disks. See "Opening an Existing Document." 

CLOSE [Document Name] 

Closes the active document window, but does not take you out of 
Medley and back to the Finder. If any changes have been made, a 
dialog box will ask if the changes should be saved before the 
document closes. See "Closing a Document." 
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SAVE AS [Document Name] 

Saves the active document under the name showing in the Title 
Bar. If an earlier version was saved to disk under the same name, 
it will be replaced by the active version. See "Saving a 
Document." 

SAVE AS ... 

Saves the active document under a different name, other than the 
one on the Title Bar. This command will also save the active 
document to a different folder or a different disk. See "Saving a 
Document." 

DELETE ... 

Lets you select and delete documents from any folder or disk. 
Once this command is used the selected document will be erased in 
its entirety from the disk on which it was saved. Folders cannot 
be deleted with this command. See "Deleting a Document." 

PRINT ... 

Lets you choose your printing options. Whether or not to start 
printing, print quality, paper source, number of copies, pages to 
print, and color printing are the options available. Most of these 
are dependent upon which type of printer is chosen. See "Printing 
a Document." 

SET MARGINS 

Lets you set the top, bottom, left, and right margins for the entire 
document. For bound documents, a gutter margin can also be set. 
See "Setting Margins." 

PAGE SETUP 

Sets the page parameters for printing. You can choose paper size, 
to print lengthwise or sideways, and to condense or reduce your 
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document. The options in this command are dependent upon 
which type of printer is chosen. See "Page Setup." 

CHOOSE PRINTER 

QUIT 

Lets you choose which type of printer you will use, as well as 
whether or not the printer is located on an AppleTalk network. 
See "Choosing a Printer." 

Takes you out of Medley and back to the Finder. If any 
documents have been altered and have not been saved, you will be 
asked if you would like to save them. See "Quitting Medley." 

THE EDIT MENU 

UNDO 

REDO 

CUT 

Deletes the last change made, so that the document looks just like 
it did before the change. Undo keeps track of the last ten changes. 
See "Undoing and Redoing." 

Is the exact opposite of Undo. Redo reinstates changes cancelled 
by Undo . Redo will keep track of ten Undoes. If Undo has not 
been used after a change to the document, Redo will be grayed 
out. See "Undoing and Redoing." 

Takes selected text or art out of your document and puts it on the 
Clipboard. Cut or Copy commands will replace anything already 
on the Clipboard. In effect, the item is then deleted. An item on 
the Clipboard cro be moved back into the document with Paste. 
This command will only be active (not grayed out) if you have 



COPY 

REFERENCE I 209 

selected either some text, or an art area. See "Deleting Text" and 
"Moving Text." 

Copies any selected text or art, and places it on the Clipboard. 
The original remains, unaltered, in the document. Copies on the 
Clipboard can be moved back into the document with Paste. This 
command will only be active (not grayed out) if you have selected 
either some text, or an art area. See "Copying Text." 

PASTE 

Moves items presently on the Clipboard into the document. The 
cursor marks the point of insertion. Items remain on the 
Clipboard until they are replaced with Cut or Copy, so they can be 
pasted into a document again and again. This command will only 
be active (not grayed out) if there is something on the Clipboard. 
See "Moving Text" and "Copying Text." 

CLEAR 

Deletes any art area or text that is selected. Deleted art or text will 
not be moved onto the Clipboard. This command will only be 
active (not grayed out) if you have selected either some text, or an 
art area. See "Deleting Text" and "Deleting Areas." 

DUPLICATE 

Duplicates the entire selected art area (or group of areas) and its 
contents. The copy is placed slightly lower and to the right of the 
original. This command will only be active (not grayed out) if an 
area or group of areas is selected. See "Duplicating Areas." 

SHOW CONTENTS OF CLIPBOARD 

Displays the present contents of the Clipboard. This command 
will only be active (not grayed out) if there is something on the 
Clipboard. See "Moving Text" and "Copying Text." 
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THE SEARCH MENU 

FIND ... 

Finds any occurrences of specified words, or parts of words, 
including capitalizations and punctuation. The requested item is 
highlighted once it is found. See "Finding Text." 

REPLACE ... 

Replaces any occurrences of specified words, or parts of words, 
including capitalizations and punctuation. Specified items may be 
replaced throughout the entire document, or on a case-by-case 
basis. See "Replacing Text." 

SPELL CHECK ... 

Finds any words that are not in the 80,000 word dictionary. You 
can spell check an entire document, or just the text that you select. 
Once a possible misspelled word is found you can enter the correct 
spelling, tell the computer to search for and suggest a list of 
probable correct spellings, or ignore it if it is correctly spelled. If 
the flagged word is correctly spelled and one that you will be 
using often, you can add it to any of the user dictionaries so that it 
is not flagged in the future. See "Spell Checking a Document." 

THESAURUS 

Displays a list of synonyms for selected words. See "The 
Electronic Thesaurus." 

DICTIONARIES 

Lets you add words to, or delete them from, the various spell 
check dictionaries. Words can be added to the dictionaries so that 
they will no longer be flagged as possible misspellings. Each 
document has its own dictionary created by the user called the 
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Document Dictionary. The Document Dictionary is attached to the 
document in which it is created, and its words will not be 
recognized if another document is spell checked. Words in a 
selected Auxiliary Dictionary will be recognized by the spell 
checker for all documents. Words cannot be deleted from the 
original 80,000 word dictionary. See "Adding Words to the 
Dictionaries." 

THE AREAS MENU 

ADD ART RECTANGLE 

Lets you draw a rectangle and ~lace it in your document. The 
pointer will become a small"+". Click and drag, and a rectangle 
will grow or shrink with the mouse movement. Let up on the 
mouse button and the rectangle will be inserted into the document. 
Text will automatically wrap around the rectangle. The rectangle 
can be resized by clicking and dragging one of the black pull tabs 
on its border, or moved by clicking and dragging with the pointtr 
in the center of the rectangle. See "Adding Rectangles, Ovals, and 
Polygons," "Selecting Areas," "Changing Area Sizes," and 
"Moving Areas." 

ADD ART ROUND RECf ANGLE 

Lets you draw a rectangle with rounded corners and place it in 
your document. The pointer will become a small "+". Click and 
drag, and a round rectangle will grow or shrink with the mouse 
movement. Let up on the mouse button and the round rectangle 
will be inserted into the document. Text will automatically wrap 
around the round rectangle. The round rectangle can be resized by 
clicking and dragging one of the black pull tabs on its border, or 
can be moved by clicking and dragging with the pointer in the 
center of the round rectangle. See "Adding Rectangles, Ovals, 
and Polygons," "Selecting Areas," "Changing Area Sizes," and 
"Moving Areas." 
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ADD ART OVAL 

Lets you draw an oval and place it in your document. The pointer 
will become a small"+". Click and drag, and an oval will grow or 
shrink with the mouse movement. Let up on the mouse button 
and the oval will be inserted into the document. The oval can be 
resized by clicking and dragging any one of the black pull tabs on 
its border, or moved by clicking and dragging with the pointer in 
the center of the oval. See "Adding Rectangles, Ovals, and 
Polygons," "Selecting Areas," "Changing Area Sizes," and 
"Moving Areas." 

ADD ART POLYGON 

Lets you draw a multi-sided polygon and place it in your 
document. The pointer will become a small"+". By clicking and 
dragging, the pointer can be used to draw a freehand polygon. If 
the mouse button is let up, the end point will automatically connect 
to the starting point. Text will automatically wrap around the 
completed polygon. Once the polygon is complete, it can be 
resized by clicking and dragging any one of the black pull tabs on 
its border, or moved by clicking and dragging with the pointer in 
the center of the polygon. See "Adding Rectangles, Ovals, and 
Polygons," "Selecting Areas," "Changing Area Sizes," and 
"Moving Areas." 

FORCE SHOWING BORDERS 

Forces all art area borders to show even if they have been turned 
off. Once selected, the command changes to "Don't Force 
Showing Borders." Selecting this will once again hide the borders 
that have been turned off. See "Show All Hidden Area Borders." 

MOVE I CHANGE AREAS 

Puts the program in the Move I Change mode so that areas can be 
resized and moved. After this command is chosen, click once in 
an area and it will become selected -- its borders will turn orange 
(gray on a monochrome monitor). Once in the Move I Change 
mode, an area can be resized by clicking and dragging any one of 
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the black pull tabs on its border, or moved by clicking and 
dragging with the pointer in its center. An art area can also be 
placed in the Move I Change mode by clicking just once within its 
borders (without having to select Move I Change Areas). This 
shortcut will not work for Page Parts. See "Selecting Areas," 
"Changing Area Sizes," and "Moving Areas." 

SHOW MOVE I CHANGE INFO 

Produces a box which shows the entire page. Outlines of all art 
areas are shown, along with the dimensions and coordinates of a 
selected area or group of areas. This box will always be behind 
the active document window. To see it in its entirety, use the 
Resize Box to resize the document window to the left. Areas 
cannot be moved in the Move I Change Info box; only on the full 
document screen. Once selected, this command changes to Hide 
Move I Change Info . Select it to hide the box. See "The Move I 
Change Information Box." 

CONVERT AREAS ... 

Produces a dialog box which lets you convert one type of art area 
to any other type (e.g., from a rectangle to an oval). This can be 
done before or after art or text is put in the area. The Convert 
Areas dialog box also lets you move an area from one page to 
another, display the area on all pages ("global" art or "global" 
Page Parts), turn selected area borders on or off, select 
LaserWriter print quality for individual areas, and change an art 
area to a Page Part (text area). This command will only be active 
(not grayed out) if an area is selected. See "Converting Areas to 
Different Types," "Moving Areas to a Different Page," "Placing 
Areas On All Pages," "Turning Off Area Borders," and "Changing 
Art Areas to Text Areas." 

GROUP 

Holds grouped areas together as a group when moving in and out 
of the Move I Change mode. Several areas can be selected as 
group while in the Move I Change mode by holding down the 
Shift key and clicking in each area. However, areas will not 
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remain as a group when you leave the Move I Change mode unless 
the Group command is chosen. This command will only be active 
(not grayed out) if you are in the Move I Change mode and have 
selected two or more areas as a group. See "Grouping Areas 
Together." 

UNGROUP 

Cancels a Group command. This command will only be active 
(not grayed out) if you are in the Move I Change mode and have 
selected a group of areas that is held together by the Group 
command. While you are still in the Move I Change mode the 
areas will be grouped together, but once you leave, the areas will 
lose their identity as a group. See "Grouping Areas Together." 

BRING TO FRONT 

Brings the selected area to the top when two or more areas 
overlap. Areas that overlap are stacked in the order that they are 
placed on the screen (the last area created will show in its entirety). 
This command will only be active (not grayed out) if an area is 
selected. See "Working With Overlapping Areas." 

SEND TOBACK 

Sends the selected area to the bottom of the stack when two or 
more areas overlap. Overlapping areas are stacked in the order in 
which they are placed on the screen: the first area on the bottom, 
the last one on the top. This command will only be active (not 
grayed out) if an area is selected. See "Working With Overlapping 
Areas." 

ENTER PAINT TOOL 

Puts the program in the Paint mode and brings up the Paint 
menus. This command will only be active (not grayed out) if an 
area is selected. The Paint tools will only work within the selected 
area. You can also enter the Paint Tool by double-clicking in any 
unselected area. See "From Text Menus to Paint Menus." 
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THE FONT MENU 

PLAIN 

BOLD 

Produces Plain text (no embellishments) of the selected font. 
Plain letters will then start to print where the cursor is flashing 
when text is entered. If you would like to change the style of text 
that has already been entered, select the block of text and then 
choose the font or style. Text that is inserted into a block of text 
which has already been formatted will always assume the font, 
style, and size of the text surrounding it unless it is changed. See 
"Choosing Fonts and Styles." 

Produces Bold text (heavy letters) of the selected font. Bold 
letters will then start to print where the cursor is flashing when text 
is entered. If you would like to change the style of text that has 
already been entered, select the block of text and then choose the 
font or style. Text that is inserted into a block of text which has 
already been formatted will always assume the font, style, and size 
of the text surrounding it unless it is changed. See "Choosing 
Fonts and Styles." 

UNDERLINE 

Produces Underlined text (underscored letters) of the selected 
font. Underlined letters will then start to print where the cursor is 
flashing when text is entered. If you would like to change the 
style of text that has already been entered, select the block of text 
and then choose the font or style. Text that is inserted into a block 
of text which has already been formatted will always assume the 
font, style, and size of the text surrounding it unless it is changed. 
See "Choosing Fonts and Styles." 
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ITALIC 

Produces Italic text (slanted letters) of the selected font. Italic 
letters will then start to print where the cursor is flashing when text 
is entered. If you would like to change the style of text that has 
already been entered, select the block of text and then choose the 
font or style. Text that is inserted into a block of text which has 
already been formatted will always assume the font, style, and size 
of the text surrounding it unless it is changed. See "Choosing 
Fonts and Styles." 

OUTLINE 

Produces Outlined text (hollow letters) of the selected font. 
Outlined letters will then start to print where the cursor is flashing 
when text is entered. If you would like to change the style of text 
that has already been entered, select the block of text and then 
choose the font or style. Text that is inserted into a block of text 
which has already been formatted will always assume the font, 
style, and size of the text surrounding it unless it is changed. See 
"Choosing Fonts and Styles." 

SHADOW 

Produces Shadowed text (hollow letters with a heavy base) of the 
selected font. Shadowed letters will then start to print where the 
cursor is flashing when text is entered. If you would like to 
change the style of text that has already been entered, select the 
block of text and then choose the font or style. Text that is 
inserted into a block of text which has already been formatted will 
always assume the font, style, and size of the text surrounding it 
unless it is changed. See "Choosing Fonts and Styles." 

CHOOSE FONT 

Lets you choose the font, style, and size of text. Letters reflecting 
the change will then start to print where the cursor is flashing 
when text is entered. If you would like to change the style of text 
that has already been entered, select the block of text and then 
choose the font or style. Text that is inserted into a block of text 



REFERENCE I 217 

which has already been formatted will always assume the font, 
style, and size of the text surrounding it unless it is changed. See 
"Choosing Fonts and Styles." 

SUPERSCRIPT 

Produces text that is slightly raised in relation to normal text. 
Superscripted text will then start to print where the cursor is 
flashing when text is entered. See "Choosing Fonts and Styles." 

NORMAL 

Reverts Superscript or Subscript text back to normal. This 
command will only be active (not grayed out) if you have selected 
text that is either Superscripted or Subscripted. See "Choosing 
Fonts and Styles." 

SUBSCRIPT 

Produces text that is slightly lower in relation to normal text. 
Subscripted text will then start to print where the cursor is flashing 
when text is entered. See "Choosing Fonts and Styles." 

THE FORMAT MENU 

CHANGE LEADING 

Changes the space between lines. Line separation is measured in 
"points" (1132 of an inch) and can be adjusted from the top of the 
line or the bottom of the line. This command also lets you adjust 
the space between paragraphs. See "Line Spacing" and 
"Paragraph Gaps." 

SET TABS 

Lets you choose one of the four possible tab-stop alignments to 
place on the Ruler. Tabs will align flush left, flush right, 
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centered, or to a decimal point. Different tab-stop alignments can 
also be chosen directly from the Ruler. See "Tabs." 

ADD A PAGE BREAK HERE 

Places a page break wherever the cursor is blinking. Any text 
below that point will appear on the next page or in the next Page 
Part. Page breaks which are created manually will not affect art 
areas that extend below the page break line. See "Adding Manual 
Page Breaks." 

CHANGE PAGE LAYOUT 

Lets you change the direction of the automatic word wrap for the 
entire page or selected Page Parts. The word wrap normally 
"wraps down" --whenever the text runs into an art area border it 
will move down a line. By selecting "wrap across," a line of text 
will read across the art area and continue on the other side. 
Change Page Layout also lets you hide "global" art areas and Page 
Parts (areas which appear in the same place on every page in the 
document) on selected pages. The "global hide buttons" will only 
be active (not grayed out) if there are no areas in your document 
which are selected. See "Word Wrap Direction" and 
"Customizing Global An and Page Parts." 

CHANGE TO UPPERCASE 

Changes all selected text to uppercase. This command will only 
be active (not grayed out) if some text is selected. See "Changing 
Text to Uppercase and Lowercase." 

CHANGE TO LOWERCASE 

Changes all selected text to lowercase. This command will only 
be active (not grayed out) if some text is selected. See "Changing 
Text to Uppercase and Lowercase." 
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CHANGE PAGE NUMBERS 

LEFT 

Lets you pick the style and location for your page numbering. 
This command also allows you to enter text on the same line as the 
page number, so that you can create headers or footers. See "Page 
Numbers, Headers, and Footers." 

Aligns text evenly, or flush, along all left margins, leaving 
"ragged" right margins. Once this command is selected, all text 
that is entered subsequently will be flush left. For text that has 
already been entered, only the paragraph in which the cursor is 
blinking - or any selected text - will change. See "Text 
Justification." 

RIGHT 

Aligns text evenly, or flush, along all right margins, leaving 
"ragged" left margins. Once this command is selected, all text that 
is entered subsequently will be flush right. For text that has 
already been entered, only the paragraph in which the cursor is 
blinking - or any selected text - will change. See "Text 
Justification." 

CENTERED 

Aligns text so that each line is centered between any two margins, 
leaving both margins "ragged." Once this command is selected, 
all text that is entered subsequently will be centered. For text that 
has already been entered, only the paragraph in which the cursor is 
blinking - or any selected text - will change as the alignment is 
changed. See "Text Justification." 

JUSTIFIED 

Aligns text evenly, or flush, along all margins. Once this 
command is selected, all text that is entered subsequently will be 
fully justified. For text that has already been entered, only the 
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paragraph in which the cursor is blinking - or any selected text -
will change. See "Text Justification." 

HYPHENATION 

Lets you hyphenate your document. (Whole words can be split 
and hyphenated on the right margin.) See "Hyphenation." 

THE SPECIAL EFFECTS MENU 

SHOW RULERS 

Causes both the horizontal and vertical rulers to appear on the 
screen. The rulers are measured in inches. All tab stop 
alignments and paragraph indents can be set from the rulers. Once 
the rulers are showing this command changes to Hide Rulers. 
Choose it to cause the rulers to disappear. See "Rulers." 

SHOW SPACES AND TABS 

Visibly displays all spaces and tabs. Spaces (created by pressing 
the Space Bar) are represented by a slightly raised period. Tabs 
(created by pressing the Tab key) are represented by an arrow 
pointing to the right. Once this command is chosen, it changes to 
Hide Spaces and Tabs. Select it to cause all space and tab 
symbols to disappear. See "Show Spaces and Tabs." 

SHOW PARAGRAPH BREAKS 

Displays all paragraph break characters. A paragraph break 
character is created whenever the Return key is pressed and is 
normally invisible. As a result of this command, all page breaks 
are also displayed. They are represented by double paragraph 
break symbols. Once this command is chosen, it changes to Hide 
Paragraph Breaks. Select it if you want the paragraph break 
symbols to disappear. See "Show Paragraph Breaks." 
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SHOW PAGE ... 

Displays the page showing on the screen at 1/4 of its original size 
so that it can be seen in its entirety. All text and art are shown 
proportionally reduced. No changes can be made while this 
command is active. See "Show an Entire Page." 

IMPORT ART 

Imports art from clip art disks and other artwork programs. If you 
have selected an art area, the imported art will appear there. If no 
art area has been selected, the imported art will appear within its 
own art area in the upper left-hand corner of your page. See 
"Importing Art." 

EXPORT ART 

Lets you move art from Medley to other artwork programs. This 
command will save the selected art area to disk as a special file that 
can be read and used by the other artwork programs. This 
command will only be active (not grayed out) if an art area is 
selected. See "Exporting Art." 

SWITCH TO GRAY SCALE 

Displays the palette and all art within the document as various 
shades of gray. This is helpful when importing digitized or 
scanned artwork since Medley's color palette may give the art an 
odd appearance. Once Switch To Gray Scale is selected, the menu 
command changes to Switch To Color. Select this to display the 
document in color. Switch To Gray Scale can also be activated 
from the Paint Tool. See "Importing Art." 
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THE SHORTCUTS MENU 

GO TO PAGE 

Allows you to move to the page of your choice. The number of 
the page currently visible in the document window is also 
displayed by this command. See "Go To Any Page." 

SELECT THIS SENTENCE 

Selects the entire sentence in which the cursor is blinking. Format 
changes can then be made to the whole sentence at once. See 
"Select a Sentence." 

SELECT THIS PARAGRAPH 

Selects the entire paragraph in which the cursor is blinking. 
Format changes can then be made to the whole paragraph at once. 
See "Select a Paragraph." 

SELECTALLPARAGRAPHS 

Selects the entire active document. Format changes can then be 
made to the whole document at once. See "Select the Entire 
Document." 

THE FILE MENU (PAINT TOOL) 

RETURN TO WORD PROCESSOR 

Takes you from the Paint Tool to the Text mode (word processor). 
You can also return to the Text mode by double-clicking anywhere 
within the document that is outside of an art area. See "From Text 
Menus To Paint Menus." 
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THE EDIT MENU (PAINT TOOL) 

UNDO 

REDO 

Cancels the last changes made with the selected art tool. See 
"Undoing Paint Changes." 

Replaces the last changes cancelled by Undo. Redo will be grayed 
out if Undo has not been used after a change has been made to the 
art. See "Undoing Paint Changes." 

THE SPECIAL EFFECTS MENU (PAINT TOOL) 

ERASE ALL 

Erases all art within the selected art area. This can also be done by 
double-clicking the Eraser tool in the Tool Box. See "Erasing 
Art." 

SHRINK 

Collapses the moving Selection Box borders so that they conform 
exactly to the art object which it surrounds. This command also 
allows you to select specific colors or objects with the Lasso or the 
Selection Box, and move them out from within larger art objects. 
See "Moving Art." 

SELECf A BRUSH 

Lets you select and edit different brush shapes for use with the 
Paint Brush. The pointer assumes the brush shape you select. 
See "Brush Shapes." 
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CHANGE COLORS 

Lets you change every occurrence of one color to another color of 
your choice within the selected art area. This is helpful when 
importing art from other sources, as Medley may alter the colors. 
See "Changing Colors." 

EDIT PATTERNS 

Lets you alter the design of the patterns in the Color Box. To 
edit the pattern of your choice, select a pattern and then this 
command. See "Editing the Patterns." 

ADJUST SPRAY PAINT 

Adjusts the fill rate (the speed at which the Spray Paint dots appear 
on the screen) of the Spray Paint tool. See "Adjusting the Spray 
Paint." 

HIDE COLOR BOX 

Hides the Color Box so that no text or art is obscured. Once 
Hide Color Box is chosen, the menu command changes to Show 
Color Box so that it can be returned to the screen. See "Moving 
and Hiding the Color and Tool Boxes." 

HIDE TOOL BOX 

Hides the Tool Box so that no text or art is obscured. Once 
Hide Tool Box is chosen, the menu command changes to Show 
Tool Box so that it can be returned to the screen. See "Moving 
and Hiding the Color and Tool Boxes." 

HIDE BOTH BOXES 

Hides both the Tool Box and the Color Box so that no text or 
art is obscured. Once Hide Both Boxes is chosen, the menu 
command changes to Show Both Boxes so that they can be 
returned to the screen. See "Moving and Hiding the Color and 
Tool Boxes." 
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SWITCH TO GRAY SCALE 

Displays the palette and all art within the document as various 
shades of gray. This is helpful when importing digitized or 
scanned artwork since Medley's color palette may give the art an 
odd appearance. Once Switch To Gray Scale is selected, the menu 
command changes to Switch To Color. Select this to display the 
document in color. Switch To Gray Scale can also be activated 
from the Text mode. See "Changing Colors" and "Working With 
Imported Art." 

HORlZONT AL FLIP 

Flips the selected art from right to left. See "Inverting Art." 

VERTICAL FLIP 

Flips the selected art upside down. See "Inverting Art." 
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about Medley 32 
about Medley command 206 
add a page break here command 

218 
add art oval command 212 
add art polygon command 212 
add art rectangle command 211 
add art round rectangle command 

211 
adding a page break 86 
adjust spray paint command 224 
adjusting the spray paint 174 
Apple menu 32 
AppleTalk 192, 193 
AppleWorks 35 
areas 12 
areas, adding 28, 112 
areas, moving 119, 125 
areas, resizing 27, 115, 123 
art areas, adding 27 
art polygons 159 
automatic hyphenation 79 
auxiliary dictionary 12, 96, 97, 99, 

100, 101 
background color 153 
backing up Medley 18 
bold text command 215 
border color 153 
bring to front 135 
bring to front command 214 
brush shapes 170 
change colors 182 
change colors command 224 
change leading command 217 
change page layout 77, 91 
change page layout command 218 
change page numbers 87 
change page numbers command 

219 
change to gray scale 172, 183 

change to lowercase command 218 
change to uppercase command 218 
changing colors 172 
changing fonts 57 
choose font command 216 
choose printer command 208 
choosing a printer 193 
choosing fonts 56, 58 
choosing styles 57 
clear 59, 140 
clear command 209 
clip art 141 
clip art disk 144 
clipboard 13, 36, 59, 60, 61, 62, 

125, 137, 138, 176, 177, 178, 
179,180,181 

close [Document Name] command 
206 

close box 13 
closing a document 42 
color box 175 
columns 139 
command key 13 
control panel 13,192,194 
convert areas 120, 124, 125, 126, 

127, 132, 141 
convert areas command 213 
copy 36, 59, 61, 137, 178, 179, 

180 
copy command 209 
copying areas 137 
copying art objects 178 
copying rulers 73 
copying text 61 
cursor 14 
cursor movement 54 
cut 36, 59, 60, 61, 120, 125, 140, 

176, 177, 180 
cut command 208 
cutting art objects 176 



delete command 207 
deleting a document 48 
deleting areas 140 
deleting text 59 
designing columns 138 
dialog box 14 
dictionaries 96, 97 
dictionaries command 210 
dictionary disk 24, 94, l 03 
directory 14 
document dictionary 14, 96, 97, 

99 
document length 53 
duplicate command 137, 138, 209 
duplicating art 169 
edit brush shapes 171 
edit patterns 173 
edit patterns command 224 
enter paint tool command 214 
erase all (paint) command 223 
eraser 165, 187 
erasing art 165 
export art command 221 
exporting art 146, 147 
exporting text 47 
fill color 154 
filled freehand shape 189 
filled oval 189 
filled polygon 190 
filled rectangle 188 
filled round rectangle 189 
filling in an area 164 
find command 63, 64, 210 
finder 12, 18, 19, 21, 49 
finding text 63 
first line indent marker 71 
flip 170 
folder 15, 34, 45, 47, 143, 148, 

149 
font 15 
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footers 90, 91 
force showing borders 131 
force showing borders command 

212 
freehand drawing 155 
freehand shapes 158 
globa115 
global art 91, 127 
global page part 78, 91, 134 
go to page 55, 107 
go to page command 222 
grayed out 15 
group command 213 
grouping areas 120, 124, 131 
gutter margins 37, 70 
hard disk 22, 45 
hard hyphens 81 
headers 90, 91 
help 32 
help command 206 
hide both boxes command 224 
hide color box command 224 
hide global art 91 
hide global page parts 91 
hide tool box command 224 
highlight 15 
hollow freehand shape 188 
hollow oval188 
hollow polygon 188 
hollow rectangle 187 
hollow round rectangle 187 
horizontal flip 170 
horizontal flip command 225 
horizontal scroll bar 55 
hyphenation 79, 80 
hyphenation command 220 
icon 15 
ImageWriter 38, 193, 194 
import art 144 
import art command 221 
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imported art 182 
importing art 141 
importing text 53 
inverting art 170 
italic text command 216 
kerning 68 
LaserWriter 40, 128, 129, 184, 

193, 196, 203 
lasso 166, 167, 17 6, 178, 180, 

185 
leading 74, 75 
leading (art) 163 
left indent marker 71 
line spacing 74 
line widths 155 
loading Medley 18 
magnifying glass 159, 161, 185 
manual hyphenation 81 
margins 36, 69 
menu bar 15 
modem port 192 
move I change areas command 

114, 212 
move I change mode 28, 114, 119, 

132, 149, 152 
moving art 166 
moving between documents on the 

desktop 108 
moving text 60 
new document 33 
new document command 206 
new folder 45, 148 
normal command 217 
open document 33 
open document command 206 
option key 15 
outline text command 216 
overlapping areas 135 
page layout 112, 119, 120, 127, 

135, 138, 140 

page numbers 87, 90 
page part 15, 78, 86, 132 
page setup 38, 40, 194, 196 
page setup command 207 
paint brush 156, 170, 186 
paint bucket 164, 186 
paint format 147 
paint menu I keystroke commands 

184 
paint tool 28, 29, 149, 152 
paragraph break 53 
paragraph break symbol 73, 104, 

105 
paragraph gaps 75 
paragraph indent markers 71 
paste 36, 60, 61, 120, 125, 137, 

176, 178, 180, 181 
paste command 209 
pasting art objects 180 
pencil 155, 186 
picture format 147 
pixel 16 
plain text command 215 
pointer 16 
polygon 27, 113, 123, 140 
polygon, add line segments 117 
polygon, subtract line segments 

119 
print with Image Writers 199 
print with LaserWriters 201 
print command 207 
printer port 192 
program disk 19, 21, 23 
pull tab 16, 27, 112, 114, 116, 

118, 123, 132, 140 
quit command 49, 208 
redo 67, 176 
redo (paint) command 223 
redo command 208 
replace command 65, 66, 210 
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resize box 16 
resizing art 168 
return to word processor command 

222 
right indent marker 71 
rulers 71, 73, 83, 120 
save as [Document Name] 

command 43, 207 
save as command 43,207 
saving a document 43 
saving to a new folder 45 
saving to a different disk 44 
saving to an existing folder 46 
scroll bars 16 
scrolling 54 
select a brush command 223 
select all paragraphs command 222 
select this paragraph command 222 
select this sentence command 222 
selecting a paragraph 108 
selecting a sentence 107 
selecting art areas 114 
selecting page parts 135 
selecting text 55 
selecting the entire document 108 
selection box 166, 168, 169, 170, 

177, 179, 180, 185 
send to back 135, 141 
send to back command 214 
set margins 37, 69 
set margins command 207 
set tabs 83 
set tabs command 217 
shadow text command 216 
shortcuts 55, 56 
show contents of clipboard 

command 209 
show move I change info 12:2 
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command 213 

show page command 221 
show paragraph breaks 86, 104 
show paragraph breaks command 

220 
show rulers 71 
show rulers command 220 
show spaces and tabs 105 
show spaces and tabs command 

220 
show this page 106 
shrink 166, 167 
shrink command 223 
soft hyphens 81 
spell check 94, 97, 99 
spell check command 210 
spray paint 174, 186 
startup disk 19, 21, 23 
sticky spaces 53 
straight line tool 187 
straight lines 156 
subscript command 217 
superscript command 217 
switch to color 143 
switch to gray scale 143 
switch to gray scale command 221, 

225 
tab leaders 83, 85 
tab marker 72, 82 
tab marker delete 83 
tab stop alignment 73, 83 
tab stop alignments 72 
tab types 82 
tabs 81 
text (art) 186 
text (ASCII) files 36, 47 
text, centered 85, 219 
text, fully justified 85, 219 
text, justified left 85,219 
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text, justified right 85, 219 
text, lowercase 92 
text menu I keystroke commands 

109 
text mode 16, 28, 114, 180 
text tool (art) 162, 163 
text, uppercase 92 
text wrap 52, 140 
text wrap direction 7 6 
thesaurus 102, 103 
thesaurus command 210 
title bar 16 
tool box 175 
turn off borders 129 
turn on borders 130 
typing 52 
underline text command 215 
undo 67, 176 
undo (paint) command 223 
undo command 208 
ungroup command 214 
vertical flip command 225 
vertical scroll bar 55 
window 16 






